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First Printing, August 1996

 

Possession, use, or copying of the software described in this publication is authorized only pursuant to a valid written license from Electronics for 
Imaging, Inc.

 



 

 Electronics for Imaging, Inc. 1996. All rights reserved.

 

Legal Notices 

ELECTRONICS FOR IMAGING, INC. MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE 
SOFTWARE. ELECTRONICS FOR IMAGING DOES NOT WARRANT, GUARANTEE, OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME 
STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 

IN NO EVENT WILL ELECTRONICS FOR IMAGING, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU 
FOR ANY CONSEQUENTIAL, INCIDENTAL OR INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR 
INABILITY TO USE THE APPLE SOFTWARE EVEN IF ELECTRONICS FOR IMAGING HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. 

 

Electronics for Imaging’s 
liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including 
negligence], product liability or otherwise), will be limited to $50. 

 

Restricted Rights Legends 

 

For defense agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (c)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at 252.227.7013. 

For civilian agencies: Restricted Rights Legend. Use, reproduction, or disclosure is subject to restrictions set forth in subparagraph (a) through (d) of 
the commercial Computer Software Restricted Rights clause at 52.227-19 and the limitations set forth in Electronics for Imaging’s standard 
commercial agreement for this software. Unpublished rights reserved under the copyright laws of the United States. 

 

Trademarks 

 

The following are trademarks of Digital Equipment Corporation: OpenVMS, VAX, PATHWORKS, Digital, and the DIGITAL logo.

The following are trademarks of Electronics for Imaging, Inc.: EFI, the EFI logo, Fiery XJ, Fiery Driven, the Fiery Driven Signature, EFICOLOR, 
the EFICOLOR logo, and Fiery Print Calibrator. Fiery, EFICOLOR, and the EFICOLOR logo are registered with the U.S. Patent and Trademark 
Office. 

All other trademarks and registered trademarks are the property of their respective holders.

The software described in this guide is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in 
accordance with the terms of the agreement.

 

Printed in U.S.A.

Electronics for Imaging Software License Agreement

 

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation 
(“Software”) included with the Colorwriter LSR 2000

 

+

 

 Color printer you have purchased, including without limitation the PostScript

 



 

 software 
provided by Adobe Systems Incorporated.
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You may:

a. use the Software solely for your own customary business purposes and solely with Colorwriter LSR 2000

 

+

 

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Colorwriter LSR 2000

 

+

 

 in a special 
encrypted format (“Coded Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols 
(“Typefaces”) solely for your own customary business purposes on the screen of the Colorwriter LSR 2000

 

+

 

 or Macintosh monitor used with 
Colorwriter LSR 2000

 

+

 

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Colorwriter LSR 2000

 

+

 

 provided the 
transferee agrees to be bound by all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts 
or typefaces for use other than with Colorwriter LSR 2000

 

+

 

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, 
except as necessary for use with the Colorwriter LSR 2000

 

+

 

 printer purchased by you; provided, however, that under no circumstances may you 
make or have made, or permit to be made, any copies of that certain portion of the Software which has been included on the Colorwriter LSR 2000

 

+

 

 
hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

 

Proprietary Rights

 

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics 
for Imaging and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except 
as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or 
any other rights, franchises or licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. 
You may not adapt or use any trademark or trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its 
suppliers or take any other action which impairs or reduces the trademark rights of Electronics for Imaging or its suppliers. The trademarks may be 
used only to identify printed output produced by the Coded Font Programs. At the reasonable request of Electronics for Imaging, you must supply 
samples of any Typeface identified with a trademark.

The MacApp software is proprietary to Apple Computer, Inc. and is licensed to Electronics for Imaging, Inc. for distribution only for use in 
combination with Colorwriter LSR software utilities.

 

Confidentiality

 

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users 
having a need to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent 
disclosure to other parties.

 

Remedies

 

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result 
in automatic termination of this license and will make available to Electronics for Imaging other legal remedies.

 

Export Controls

 

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign 
government licenses. Your failure to comply with this provision is a material breach of this Agreement.

 

Government Use

 

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer 
Software—Restricted Right Clause at 48 CFR 52.227-19, as applicable.



 

Third Party Beneficiary

 

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 1585 Charleston Road, Mountain View, California 
94039-7900 (“Adobe”) is a third-party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use 
of the Fonts, the Coded Font Programs, the Typefaces and the Trademarks licensed hereby. Such provisions are made expressly for the benefit of 
Adobe and are enforceable by Adobe in addition to Electronics for Imaging.

 

General

 

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded 
Font Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

 

FCC (Federal Communications Commission) Notice

WARNING:

 

 FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer 
could void the user’s authority to operate this equipment. 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by 
one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult a dealer or an experienced radio or television technician for help.

 

Modifications:

 

 The FCC requires the user to be notified that any changes or modifications made to this device that are not expressly approved by 
Digital Equipment Corporation may void the user’s authority to operate the equipment.

 

Cables:

 

 Connections to this device must be shielded cables with metallic RFI/EMI connector hoods in order to maintain compliance with FCC 
Rules and Regulations.

 

DOC Compliance Notice 

 

This equipment does not exceed the Class B limits for radio noise emissions as described in the Radio Interference Regulations of the Canadian 
Department of Communications.

 

DOC Avis de Conformation 

 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la classe B préscrites 
dans le Règlement sur le brouillage radioélectrique édicté par le Ministère des Communications du Canada.

 

CDRH Regulations

 

The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration implemented regulations for laser products 
on August 1, 1976. These regulations apply to laser products marketed in the United States. The label on the printer indicates compliance with the 
CDRH regulations and must be attached to laser products marketed in the United States.



 

Acoustics

 

Declared values per ISO 9296 and ISO 7779:

 

Sound Power Level Sound Pressure Level

 

L

 

WAd

 

, B L

 

pAm

 

, dBA
(bystander positions)

 

Product Idle Operate Idle Operate

 

LNC01 (color) 6.2 7.0 44 53
LNC01 (b&w) 6.2 6.9 44 52
(1 B = 10 dBA)

Current values for specific configurations are available from Digital representatives.

 

Schallemissionswerte

 

Werteangaben nach ISO 9296 und ISO 7779/DIN EN27779:

 

Schalleistungspegel Schalldruckpegel

 

L

 

WAd

 

, B L

 

pAm

 

, dBA
(bystander positions)

 

Gerät Leerlaug Betrieb Leerlauf Betrieb

 

LNC01 (color) 6,2 7,0 44 53
LNC01 (b&w) 6,2 6,9 44 52
(1 B = 10 dBA)

Aktuelle Werte für spezielle Ausrüstungsstufen sind über die Digital Equipment Vertretungen erhältlich.

 

Class 1 Laser Product (100-120V/220-240V models)

 

Laser radiation could be hazardous to the human body. For this reason, laser radiation emitted inside this printer is hermetically sealed within the 
protective housing and external cover. In the normal operation of the product by the user, no radiation can leak from the machine. 

This printer is certified as Class 1 laser product under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard 
according to the Radiation Control for Health and Safety Act of 1968. (This means that the printer does not emit hazardous laser radiation.)  

The label shown below is attached to this printer.

 

WARNING:

 

 When servicing the machine or laser module, follow the procedures specified in the manual so that there are no hazards from the laser. 
The use of controls, adjustments, or performance of procedures other than those specified in this manual may result in hazardous laser radiation exposure.

 

WARNING:

 

 The label shown above is intended as a warning to persons disassembling the Raster Laser Scanner unit for internal alignment or repair 
purposes. It does not apply to any of the maintenance procedures specified in this manual.

DANGER    -



CAUTION   -

ATTENTION   -



VORSICHT     -



ATTENZIONE -



PRECAUTION-



VARO!             -





VARNING!      -



ADVARSEL!   -



ADVARSEL    -

Invisible laser radiation when open.

AVOID DIRECT EXPOSURE TO BEAM.

INVISIBLE LASER RADIATION WHEN OPEN.

AVOID EXPOSURE TO BEAM.

RAYONNEMENT LASER INVISIBLE EN CAS D'OUVERTURE.

EXPOSITION DANGEREUSE AU FAISCEAU.

UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG GEÖFNET.

NICHT DEM STRAHL AUSSETZEN.

RADIAZIONE LASER INVISIBLE IN CASO DI APERTURA.

EVITARE L'ESPOSIZIONE AL FASCIO.

RADICION LASER INVISIBLE CUANDO SE ABRE.

EVITAR EXPONERSE AL RAYO.

AAVATTAESSA OLET ALTTIINA NÄKYMÄTTÖMÄLLE

LASERSÄTEILYLLE. ÄLÄ KATSO SÄTEESEEN.



OSYNLIG LASERSTRÅLNING NÄR DENNA DEL ÄR ÖPPNAD.

BETRAKTA EJ STRÅLEN.

USYNLIG LASER STRÅLING, NÄR DENNE ER ÅBEN.

UNDGÅ BESTRÅLING.

USYNLIG LASERSTRÅLING, NÄR DEKSEL ÅPNES.

UNNGÅ EKSPONERING FOR STRÅLEN.

RS5-8169
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In today’s business environment, the pressure is on to produce professional, 
polished documents and sharp, color-specific renderings and presentations. The 
pressure is compounded by the need to produce these materials in a fast and cost-
effective manner. Generating them in your own efficient environment results in 
higher productivity, especially when crisp output and color quality is of 
paramount concern.

 

About the Colorwriter LSR 2000

 

+

 

 

 

The Digital Colorwriter LSR 2000

 

+

 

 represents the highest standards in 
continuous tone color laser technology. Equipped with a Fiery

 



 

 XJe controller, 
and combined with Digital’s well-known product reliability and support, the 
Colorwriter LSR 2000

 

+

 

 provides top performance and photographic quality for 
large, complex files consisting of text, graphics, and images. The Colorwriter not 
only performs at speeds up to five times faster than typical desktop models, it does 
so with print quality previously found only in more expensive color laser printers. 

With its Adobe

 



 

PostScript

 



 

level 2 capabilities, Kodak Precision and ICC color 
profiles, and flexibility in page layout, the Colorwriter fits extremely well into 
graphic arts, prepress, and desktop publishing environments. The complex images 
necessitated by computer-aided design and engineering are similarly well met with 
this printer’s high-resolution reproduction. Furthermore, word processing 
documents, spreadsheets, and other presentations all reflect the highest quality 
output when the Colorwriter LSR 2000

 

+

 

 is the source. 

The Colorwriter LSR 2000

 

+

 

 offers four different color rendering dictionaries 
(CRDs) to allow a wide range of color output and to assure that whatever is being 
printed looks as it should, from photographs to computer-designed presentations. 
Switching between CRDs is effortless; the LCD control panel makes it possible to 
use a new CRD without restarting the Colorwriter. The Colorwriter is also 
Energy Star compliant, which means it can be left on between print jobs without 
wasting electricity. A customizable power saver mode allows the user to specify 
when the printer will power-down its mechanical parts. After a brief warmup, the 
Colorwriter is ready to receive jobs, allowing you to concentrate on your print 
jobs, instead of your printer.

Preface
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xiv About this guide

 

About this guide

 

This guide provides an introduction to desktop color printing, an overview of the 
printer and how to operate it, how to use the software provided, and what you 
need to know about using the printer in a networked environment. It also outlines 
routine maintenance procedures, includes troubleshooting information, and 
explains how to order accessories, supplies, and documentation. Specifications are 
also included.

 

N

 

OTE

 

:

 

When referring to the printer, the terms Colorwriter, Colorwriter LSR, and 
Colorwriter LSR 2000

 

+

 

 are used interchangeably in this manual.

The audience for this guide is anyone who will be printing to the 
Colorwriter LSR 2000

 

+

 

.

 

N

 

OTE

 

:

 

In this manual, software or features that are part of the Professional Color 
Kit (PCK) are indicated with a small PCK icon. The Professional Color Kit is an 
optional feature set available for the Colorwriter.

The following major topics are included:

• Introduction to desktop color printing

• Using the control panels

• Printing from various computers and workstations

• Error messages

• Setup menus

• Maintenance

• Troubleshooting

• Specifications

• Ordering supplies and documentation

• Obtaining service

PCK



 

xv Related documentation

 

Related documentation

 

This guide is part of a set of printed documentation (Order Number: 
EK-LCPLE-DK) that also includes the following:

• The 

 

Colorwriter LSR 2000

 

+

 

 Printer Getting Started

 

 describes how to install the 
Colorwriter and the user software for the Colorwriter, and how to set up 
printing from Macintosh

 



 

 and Windows computers. You’ll also learn how to set 
up the Colorwriter from the printer control panel. 

• The 

 

Quick Reference

 

 

 

Card

 

 shows how to set up manual feed printing, clear 
paper jams, replace toner, and use the drum cartridge kit. 

A clear plastic pocket is included in the documentation pack. If you adhere it to 
the side of the printer, you can use it to keep the Quick Reference Card with the 
printer.

• Printed 

 

Release Notes

 

 describe last-minute additions and changes to the 
documentation or software. 

• Return the 

 

Printer Registration Card

 

 to register your Colorwriter and receive 
special offers and new product information. 

•

 

Warranty Card

 

 

For information about ordering related documentation, see Appendix G

 

.

 

In addition to the printed documentation, you should read the on-line Read Me 
files on the CD that contains user software, printer files, and screen fonts. The 
following manual is included in online form on the CD:

• The 

 

PostScript Language Printer Addendum 

 

describes the parameters and 
resources present in the implementation of the PostScript interpreter for the 
Colorwriter, which has PostScript language features and capabilities that might 
not be present in other PostScript output devices. 



 

xvi Important safety information

 

Important safety information

 

This printer is a high-precision electronic device. Therefore be sure to read these 
safety instructions carefully before you begin. 

Follow all warnings and instructions marked on the printer and consumables, 
such as the toner cartridges and silicone oil bottles.

 

Handling the Colorwriter

 

• Do not place this printer on an unstable cart, stand, or table.

• The printer alone weighs approximately 110 lb (50 kg). Do not attempt to 
move it by yourself. It should always be moved by two or more people. 

• When carrying the printer, be sure to hold it horizontally. Tilting the printer 
may cause the silicone oil to spill.

• When the printer is in use, the fixing assembly and delivery areas become 
extremely hot. Be careful not to touch these areas.

• Before moving the printer, be sure to turn it off and then unplug the power 
cable.

 

Choosing a location for the Colorwriter

 

• Do not expose the printer to a wet environment.

• Make sure the printer is level (at less than a 1% angle); otherwise a REPLACE 
FIXING UNIT PUMP error message will be displayed on the control panel.

• Do not directly expose the printer to a chemical environment, for example, an 
experimental laboratory. The exterior of the printer is made of plastic, and the 
outside covering may fade, become deformed, or melt.

!




 

xvii Important safety information

 

Unpacking and setting up the Colorwriter

 

• Before connecting the printer to a power source, check the voltage rating label 
on the back of the printer to ensure that the printer voltage matches that of the 
power source. If the voltage label is missing, contact the nearest authorized 
dealer or your place of purchase.

• Avoid using an extension cord. If it is unavoidable, be sure to take the following 
precautions. Failure to do this may lead to overheating or fire, or cause lights to 
flicker due to a drop in voltage.

• Be sure not to exceed the allowed rating current of the extension cord. 
Make sure that the total ampere rating of the products plugged into the 
extension cord does not exceed the extension cord ampere rating.

• Use a short extension cord. Do not connect several extension cords 
together.

• When connecting cables or disconnecting cables from the printer, make sure 
that the power switch is in the off position.

• Be sure to turn off the power before unplugging or plugging in the printer 
power cord or interface cable.

 

Operating the Colorwriter

 

• Slots and openings in the cabinet are provided for ventilation. To ensure reliable 
operation of the printer and protect it from overheating, these openings should 
never be blocked or covered.

Air ventilation slots 
(back)

Inhalation slot 
(right side)



 

xviii Important safety information

 

• The printer is equipped with a 3-wire grounding type plug, which has a third 
(grounding) pin. This plug will fit into only a grounding-type power outlet. If 
you are unable to insert the plug into the outlet, contact your electrician to 
replace your obsolete outlet. Do not defeat the purpose of the grounding type 
plug.

• Unplug this printer from the wall outlet before cleaning. Use a damp cloth for 
cleaning. Do not spray liquid or aerosol cleaners directly on the cabinet or the 
openings, as the spray could penetrate the printer and damage internal parts. 

• Do not attempt to service this printer by yourself, except as instructed in this 
manual. Opening or removing covers that are intended to be removed only by 
qualified service personnel may expose you to dangerous voltage points or other 
risks. Refer all servicing in those compartments to qualified service personnel. 

• Operation of this printer should always be supervised by a responsible adult. To 
avoid injury, do not allow children access to the interior of any electrical 
product and do not let them touch any electrical contacts or gears that are 
exposed.

• This symbol warns the user that uninsulated voltage within the unit may have 
sufficient magnitude to cause electric shock.

• Do not make contact with any inside part of this unit while it is plugged in.

• Avoid operating the printer when the waste toner bottle and/or silicone oil 
bottle is not installed; otherwise, the printer may be damaged. 

• Do not attempt to modify the printer.

• Do not remove the warning or instruction labels on the printer.

• Do not dispose of the used waste toner box or the silicone oil box into a fire.

!




 

xix Energy Star compliance

 

Protecting the LCD display

 

Do not subject the Colorwriter to strong shocks. The Colorwriter has a liquid 
crystal display (LCD) that is made of glass and can break. If the display window 
breaks and the liquid crystal material leaks out, do not inhale, ingest, or touch it. 
If the material gets on your skin or clothing, wash it off with soap and water 
immediately.

 

Ozone emission

 

This printer meets the requirements for ozone emission of the applicable standard 
published by Underwriters’ Laboratories, Inc. (UL). Ozone (O

 

3

 

) is a colorless gas 
by-product of the electrophotographic process. Ozone is discharged only while the 
printer is printing, and is emitted through the exhaust port on the rear, left side of 
the printer. Only service personnel should replace the ozone filter.

Those who are particularly sensitive to ozone odor may feel sick if exposed to it for 
long periods of time. To avoid this, make sure that the following measures are 
taken:

• Install the printer in a large, well ventilated room. 

• Avoid facing the exhaust port directly toward users.

• Be sure that the ozone filter is replaced periodically by the service person.

• Avoid using the printer without a filter.

 

Energy Star compliance

 

The Colorwriter comes equipped with a power saver mode that can reduce the 
total power consumption of the printer to less than 45 watts—a 65 percent 
reduction in electricity use. In power saver mode, the fan and fuser are turned off 
after a user- defined period of inactivity. With the power saver feature, the 
Colorwriter complies with the EPA (Environmental Protection Agency) 
guidelines for an Energy Star compliant device (United States only).

!
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1-1 The properties of color

 

This chapter provides information about:

• The properties of color

• Traditional color printing and Colorwriter printing

• Controlling printed color

 

The properties of color

 

Color theory is an attempt to systematize the properties of color perception, 
which by nature is relative and changeable. A color appears different depending 
on the other colors around it, and individuals vary in their abilities to perceive 
color.

This section introduces concepts that are basic to color theory. You will encounter 
some of these ideas (such as hue, saturation, and brightness) when you work with 
color in applications, while others are useful background information. Since color 
is a complex topic, consider this a starting point for experimentation and further 
research.

 

The physics of color

 

Humans are sensitive to electromagnetic radiation at wavelengths between 400 
nanometers (purplish blue) and 700 nanometers (red). This range is called the 
visible spectrum of light. We see pure spectral light as intensely saturated or pure 
colors. Sunlight at mid day, which we perceive as white or neutral light, is 
composed of light from across the visible spectrum in more or less equal 
proportions. Shining sunlight through a prism separates it into its spectral 
components, resulting in the familiar rainbow of colors (plate 1). 

Most light sources we encounter in our daily environment are like the sun in that 
they emit a mixture of many light wavelengths, although the particular 
distribution of wavelengths can vary considerably. Light from a tungsten light 
bulb contains much less blue light than sunlight. Tungsten light appears white to 
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the human eye which can, up to a point, adjust to the different light sources. 
However, colored objects appear different under tungsten light than they do 
under sunlight because of the different spectral makeup of the two light sources.

The mixture of light wavelengths emitted by a light source is reflected selectively 
by different objects, and the mixture of light reflected appears as different colors. 
Some of these mixtures appear as relatively saturated colors, but most appear to us 
as grays or impure hues of a color. 

 

CIE color model

 

In the 1930s, the Commission Internationale de l’Eclairage (CIE) defined a 
standard color space to help in the communication of color information. This 
color space was based on research about the nature of color perception. The CIE 
chromaticity diagram (plate 2) is a two-dimensional model of color vision. The 
arc around the top of the triangle encompasses the pure or spectral colors, from 
blue violet to red. Although the CIE chromaticity diagram is not perceptually 
uniform—some areas of the diagram seem to compress color differences relative to 
others—it is a good tool for illustrating some interesting aspects of color vision.

By mixing two spectral colors in different proportions, we can create any of the 
colors that are found on the straight line drawn between them in the diagram. 
Applying this rule, notice how it is possible to create the same gray by mixing 
blue-green and red light as you can by mixing yellow-green and blue-violet light. 
This is possible because of a phenomenon peculiar to color vision called 

 

metamerism

 

. The eye does not distinguish individual wavelengths of light. 
Therefore, different combinations of spectral light can produce the same perceived 
color. 

Notice how purple colors, which do not exist in the spectrum of pure light, are 
found at the bottom of the diagram. Purples are mixtures of red and blue light—
the opposite ends of the spectrum.
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Hue, saturation, and brightness

 

A color can also be described in terms of three varying characteristics: its hue, or 
tint (the qualitative aspect of a color—red, green, or blue); its saturation, or the 
purity of the color; and its brightness, or relative position between white and 
black. While the CIE chromaticity diagram (plate 2) conveys hue and saturation, 
a three-dimensional color model is required to show the brightness component as 
well (plate 3).

Many computer applications offer dialog boxes in which you choose colors by 
manipulating hue, saturation, and brightness. For example, Adobe Photoshop

 



 

 
uses a Color Picker that can be reconfigured according to preference.

 

Additive and subtractive color systems

 

Color devices used in desktop publishing and printing simulate the range of 
visible colors using a set of primary colors that are combined to create other 
colors. Two methods of creating a range of colors from a set of primary colors 
exist. Computer monitors and scanners use the 

 

additive color model

 

. Color laser 
printers such as the Colorwriter, and traditional printing processes using ink on 
paper, use the 

 

subtractive color model

 

.

 

Additive (RGB) color

 

Color devices that use the additive color model produce a range of colors by 
combining varying amounts of red, green, and blue light. These colors are called 
the 

 

additive primaries (

 

plate 5). White is created by adding the maximum 
amount of red, green, and blue light available; black is found wherever all three 
colors are absent. Grays are created by adding varying amounts of all three colors 
together. Combining varying amounts of any two of the additive primaries creates 
a third, saturated hue.

A familiar device that uses this color model is the computer monitor (plate 6). 
Monitors have red, green, and blue phosphors that emit varying amounts of light 
to display a given color. Scanners create digital representations of colors by 
measuring their red, green, and blue components through colored filters.
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Subtractive (CMY and CMYK) color

 

The subtractive color model is used in color printing, as well as in color 
photographic prints and transparency film. While the additive color model 
simulates the visible spectrum of color by adding light of three primary hues, the 
subtractive color model uses a “white” or neutral light source containing light of 
many wavelengths. Inks, toners, or other 

 

colorants

 

 are used to selectively absorb 
(subtract) certain wavelengths of light that would otherwise be reflected from or 
transmitted through the media in question. 

The 

 

subtractive primaries

 

 are cyan, magenta, and yellow; they absorb red, green, 
and blue light respectively (plate 7). Combining any two of the subtractive 
primaries creates a new color that is relatively pure or saturated. For example, you 
can make red by combining magenta and yellow, which absorb green and blue 
light respectively. White is found wherever no colorant is applied. Combining all 
three subtractive primaries yields a dark color that could be considered “black” in 
the print. However, color printing has traditionally used a four-color process inks 
set: 

 

C

 

yan, 

 

M

 

agenta, 

 

Y

 

ellow, and blac

 

K

 

 (CMYK). The addition of black ink assists 
in a number of areas, including registration between the different ink colors, 
contrast, and rendition of black text. Digital color printers such as the Colorwriter 
use cyan, magenta, yellow, and black toners.

The CMYK colorants used both in offset printing and in digital color printers are 
to some degree transparent. When one layer of colorant is applied on top of 
another, you see the effect of both. To create a range of intermediary colors, a 
method is required for varying the amount of each colorant that is applied. A 
technique called 

 

halftoning

 

 is used in offset printing, while color printers 
typically use a proprietary system for applying toner that is similar to halftoning.

Although the toner is applied in a system similar to halftoning, the spots of toner 
are so fine and close together that output resembles a photograph, and the 
Colorwriter is normally referred to as 

 

continuous tone (contone)

 

 device.

Even if your color printing is done exclusively on the Colorwriter, you will 
encounter concepts from traditional printing on press if you use high-end 
graphics applications. For example, color controls in illustration applications such 
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as Adobe Illustrator

 



 

 are geared toward specifying color for offset printing using 
process and spot colors. Many applications allow you to specify the screening used 
for each printing plate.

Screen frequency settings are generally ignored by the PostScript interpreter when 
it processes your document for the Colorwriter.

 

Printer gamut

 

Different color reproduction techniques have different color capabilities. The 
range of colors that can be produced with a given color device is called its 

 

gamut

 

. 
Color transparency film and color monitors have large gamuts, whereas the color 
gamut that can be produced using process inks or CMYK toners on paper is 
comparatively small. This is why some colors that a computer monitor can 
display, especially bright saturated colors, cannot be reproduced exactly in printer 
output—nor can they be reproduced on printing presses using process colors. To a 
lesser extent, a color printer can print some colors that cannot be displayed on a 
monitor.

You will need to take the gamut of your printer into account when designing on a 
color monitor, particularly when using applications that use the RGB color 
model, such as presentation packages, pixel-editing applications, and painting 
applications. RGB colors that are outside of the color printer’s gamut are 
“mapped” to printable CMYK colors. This process is sometimes referred to as 

 

gamut mapping

 

; it takes place when RGB image data is converted to CMYK, 
either on your workstation or on the printer. The result may be a darkening or 
desaturation of certain colors that appear bright and saturated on the monitor. 
EFICOLOR 

 

color rendering dictionaries (CRDs)

 

 or 

 

separation tables

 

, 
described in the section “The role of color management” on page 1-8, provide a 
choice of color rendering styles, each of which uses different gamut mapping 
methods.
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Traditional color printing and Colorwriter printing

 

Until recently, most color printing was done on a printing press using one of 
several printing technologies—offset lithography, flexography, and gravure. All of 
these traditional printing techniques require a large amount of preparation before 
a print run can take place. Colorwriter printing eliminates most of this 
preparation. By streamlining the process of color printing, the Colorwriter makes 
short print runs economically feasible.

In contemporary offset lithographic printing, digital files from desktop computers 
are output to an imagesetter, which creates film separations. The film is then used 
to make a prepress proof, which is an accurate predictor of the final print job, and 
provides an opportunity to make corrections before going to press. Once the proof 
is approved, the printer makes plates from the film and runs the print job on the 
press. 

With a Colorwriter, you simply print the file. The Colorwriter processes the 
PostScript information in the file and sends four bitmaps (one each for cyan, 
magenta, yellow, and black) to the printer’s laser-based print engine. The print 
emerges from the printer shortly afterward. The ease of Colorwriter printing 
makes experimentation possible that would be too costly on press, allowing almost 
unlimited fine-tuning of color and design elements.

Imagesetter Film Proof PressDesktop Print run
computer

Desktop 
computer

Colorwriter Prints

Traditional color 
printing process

Colorwriter 
printing process
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Controlling printed color

 

The following factors affect printer consistency, as well as color fidelity and overall 
output quality:

 

Maintenance and supplies

 

The paper and toner used in a printer affect printed color. For best results, use the 
paper and toner recommended by the manufacturer of the printer.

Problems such as streaking and insufficient or excessive amounts of one or more 
toner colors indicate the need for maintenance or repair. Replacing a toner 
cartridge as soon as the low toner message appears on the Printer Control Panel is 
one of the easiest ways to maintain color consistency.

 

Calibration

 

Color output from the laser-based print engine in your Colorwriter is subject to 
changes in temperature and humidity, and is prone to drift over time. The 
printer’s internal sensor monitors these changes and corrects the output toner 
densities so as to obtain an optimal maximum density and an optimal curve of 
intermediate densities.

This internal calibration occurs whenever the power is turned on and every 30 
minutes while the power is on. It also occurs after a sudden environmental 
change, after a prescribed number of prints, and when a new toner or drum 
cartridge is installed. The printer monitors its output density by imaging a pattern 
of toner densities on the transfer drum, and measuring the light reflected from the 
pattern.

Building on the printer’s internal calibration, you have additional options for 
controlling color output. You can monitor printed output by making standard test 
prints at regular intervals, visually examining and comparing them. You can do 
this conveniently by printing the Test Page and saving the result. Using the 
Colorwriter density control panel you can make small changes in the density of 
individual toner colors. We recommend that you leave the density control panel in 
the neutral (center) position before calibrating the Colorwriter with the Fiery 
Print Calibrator

 



 

.
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If you have a 

 

densitometer

 

, you can measure your printed output to monitor the 
range of output densities. Where color accuracy and consistency are crucial, 
regular calibration of the printer is advisable.

In this manual, software or features that are part of the Professional Color Kit 
(PCK) are indicated with a small PCK icon. The Professional Color Kit is an 
optional feature set available for the Colorwriter.

The Fiery Print Calibrator, a Macintosh application provided with the 
Colorwriter, together with a 

 

Status T densitometer

 

, help to automate the 
calibration process. You use the Calibrator to print and measure color patches and 
compensate for changes in print densities. The strip-reading X-Rite DTP 32 
densitometer makes calibration a quick and simple process.

The Calibrator application compares measured toner densities with a set of target 
densities, and downloads a software correction to the Colorwriter that brings the 
toner densities close to the target. You can use the Colorwriter profile included 
with the calibration software as a target, you can edit the target maximum density 
and midtone density for each process color, or you can create a set of custom 
targets.

Calibrations performed with the Fiery Print Calibrator reside on the printer, and 
are applied as 

 

transfer curves

 

 to all print jobs. 

 

The role of color management

 

A properly maintained and calibrated Colorwriter print engine will give consistent 
output from day to day. However, the method you use for matching color output 
from the Colorwriter across different devices depends on the type of color data 
you send to the printer.

•

 

CRDs

 

—With scanners, presentation packages, or other applications that 
specify colors as RGB values, use CRDs to make the image displayed on the 
color monitor similar to the printed output. If you specify RGB colors in 
Photoshop, use the Colorwriter separation tables to achieve the same effect.

PCK

PCK
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•

 

Color Profiles

 

—Two sets of color profiles are provided on the User Software 
CD: standard and calibrated.  You should install and use the calibrated versions 
of the profiles only if you have used the Fiery Print Calibrator to calibrate your 
Colorwriter.  Otherwise, use the standard profiles. There will be a significant 
difference in color reproduction if the incorrect profiles are used.

• Kodak Precision Transform files are included for applications that use the 
Kodak Precision Color Management System.  Refer to your application 
documentation for the installation and use of these files.

• ColorSync (ICC) color profiles are included for use with Macintosh 
systems that support ColorSync 2.0.  To install the profile, you should 
copy the profiles to the ColorSync Profiles folder, inside the Preferences 
folder in your System Folder.

•

 

Swatch color matching

 

—With illustration or page layout applications that 
specify colors as CMYK values, use the CMYK Reference Pages and the 
PANTONE Reference Books. From these pages you can see how various C, M, 
Y, K combinations look when printed by the Colorwriter, and can determine 
the CMYK data to specify in order to obtain the printed colors you want. Using 
the PANTONE Reference Books you can determine the nearest CMYK values 
to match a given color in the printed PANTONE Color libraries for coated and 
uncoated paper. 

 

CRDs—color management on the Colorwriter LSR 2000

 

Because the Colorwriter is a PostScript Level 2 printing device, it has the ability to 
use custom CRDs (color rendering dictionaries). CRDs are used for converting 
RGB data sent to the printer into CMYK data used by the printer’s print engine, 
tailored to its particular color response. CRDs are designed to give a close match 
between the monitor and printed output.

CRDs work with both Macintosh and Windows applications. You can select a 
CRD by choosing it from the Rendering Style pop-up menu:

• In the Print Options dialog box when using PostScript Level 2 printer drivers 
such as the Adobe PostScript Printer Driver or Apple LaserWriter 8.0 or later on 
the Macintosh 

• In the Features tab in the Printer Setup dialog box using the Adobe PS 3 
PostScript Printer Driver in Windows 3.x applications.
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You can choose from four color rendering styles, each of which has a different way 
of translating color image data to the CMYK color space of your printer. 
Choosing the appropriate color rendering style will give you the best results 
within the capabilities of your printer.

Guidelines for using color rendering styles follow:

•

 

Photographic rendering

 

 preserves tonal relationships in images and is best for 
continuous tone photographs. With this rendering style, unprintable colors are 
mapped to printable colors in a way that retains differences in lightness, slightly 
sacrificing color accuracy as necessary. Photographic rendering typically often 
gives less saturated output when printing out-of-gamut RGB colors than Solid 
Color rendering does.

•

 

Solid Color rendering

 

 is appropriate when color accuracy is crucial, and does 
the best job of preserving the saturation of displayed colors. With this rendering 
style, unprintable colors are mapped to the closest printable colors. Note that 
Solid Color rendering may not be appropriate for printing saturated RGB color 
blends, since artifacts such as banding may occur.

•

 

Presentation rendering

 

 is appropriate for bright saturated colors used in 
illustrations and graphs for business presentations—such as graphics created 
using Microsoft PowerPoint. It does not try to match printed colors precisely to 
displayed colors. Presentation rendering typically gives denser output than the 
other two color rendering styles and is recommended for presentations that are 
printed on transparency materials.

•

 

Monitor Color rendering

 

 is appropriate when you want the best match 
between colors as they are displayed on your computer monitor and colors in 
the printed output. Monitor rendering matches printed colors to displayed 
colors by taking into account the lightness of colors when rendering them in the 
printed output. While it is similar to Presentation rendering for some colors, 
blues will appear lighter and less purple, and greens will appear more olive green 
than grass green, and lighter.

You can use CRDs when:

• Printing from presentation packages, word processors, spreadsheets, and other 
applications that send RGB information to the Colorwriter

• Printing scans and other RGB images from Adobe Photoshop
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• Saving RGB EPS images from Adobe Photoshop and placing them in other 
applications

If you work with RGB data in Photoshop for Macintosh or Windows, you can 
load Colorwriter separation tables to perform the same function as the CRDs 
built into the printer. Separation tables are used when you print to the 
Colorwriter, when you save separations, and when you change color mode within 
Photoshop. Colorwriter user software includes separation tables for Photographic 
and for Solid Color rendering. To load the separation tables, see the instructions 
in Chapter 6 of 

 

Getting Started

 

. See Chapters 3 and 4 of this manual for additional 
application notes.

 

Swatch color matching

 

When you use applications that specify color as CMYK data, swatch color 
matching allows you to match color output from presses or other printers. The 
Colorwriter comes with support for printing reference pages of CMYK data and 
PANTONE colors. By choosing a color from one of these pages, and specifying 
the CMYK percentages shown beside the color, you can be sure of obtaining the 
same color from the Colorwriter.

You can make it even more reliable by calibrating your Colorwriter before 
printing the reference pages and your final output. Swatch color matching is not 
suitable for matching monitor and printer color.

The Macintosh or Windows CMYK Reference Pages, on the user software disks, 
are PostScript files that print eleven pages of swatches in graduated combinations 
of yellow, magenta, and cyan, and smaller patches that include 25, 50 and 75% 
black. The process colors are shown in 10% increments. You can produce these 
colors from any application that specifies colors as CMYK percentages.

The PANTONE color matching system is a standard color system within the 
graphic arts and prepress industries. It specifies hundreds of spot colors, each 
identified with a unique number. Each PANTONE color is simulated on the 
printer by printing an appropriate combination of process (CMYK) colors. The 
ability to simulate PANTONE colors is a basic form of color management. 
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Colorwriter support for the PANTONE color matching system consists of the 
Macintosh and Windows PANTONE Reference Book for coated and uncoated 
papers, included with the user software.

With the PANTONE Reference Book files, you can quickly print a book of 
PANTONE color simulations, accompanied by their CMYK percent values, on 
your Colorwriter. You can give this PANTONE Reference Book to all designers 
who specify PANTONE colors in their Macintosh and Windows applications. 
Designers can pick PANTONE colors from the book and then specify the colors 
in their applications by entering the CMYK values manually. You can use the 
CMYK Reference pages the same way.
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2-1

 

This chapter contains basic information on operating the Colorwriter. You’ll find 
instructions on:

• Using the printer control panel

• Using the display window

• Using the density control panel

• Loading paper into the optional paper feeder unit

• Handling and storing paper

• Loading the paper cassette

• Loading paper into the multipurpose tray

• Loading transparency film

Chapter 2:
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the Printer
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Printer control panel overview

 

The printer control panel on the front of the Colorwriter enables you to set 
options and view information about print jobs, in addition to displaying status 
information about the Colorwriter. The printer control panel is comprised of the 
following parts:

• Activity lights

• Buttons

• Display window

For a list of error messages that may be displayed on the printer control panel, see 
Appendix A. For a more detailed map of printer control panel information, see 
Appendix B.

 

Activity lights

 

The activity lights indicate printer status and have the following meanings:

 

Lit when the printer is online and ready to print new jobs.

Flashes when the printer is receiving data, processing, printing, or the 
Downloader or Spooler is connected.

Lit when the printer requires operator intervention. Flashes when the printer 
is warming up or there is an error that prevents printing.

Main cassette light is lit when the main (upper) paper cassette is selected as 
the default tray or requested by the current print job.

Lower cassette light is lit when the optional (lower) paper cassette is selected 
as the default tray or requested by the current print job.

Multipurpose tray light is lit when the multipurpose tray is selected as the 
default tray or requested by the current print job.

Processing

Fault

LCD

READY      292MB

Colorwriter LSR

Main Cassette
Tray light indicates default 

paper source, or paper source 

requested by current print job

Printer is processing

or printing a job

Press Enter to

view fault message

Optional Cassette

Multipurpose Tray
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Buttons

 

The buttons enable you to control print jobs and choose print options; they have 
the following meanings:

 

Suspends and resumes printing. Brings the printer offline for setup or for 
changing language of LCD screens.

Cancels the “oldest” job processing or printing. This button is active only when 
the 

 

Processing

 

 or 

 

Printing

 

 message appears.

At startup, or at the 

 

PRINTER OFFLINE

 

 screen, accesses the setup menus. In the 
setup menus, takes you back to the 

 

SELECT FUNCTION 

 

screen. When the 
Colorwriter is online, switches between the status windows and the Print Pages 
menu (and the warning window if a message is being displayed).

Selects the currently displayed choice on the second line of the display window 
and proceeds to the next option.

Takes you to the next entry in the list. In a fixed-length list, takes you to the next 
item in the list. When entering text, decrements to the previous character in the 
alphabet. Hold down the 

 

↓

 

 button to decrement rapidly.

Takes you to the previous entry in the list. In a fixed-length list, takes you to the 
previous item in the list. When entering text, increments to the next character in 
the alphabet. Hold down the 

 

↑

 

 button to increment rapidly.

In the setup menus, backspaces the cursor to the previous text-entry position. In 
a text field, deletes the current character as it backspaces.

In the setup menus, advances the cursor to the next text-entry position.
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Display window

 

The display window is an LCD panel on the printer control panel that provides 
information on the status of the Colorwriter, enables you to print special pages, 
and enables you to view and edit printer setup information. For information 
about using the Printer Setup menu, see Chapter 4 of 

 

Getting Started

 

.

 

Resetting default setup options

 

You can reset the setup options so that they are identical to the settings that came 
with the Colorwriter. For a complete description of the default setup options, see 
Chapter 4 of 

 

Getting Started

 

.

 

T

 

O

 

 

 

RESET

 

 

 

THE

 

 C

 

OLORWRITER

 

’

 

S

 

 

 

DEFAULT

 

 

 

SETUP

 

 

 

OPTIONS

 

:

 

1. Restart the Colorwriter by turning it off and then back on.

2. When the printer control panel displays the message “Press menu for setup” press 
the 

 

↑

 

 and 

 

↓

 

 buttons simultaneously. 

 

The current settings are deleted. 

 

SELECT FUNCTION

 

 appears on the control panel.

 

3. Press the Menu button to initialize the printer.

 

The default setup options are restored to the Colorwriter.

 

Status messages

 

When the Colorwriter is printing normally, status information appears in the 
control panel. The messages are:

•

 

INITIALIZING

 

—Displays while the printer is initializing. 

•

 

READY

 

—Appears when the printer is ready to print but not processing or 
printing a job. Also displays the free disk space and printer name.

•

 

PROCESSING

 

—Displays the name of the job currently processing.

•

 

PRINTING

 

—Displays the name of the job currently printing.

•

 

CANCELING JOB

 

—Appears when you cancel a print job.

•

 

POWER SAVER MODE

 

—Appears when the printer’s Energy Star feature is active.

For further explanation of status messages, see Appendix A of this manual.
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Warning, service, and error messages

 

If there is a printing problem, the fault light is lit, and an error message appears on 
the control panel. You can press the Menu button when an error message is 
displayed to see the other control panel screens. For information about error 
messages, see Appendix A.

 

Menu options

 

To display a list of special pages you can print from the Colorwriter control panel, 
press the Menu button. Use the

 

 

 

↓

 

 and 

 

↑

 

 

 

buttons to select the page you want to 
print, and then press the Enter button. The table below lists the special pages you 
can print.

 

Page Description

 

Test Page Prints a page with color and grayscale samples. 
Printing a test page enables you to detect printer problems. The 
following information also appears on the test page: printer name, 
product name, system software version, memory configuration, 
ethernet address, default paper size, and whether or not the optional 
cassette is installed.

Job Log Prints the job log. 
For information on the fields in the job log and on printing the job 
log in other forms, see the section on using the job log with the 
Macintosh or Windows Colorwriter LSR Spooler (for Macintosh, 
Chapter 3; for Windows, Chapter 4).

Configuration Prints the configuration page, which gives the current device 
configuration. This page lists the selected options for all Setup 
settings. Always print this page before calling service or upgrading 
memory.

Help Map Prints an overview of the screens you can access from the printer 
control panel.

Color Pages Prints the color reference charts. These pages display the RGB, CMY, 
and PANTONE color equivalents available from the Colorwriter.

Demo Page 1 Prints a color page that is representative of what might be produced in 
a corporate environment.

Demo Page 2 Prints a page that demonstrates RIP processing time.
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Using the density control panel

 

This section describes the density control panel located on the back of the 
Colorwriter. You can use the density control panel to:

• Change color density settings

• Change test pattern pages

The parts of the density control panel are shown in the following illustration:

 

M Lights when magenta is selected.

C Lights when cyan is selected.

Y Lights when yellow is selected.

Bk Lights when black is selected

Density gauge Indicates the currently selected color density or test print pattern.

COLOR SELECT Press this button to select one of the color selection indicators (M, 
C, Y, Bk) to change the density.

 

–/+

 

Use these buttons to change the density or to select a test pattern for 
the TEST PRINT function.

TEST PRINT 
button

ENTER 
button

CHANGE 
buttons

COLOR SELECT 
button

Density gauge

COLOR SELECT indicators

Magenta LED Cyan LED Yellow LED Black LED

M C Y Bk

DEFAULT ENTER
TEST 
PRINTCOLOR 

SELECT
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Density adjustment

 

Use the following procedure to customize the color density for printed pages. 
Note that you can change the color density while your job is printing. Before you 
calibrate the Colorwriter with the Fiery Print Calibrator, we recommend setting 
the density control panel to the neutral (center) position.

 

T

 

O

 

 

 

ADJUST

 

 

 

COLOR

 

 

 

DENSITY

 

:

 

1. Press COLOR SELECT to select a color to change.

 

The LED lights up indicating the selected color and density.

 

2. Press + or – to change the density. 

 

When you change the density from the current setting, the density gauge LED 
flashes.

 

ENTER After you select a new density for one of the color selection 
indicators (M, C, Y, Bk), press this button to save the new density 
for the selected color indicator.

TEST PRINT Prints a built in test pattern (solid color, solid white, gradation, 
horizontal lines, vertical lines, or grid). Use the test print to check 
the results of a density change.

Selected color

Density

M C Y Bk

DEFAULT ENTER
TEST 
PRINTCOLOR 

SELECT



 

2
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3. Press ENTER to save the new density setting.

 

The density gauge LED stops flashing when the new color density settings have 
been saved. Turning the printer on and off does not change the color density 
settings. The new settings remain in memory until they are changed again.

When the printer is on, or the density control panel is not used for at least 30 
seconds, it enters OFF mode. In OFF mode, the COLOR SELECT indicators go 
off and only the density gauge default LED (middle) lights if all the colors are set 
at the factory-shipping value. Otherwise all LEDs will go off.

If you press the + and - buttons for at least 5 seconds, all color densities are 
initialized to the default settings and the panel enters OFF mode.

 

Test patterns

 

When the printer is idle, you can print a test pattern to check the printer color 
quality. Six test patterns are available and can be selected using the density control 
panel. If you change the test pattern, the alert button on the status panel flashes 
and jobs cannot be printed. Turning off the printer resets the test pattern to the 
default page (horizontal lines). The test pattern is printed from the main cassette 
and differs from the Test Page printed from the printer control panel. 



 

2
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T

 

O

 

 

 

CHANGE

 

 

 

THE

 

 

 

TEST

 

 PATTERN:

1. While holding down COLOR SELECT, press ENTER eight times.

All color indicator LEDs will flash to indicate the shift to the test pattern selection 
mode.

2. Press + and - to select a test pattern.

See the figure below for the relationship between the density gauge LEDs and the 
test patterns available. If you select another test pattern, the density gauge LED 
for the selected pattern will flash.

3. Press ENTER to save the changes.

The LED stops flashing to indicate that the new test pattern has been saved.

M C Y Bk

COLOR
SELECT

DEFAULT ENTER
TEST

PRINT

Grid

Vertical lines Horizontal lines

Gradation

Solid white

Solid color
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Using the optional paper feeder unit
The optional paper feed unit gives you two distinct advantages:

• Increases the paper supply by approximately 250 sheets of 20-pound (80 g/m2 

stock), in addition to the 250-sheet capacity in the main cassette and the 100-
sheet multipurpose tray.

• Adds flexibility in paper size. For example, you can store letter-size paper in the 
main cassette and A4-size paper in the paper feeder unit. Thus, you can switch 
the paper source from your computer without walking to the printer to change 
the paper size.

The optional paper feeder unit comes with a cassette (shown below), which can 
hold about 250 sheets of plain paper. The supported paper sizes are Letter, A4, B5, 
and Legal. For instructions on attaching the optional paper feed unit, setting the 
paper size, and loading paper, see Chapter 2 of Getting Started.

NOTE: The locking pins are included in the paper feeder unit package. Be careful 
not to lose them.

Paper feeder unit

Optional cassette
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Handling and storing paper 
Appropriate paper handling and storage keeps the paper in the best condition for 
printing. Follow the instructions below for handling and storing paper.

• Store unused paper in its wrapping to protect the paper against humidity. 

• Do not store paper directly on the floor as the floor is generally humid. 

• Use a specially designed storage box if you need to store paper in a very humid 
place. 

• Put paper on a flat surface and do not stack the paper too high, to prevent 
excessive in-ream paper curl. 

• Do not subject paper to direct sunlight or a humid environment. 

• If the paper is moved to a place with a very different temperature, let the paper 
set there for about a day before you use it; otherwise paper curl or wrinkles will 
result.

For a list of unacceptable paper types, see page E-4.

Storing printouts
Note the following precautions for storing color printouts:

• Printed color hardly fades under normal room light. If you plan to keep the 
color printouts for a long period (more than two years), put them in a binder. 
(Sometimes the Printed color appears to change when in fact it is a color change 
in the paper itself.) 

• Do not store color printouts together with PVC materials such as clear holders. 
The toner may melt, causing the paper and the PVC materials to stick together.

• Use only non-solvent glues to glue color printouts together. 

• Solvents will dissolve the toner. Before using a glue, test it on unwanted 
printouts. 
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• Before inserting any color printout between printed pages, make sure the pages 
are completely dry, otherwise, the ink may cause the toner to melt. 

• Store color printouts flat. If they are folded or wrinkled, the toner may come 
off. 

• Store color printouts at room temperature. High temperature will cause the 
toner to melt and colors to mix.

Handling transparency film 
Use the recommended transparency film for optimum printing results (see 
page F-6). This transparency film is designed exclusively for color laser printers. 
Under no circumstances should it be used with black and white laser printers or 
other types of color printers. 

NOTE: Do not load transparency film into the paper cassette. Use the 
multipurpose tray instead. For information, see page 2-23. 

Printed transparency film should be picked up as soon as it comes out of the 
printer. This prevents possible interference with succeeding copies. Make sure no 
silicone oil gets on the transparency film. It is recommended that you use the face 
down tray. Avoid high temperatures and high humidity. Be sure to store any 
unused transparency film in its protective bag.

NOTE: Not all print media can be used on this printer. Always print a few pages 
before you purchase a large quantity of paper. For recommended paper to achieve 
optimum results, see page E-3. 
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Loading the paper cassette
The universal paper cassette included in the printer package can hold about 250 
sheets of 20-pound (80 g/m2 stock). The paper sizes supported are Letter, A4, B5, 
and Legal. 

The Colorwriter is not designed to print on envelopes or labels. Attempting to 
print on those materials could damage the printer.

Before printing in an application, specify the paper size. If you specify a paper size 
other than what is in the printer, an error message appears on the printer control 
panel and the job will not print. 

For a description of paper requirements, see Appendix E. 

This section describes how to use the paper cassette. Before loading paper into the 
cassette, always fan the paper first to loosen any sheets that are stuck together.

NOTE: Do not load transparency film into the paper cassette. Use the 
multipurpose tray instead. For information, see page 2-18. 

!
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TO REMOVE THE PAPER CASSETTE:

• While pushing up the handle on the underside of the cassette, pull out the paper 
cassette.

NOTE: To increase the paper supply, you can also add the optional paper feeder 
unit which comes with a universal paper cassette as well. For information on 
installing the feeder unit, see page 2-8 of Getting Started.

TO SET THE PAPER SIZE:

1. Place the cassette on a flat surface.

NOTE: The next two steps (2 and 3) are required for the printer to accept the new 
paper size.

2. While pressing the release button, slide the paper width guide until the desired 
paper width is selected (as marked on the tray), then release the button to lock.

LG
L

A4
LTR

B5

Paper width guide

Release button
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3. While lifting the paper length guide slightly, slide it until the desired paper 
length is selected (as marked on the tray), then release the guide to lock it. 

4. Set the size guide on the front of the cassette to the corresponding paper size.

The size guide provides you with a visual indication of the paper size loaded in the 
cassette.

TO LOAD PAPER:

1. Place the cassette on a flat surface. Then place a stack of paper into the paper 
cassette, with the side you want printed on facing up and the bottom edge going 
into the cassette first.

LG
L

A4
LTR

B5

Paper length 
guide

LGL
A4

LTR
B5
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2. Check to see that the paper stack does not exceed the paper limit mark, otherwise 
a paper jam may result.

3. Press down on the paper so that it stays under the two retaining clips, otherwise a 
paper jam may result. 

4. Align the paper cassette so that it rests on the rails inside the paper feeder unit.

Rails
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5. While pressing the handle upward, slide the cassette all the way into the paper 
feeder unit until it clicks into place.

The cassette is now ready to supply paper. 

TO READ THE PAPER AMOUNT INDICATOR:

• The blue bar goes out of view as the paper is used. When the blue bar is 
completely out of view, refill the cassette.

FULL EMPTY

Blue bar

With optional paper feeder unit
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Loading paper into the multipurpose tray
The multipurpose tray holds about 100 sheets of paper. Various paper sizes and 
types are supported, including transparency film. See “Paper requirements” on 
page E-3 for a list of paper types supported. The tray can be closed when not in 
use.

For information on loading transparency film, see page 2-23.

TO OPEN OR CLOSE THE MULTIPURPOSE TRAY:

1. Pull on the latch to open the multipurpose tray.

2. Pull out the extension tray, then gently press down to lock it.
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TO CLOSE THE MULTIPURPOSE TRAY:

1. Lift the end of the extension tray slightly, then push it into the multipurpose 
tray.

2. Close the multipurpose tray.

TO LOAD PLAIN PAPER:

1. Adjust the paper guides to the desired paper size.
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2. Tap a stack of paper on a flat surface to align its edges.

3. Insert the paper stack as far as it can go into the printer, making sure the print 
side is facing down and the top of the page is going into the printer first.

4. Check that the paper stack does not exceed the paper limit mark.
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NOTE: Do not load the multipurpose tray with different sized paper at the same 
time.

Do not place anything but paper on the multipurpose tray. Also, avoid pressing or 
applying excessive force to the multipurpose tray.

Do not add paper when there is still paper in the multipurpose tray; otherwise 
incorrect paper feed or a paper jam may occur. Add paper only when the 
multipurpose tray is empty. 

If printed pages come out of the printer curled, you can correct the problem by 
reversing the paper stack in the multipurpose tray so that the bottom of the stack 
faces up. 

If the leading edge of the paper to be used is curled, straighten it out as much as 
possible before loading it into the tray.

Do not set the paper guides so tight that the paper stack bends.
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Do not set the paper guides so loose that the paper stack is not evenly aligned.

Do not set the paper guides so that there is space between the guides and the 
paper.

Do not place the paper into the multipurpose tray at an angle.
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Loading transparency film
Transparency film can be loaded into the multipurpose tray only. About 20 sheets 
can be loaded at a time.

For optimal color print quality, use our letter-size or A4-size transparency film. 
For details, contact an authorized service representative. The transparency film has 
the following color markers for correct insertion:

When feeding transparency film into the printer, position each sheet so that the 
white positioning marker (triangle) is on the upper right. The Colorwriter accepts 
short edge feed only. Looking at a transparency with its white marker positioned 
at the upper right, the side facing away from you is the print side. 

Feeding direction

White positioning markers
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TO LOAD TRANSPARENCY FILM:

1. Open the multipurpose tray (see page 2-18 for this procedure).

2. Adjust the paper guides to accept transparency film (A4 or Letter size).

3. With the white positioning marker on the upper right, tap a stack of transparency 
film on a flat surface to align its edges.

NOTE: When tapping, try to hold the edges and avoid touching the print sides.

4. Before loading, fan the stack of transparency film to prevent sticking. Be careful 
not to scratch or leave fingerprints on the print sides.
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5. Position each sheet so that the white positing marker is on the upper right as 
shown, and push it as far as it can go into the printer.

NOTE: When you hold the transparency film this way, the print side is facing down 
on the multipurpose tray. Therefore try to keep the print sides free of scratches or 
fingerprints when placing them on the tray.

6. Check that the transparency film does not exceed the paper limit mark.

7. Make sure the proper paper delivery is selected.

For information about handling transparency film, see page 2-12.

White positioning marker
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3-1 Printing from applications

 

You can print to the Colorwriter from any Macintosh computer with Ethernet 
installed. First, select the Colorwriter LSR 2000

 

+

 

 as the current printer with the 
Chooser desk accessory, then print the file from within your application. You may 
use the Page Setup or Print dialog box to set printing options after you select the 
Colorwriter in the Chooser. 

 

Printing from applications

 

You can print to the Colorwriter from Macintosh applications by selecting the 
desired Colorwriter or Colorwriter queue in the Chooser. If you have installed the 
Adobe PostScript Printer Driver 8.0 or later or the LaserWriter printer driver 
version 8.0 or later, you can use the Print Options dialog box to override some of 
the printer settings on the Colorwriter. (We recommend that you use the Adobe 
PostScript Printer Driver.) For information about achieving the best printing 
results from specific applications, see “Application notes” on page 3-29.

 

T

 

O

 

 

 

SELECT

 

 

 

THE

 

 C

 

OLORWRITER

 

 

 

AS

 

 

 

THE

 

 

 

CURRENT

 

 

 

PRINTER

 

:

 

1. Make sure that the Colorwriter is connected to your network and turned on.

2. Select Chooser from the Apple menu.

3. Click the PSPrinter icon or the LaserWriter 8.0 icon to select the driver.

 

Select PSPrinter if you are using the Adobe PostScript Printer Driver; select 
LaserWriter 8 if you are using the LaserWriter printer driver.

 

4. If your network is divided into zones, select the zone in which the Colorwriter is 
located.

5. Select the Colorwriter in the list that appears.

 

The names of all supported printers in the zone display in the Chooser window. 
Unless your system administrator has renamed it, the printer is named 
Colorwriter LSR. 

Chapter 3:
Printing from 
Macintosh 
Computers

 

 

This document was created with FrameMaker 4.0.4
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3-2 Printing from applications

 

If you have the PCK option, and your system administrator has enabled all 
connections, you can select Colorwriter LSR_Direct to print to the direct 
connection and bypass spooling, Colorwriter LSR_Print to print to the Print 
queue, or Colorwriter LSR_Hold to print to the Hold queue.

 

N

 

OTE

 

:

 

If your system administrator disabled one of these connections the 
corresponding name will not appear in the Chooser. If your Colorwriter has the 
16MB configuration, only a single name will appear in the Chooser, representing 
the direct connection.

 

6. Make sure that AppleTalk is Active and then click the close box to quit the 
Chooser.

 

Turning off Background Printing prevents the Macintosh from spooling the 
printing jobs. The Colorwriter remains selected as the current printer until you 
choose a new printer in the Chooser.

 

T

 

O

 

 

 

PRINT

 

 

 

FROM

 

 

 

A

 

 M

 

ACINTOSH

 

 

 

APPLICATION

 

:

 

1. Make sure that any printer description files needed by the application are 
installed on your Macintosh.

 

See Chapter 6 of 

 

Getting Started 

 

for information on which files you need and 
where to install them.

 

2. Open the file you want to print from within the application.

3. Choose Page Setup from your application’s File menu.

4. Select the printing options you want in the Page Setup dialog box and click OK.

 

If the LaserWriter Page Setup dialog box lets you select from a list of available 
printers, select the Colorwriter LSR 2000

 

+

 

.

 

N

 

OTE

 

:

 

The 

 

Text Smoothing

 

,

 

 Graphics Smoothing

 

, and 

 

Faster Bitmap Printing

 

 
options have no effect on your printed document when you print with the 
Colorwriter.

 

5. Choose Print from the application’s File menu.

PCK



 

3

 

3-3 Printing from applications

6. Select the options you want and click Print.

N

 

OTE

 

:

 

Print and Print Options dialog boxes vary among printer drivers and 
applications.

If you can select a 

 

Paper Source

 

, specify the paper tray to use for the job. For 
example, you can use this dialog box to specify that the job should be printed on 
the media in the 

 

Multipurpose tray

 

.

 

7. Click Options to set additional information for the print job.

N

 

OTE

 

:

 

These additional options are available if you are using the Adobe PostScript 
Printer Driver or the Apple LaserWriter driver version 8.0 or later. 

The options in the lower part of this dialog box are specific to the Colorwriter. 
They override default settings in the Printer Setup from the control panel. 

Scroll to see all the options.

Make sure that 

 

Color/Grayscale

 

 or 

 

ColorSync Color Matching

 

 is chosen from 
the Print pop-up menu, otherwise your file may print in black and white.

Choosing 

 

ColorSync Color Matching

 

 allows you to use the ColorSync 2.0 
profiles. With this option, make sure you also select the Colorwriter profile.
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3-4 Printing from applications

 

Click 

 

Save

 

 after you change the options to make the new settings your default 
settings. Don’t click 

 

Save

 

 if you want to use the Colorwriter defaults for each job.

 

N

 

OTE

 

:

 

This affects printing from all applications, not just the one you are using.

If you select 

 

Printer’s Default

 

, the Colorwriter prints with the instructions 
entered during Setup for Color Mode and Rendering Style. The options you can 
specify are:

 

Color Mode—CMYK/Grayscale

 

Specify the color mode for the document. Select 

 

CMYK

 

 if it is a color document. 
Select 

 

Grayscale

 

 if it is a grayscale document or if you want a color document to 
print in grayscale.

 

Paper Type—Plain Paper/Transparency

 

Use this option to specify the type of media to be printed on. Select 

 

Plain Paper 

 

if 
you will be printing on standard printer paper. Select 

 

Transparency

 

 if you will be 
printing on a transparency. 

 

Rendering Style—Photographic/Presentation/Monitor/Solid Color

 

Use this option to select a default color rendering dictionary (CRD) to be used 
when you print an RGB file from the Adobe PostScript Printer Driver or an 
application such as Adobe Photoshop that supports PostScript Level 2. 

Selecting the appropriate color rendering dictionary for the type of image you are 
printing assures optimum color output on the Colorwriter. The 

 

Photographic

 

 
CRD optimizes the range of colors on the Colorwriter to produce the best results 
for photographic or bitmapped images. The 

 

Presentation

 

 CRD optimizes the 
output of pure, saturated colors such as those used in business presentations, and 
is especially suited for printing transparencies. The 

 

Solid Color

 

 

 

CRD is most 
useful for printing spot colors such as those found in company logos. The 

 

Monitor

 

 CRD improves the correspondence between colors as they are displayed 
on the computer monitor and colors in the printed output.
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N

 

OTE

 

:

 

Color rendering dictionaries are not used when CMYK files are sent to the 
Colorwriter, nor are they used when RGB files are sent from PostScript Level 1 
applications when using any printer driver or QuickDraw applications when 
using the LaserWriter 7.x or other PostScript Level 1 printer drivers.

 

Brightness—85% Lightest/90% Lighter/95% Light/100% Normal/105% 
Dark/110% Darker/115% Darkest

 

Change the Brightness setting if a file prints too dark or too light. Select 

 

85%

 

 for 
a substantially lighter image, 

 

115%

 

 for a substantially darker image, or one of the 
options in between. 

You can override this setting in the Colorwriter LSR Spooler Override Print 
Settings window (see page 3-24).

 

8. In the Printer Setup dialog box, click OK to accept the changes.

PCK
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3-6 Printing pages from the multipurpose tray

 

Printing pages from the multipurpose tray

 

You can use the Colorwriter to print manually fed pages if you want to print on 
special paper, such as letterhead or colored paper, or a transparency. 

 

T

 

O

 

 

 

PRINT

 

 

 

PAGES

 

 

 

USING

 

 

 

THE

 

 

 

MULTIPURPOSE

 

 

 

TRAY

 

: 

 

1. Open the multipurpose tray and insert a sheet of paper or a transparency.

 

For information on using transparency film, see page 2-23. For information on 
loading multiple sheets of paper into the multipurpose tray, see page 2-18. Be sure 
to use the page size specified in the Page Setup dialog box of your application. 

 

2. From your application, select Multipurpose Tray as the Paper Source in the Page 
Setup or Print dialog box.

 

If you want to print on a transparency, click Options in the Print dialog box, 
choose Transparency for the Paper Type, and choose Presentation for the 
Rendering Style. Some applications provide these options from different dialog 
boxes.

 

3. Click Print in your application’s Print dialog box.

 

A message appears on your Macintosh screen and on the printer control panel 
reminding you to insert paper in the multipurpose tray. Click OK.

The job prints on the page that was inserted in the multipurpose tray. If you did 
not specify the correct size for the page you are printing, the page may not be 
centered when it prints.
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Using Colorwriter LSR utilities
The Macintosh utilities enable you to perform additional functions with your 
Colorwriter. The following utilities are included on the Colorwriter User Software 
CD:

• The Colorwriter LSR Downloader

• The Colorwriter LSR Spooler

• The Fiery Print Calibrator

NOTE: The Colorwriter LSR utilities can be used only if you have a 
Colorwriter LSR 2000+ with the PCK option installed.

Using the Colorwriter LSR Downloader
You can use the Colorwriter LSR Downloader to: 

• Print PostScript and Encapsulated PostScript (EPS) files. 

• Check the status of the Colorwriter.

• Manage the PostScript printer fonts stored on the Colorwriter hard disk.

NOTE: You can also use standard LaserWriter downloaders, such as the Adobe Font 
Downloader, with the Colorwriter LSR 2000+. The Colorwriter LSR Downloader 
was designed specifically for the Colorwriter LSR 2000+ printer. You cannot use it 
with any other printer.

PCK

PCK

PCK



33-8 Using the Colorwriter LSR Downloader

TO VIEW STATUS INFORMATION WITH THE COLORWRITER LSR DOWNLOADER:

1. Double-click the Colorwriter LSR Downloader icon.

2. Select the Colorwriter LSR 2000+ in the Chooser window that appears and click 
Connect.
.

You see the Colorwriter LSR Downloader window, with a File menu, icons, the 
Colorwriter Status window, and a status bar at the bottom of the screen. 
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Icons for some menu functions are displayed in the Toolbar at the top of the 
window. Click the button to perform the function. You can toggle the display of 
the Toolbar by choosing Toolbar in the View menu. The icons are:

The Print Status region displays the printer status, the user name, and document 
name of the job currently printing.

The RIP Status region displays the server status, the user name, and the document 
name of the job currently processing. 

The Download Progress bar displays the number of bytes processed when you 
download a job to the printer.

The Colorwriter Hard Disk area displays the amount of available disk space on 
the Colorwriter LSR 2000+.

You can click the Display Font List button or choose Font List from the File 
menu to view font information in the window.

3. To select a different Colorwriter choose Open from the File menu, select another 
Colorwriter in the Chooser window that appears, and click Connect.

4. To close a particular Downloader window, click to make it active, and choose Close 
from the File menu. To close the application, choose Quit from the File menu.

Open Colorwriter Click this button to connect to a different 
Colorwriter or Colorwriter queue

Download Click this button to download a file or 
font to the Colorwriter

Display font list Click this button to display a list of the 
fonts on the Colorwriter’s hard disk.

Display status 
window

Click this button to display the status 
window for the current Colorwriter. 
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Printing with the Colorwriter LSR Downloader
Printing PostScript files with Colorwriter LSR Downloader is fast—generally 
faster than printing from within applications. If you regularly print large files, be 
sure to try printing with the Colorwriter LSR Downloader.

TO DOWNLOAD A FILE WITH THE COLORWRITER LSR DOWNLOADER:

1. Use your application to generate a PostScript or EPS file.

You can save a PostScript file by selecting the PostScript option in the application’s 
Print dialog box. With some applications, you can save Encapsulated PostScript 
(EPS) files.

If you experience problems printing EPS files with the Colorwriter LSR 
Downloader, you can print the file directly from the application in which you 
created it.

2. Double-click the Colorwriter LSR Downloader icon.

3. Choose Download from the File menu or click the Download button.

A dialog box containing a list of files appears.
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4. Select the file type to display in the Show pop-up menu.

You can leave this at the default All known formats, or select All Files. All known 
formats will list all files in formats supported by the Colorwriter LSR 
Downloader; All Files will list all files.

NOTE: You can download files and fonts in the same batch.

5. Select where to download the file in the Queue pop-up menu.

You can select the Print queue, Hold queue, or Direct connection. Disabled 
queues will not appear in the pop-up menu. Fonts automatically go to the Direct 
connection.

6. Select the filename and click Add.

You can use the dialog box to move to different drives and directories to select files 
to download. Click Add All to add all files in a folder.

If you change your mind about a file, select the filename in the Files to Download 
list and click Remove.

Click Remove All to remove all files from the Files to Download list.

7. To change attributes of a job, select it and click Options. 

8. Specify the following information in the dialog box and click OK.

Copies—Specify the number of copies you want by entering the number in the 
Copies text box.

Brightness—Change the Brightness setting if the printed results are too dark or 
too light. Select 85% for a substantially lighter image, 115% for a substantially 
darker image, or one of the options in between these two values. 
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NOTE: Some applications, including Adobe Photoshop, provide transfer functions 
that let you specify density settings for an image. If the file you are printing 
includes transfer functions, the Colorwriter LSR Downloader Brightness options 
will have no effect on your printout. For more information on using transfer 
functions, see the documentation for your application.

‘showpage’ (after EPS files)—In most cases, you do not need to use this option. 
Select the ‘showpage’ option only if an EPS file fails to print without it. This 
option adds a “showpage” PostScript language command at the end of the print 
job. If you select this option unnecessarily, extra blank pages may print.

9. Repeat steps 7 and 8 for any other jobs as needed.

10. When you have selected all files, click Download.

11. Press Command-Period (.) to cancel downloading.

Downloading and managing printer fonts 
Before printing a PostScript or EPS file that requires fonts that are not resident on 
the Colorwriter LSR 2000+ hard disk, you must download the fonts manually. 

The Colorwriter comes with PostScript fonts. These include regular, bold, italic, 
and bold italic versions of Courier, Times, Helvetica, Helvetica Narrow, Helvetica 
Condensed, ITC Avant Garde, Palatino, ITC Bookman, and New Century 
Schoolbook. Also included are ITC Zapf Dingbats, ITC Zapf Chancery, and ITC 
Symbol.

NOTE: You cannot use the Colorwriter LSR Downloader to download TrueType 
fonts. For information on downloading fonts from a Windows computer, see 
page 4-20.
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TO DOWNLOAD A PRINTER FONT:

1. Double-click the Colorwriter LSR Downloader icon.

2. Make sure the direct connection is selected.

If necessary, select Open from the File menu to open a new connection.

3. Choose Download from the File menu.

4. Select the printer fonts you want to download and click Add, or double-click the 
printer font name. Choose Add All to add all of the fonts in the current folder.

Printer fonts are usually stored in the Fonts folder or Extensions folder inside the 
System Folder. Select the Fonts or Extensions folder from within the System 
Folder, and click Open. A list of available fonts appears.

5. Repeat Step 4 for all fonts you want to download.

If you change your mind, select the font in the Files to Download list and click 
Remove. Click Remove All to remove all files from the list.

6. When you have selected all fonts, click Download.

Printer fonts and Macintosh screen fonts 

Like all PostScript fonts, the fonts included with the Colorwriter LSR 2000+ 
come in two forms: printer fonts and screen fonts. The printer fonts are installed 
permanently on the Colorwriter LSR 2000+ hard disk. The screen fonts which are 
included with the Colorwriter LSR 2000+ should be installed on your Macintosh. 
If you are using these fonts in documents you print on a LaserWriter, they are 
probably already installed. If not, you’ll need to install them yourself. See 
Chapter 6 in Getting Started for instructions.

Occasionally, you may want to use PostScript fonts that are not included with the 
Colorwriter LSR 2000+. If so, you’ll need to install both the screen fonts and the 
printer fonts on your computer. To do this, follow the instructions from the font 
manufacturer. 

Downloading printer fonts to the Colorwriter 

In general, each time you print from within an application, the application 
automatically downloads any fonts used in your document that are not already 
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installed on the Colorwriter LSR 2000+, as long as the printer fonts are installed 
in your System Folder. These fonts remain in the Colorwriter only until your 
document has printed. If you print the same document again, your application 
must download the fonts again.

If you regularly use one or more fonts from the Macintosh that are not already 
installed on the Colorwriter, you can save time by downloading them to the 
Colorwriter with the Colorwriter LSR Downloader. Fonts you download to the 
Colorwriter remain installed until you remove them using the Colorwriter LSR 
Downloader, no matter how many times the Colorwriter is turned off and on. 
You’ll probably want to download fonts you use on a regular basis to the 
Colorwriter. 

Before you print PostScript or Encapsulated PostScript (EPS) files using the 
Colorwriter LSR Downloader, make sure that all fonts included in your file are 
installed on the Colorwriter. If your file contains fonts that are not installed on 
the Colorwriter, the text in these fonts will not print correctly and may not print 
at all. With some drivers, you can include fonts when you create PostScript files. 
See your application software for information.
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TO VIEW FONT INFORMATION:

1. Choose Font List from the File menu or click the Font List button.

The Font List window is displayed with the Update, Print, and Delete buttons in 
the titlebar.
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The icons in the Font list window are:

2. Click the Update button to update the information in the list.

3. Click the Print Font List button to print the font list. 

4. Highlight a font and click the Delete button to delete the font.

Shift-click to select multiple fonts.

NOTE: The 39 printer fonts included with the Colorwriter (resident fonts) are 
locked. Locked fonts appear with a lock icon next to the name and cannot be 
deleted.

Update Click this icon to update the information in the font 
list window.

Print Font 
List

Click this icon to print the font list.

Delete Select a font and click this icon to delete it from the 
Colorwriter hard disk.
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Using the Colorwriter LSR Spooler
The Colorwriter LSR Spooler lets you monitor and manipulate the print jobs that 
you send to the Colorwriter. It also lets system administrators track and manage 
all users’ print jobs. 

Colorwriter LSR Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the Colorwriter hard disk. Make sure that you 
leave enough space on the hard disk for fonts and other Colorwriter LSR Spooler 
jobs. Files printed to the direct connection are not available from the 
Colorwriter LSR Spooler.

You can use the Colorwriter LSR Spooler job log for job accounting purposes, or 
just to view information about jobs printed to the Colorwriter. The job log can be 
printed to the Colorwriter or saved as a file and viewed in other applications.

TO USE THE COLORWRITER LSR SPOOLER:

1. Double-click the Colorwriter LSR Spooler icon.

Print Print jobs sent to the Colorwriter Print queue appear in the 
Print queue list. You can move and manipulate these jobs as 
described below.

Hold Jobs sent to the Hold queue remain in the Hold queue until 
they are moved to the Print queue or deleted. If you need to 
print the same document frequently, you can send it to the 
Hold queue and move a copy of the job to the Print queue every 
time you need to print it. You can also print large jobs to the 
Hold queue and then move them to the Print queue when other 
users are not printing.

Printed The jobs most recently printed by the Colorwriter are saved in 
the Printed queue. You can drag these jobs back to the Print 
queue to print additional copies. The number of jobs saved in 
the Printed queue is set by your System Administrator in the 
Printer Setup.

PCK
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2. Select the Colorwriter LSR 2000+ from the list of devices, and click Connect.

The Colorwriter LSR Spooler main window and File, Edit, Window, and 
Administrator menus appear. 
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The job list includes information about the document name, user name, time and 
date sent, print device, and file size. 

The window is split into regions that correspond to the different queues and steps 
in the printing process. You can click and drag a job to the Print or Hold region of 
the window to move it to the corresponding queue. 

The icons provide information about the job:

Printing Print 
icon

The job that is currently printing appears in 
this list. It can be selected and deleted to 
cancel printing.

Waiting Print 
icon

Jobs that have been processed and are waiting 
to be printed appear in this list. They are 
dimmed because they cannot be canceled, 
their settings cannot be changed, and they 
cannot be moved.

Ripping RIP 
icon

Jobs that are processing appear in the scroll 
list, but they are dimmed because their 
settings cannot be changed and they can’t be 
moved.

Print Print 
icon

Jobs that are waiting to be printed that have 
not been processed appear with the Print 
icon. This list shows jobs in the order they 
will be printed. 

Hold Hold 
icon

Jobs in the Hold queue appear with the Hold 
icon. You can move the job to the Print queue 
to print it.

Printed Printed
 icon

Jobs that have been printed are saved in the 
Printed queue and appear with the Printed 
icon. Jobs are stored in the Printed queue 
until the limit set in the Printer Setup on the 
control panel is reached. 

Printed Alert 
icon

If a PostScript error occurred while a job was 
printing, it appears in the Printed queue with 
an Alert icon next to it. You can double-click 
the Alert icon to display the error message.
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Icons also appear above the scroll list. The icons are:

3. Choose Preferences from the Edit menu to specify how the Colorwriter LSR 
Spooler behaves.

The Preferences window appears. 

You can use this window to specify that the Colorwriter:

Update Automatically every n seconds or Update Manually—This option lets 
you specify whether the Colorwriter LSR Spooler main window is automatically 
updated every 20 seconds (or at an interval that you set), or whether it is updated 

Update Click this icon to update the information in the 
Colorwriter LSR Spooler main window.

Duplicate
and Print

Drag a job onto this icon or select the document and 
click this icon to move a duplicate of the job to the 
Print queue.

Print Drag a job onto this icon or select the document and 
click this icon to move it to the Print queue.

Hold Drag a job onto this icon or select the document and 
click this icon to move it to the Hold queue.

Delete/
Cancel

Drag a job onto this icon or select the document and 
click this icon to delete it or cancel processing or 
printing it. You will be asked to verify that you want 
to delete the job. You can eliminate the verification 
notice by turning off the Confirm file deletion 
option in the Preferences window.
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only when you choose the Update command from the Window menu. By default, 
the Colorwriter LSR Spooler main window is updated automatically every 20 
seconds.

NOTE: When automatic updating is on, data from the Colorwriter is transmitted 
over the network very frequently. This data adds to the network traffic, and may 
slow down other network jobs. For optimum network performance, turn off 
automatic updating in the Colorwriter LSR Spooler Preferences dialog box; when 
you want to view updated information in the Colorwriter LSR Spooler windows, 
choose Update from the Window menu or click the Update icon.

Confirm file deletion—Select this if you want a confirmation dialog box to 
appear before you delete a file.

4. If you selected Manual updating in the Preferences window, choose Update from 
the Window menu to update the information in the Colorwriter LSR Spooler 
window.

To manage print jobs, see page 3-22.

To use the job log, see page 3-25.

5. To display information about a different Colorwriter, choose Open Colorwriter LSR 
from the File menu.

The Chooser window appears.

6. Select the Colorwriter LSR 2000+ in the Chooser.

The Colorwriter LSR Spooler main window appears and displays information 
about the Colorwriter you selected.

7. You can move between Colorwriter LSR Spooler windows by choosing the 
Colorwriter LSR 2000+ name in the Window menu.

8. Choose Close from the File menu to close the connection to the current 
Colorwriter; choose Quit from the File menu to quit the Colorwriter LSR Spooler 
application.
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Duplicating, copying, moving, and deleting jobs
Users can always move, delete, and configure their own print jobs. If a password 
has been set, users can manipulate only their own print jobs; the Colorwriter 
system administrator (or anyone with Colorwriter LSR Spooler password access) 
can move, prioritize, delete, and configure jobs for all users.

You can move your jobs from the Hold queue and the Printed queue to the Print 
queue. If, for example, you frequently print the same file, you can send it to the 
Hold queue and later drag a copy of the file to the Print queue. By copying rather 
than moving a job, you leave a copy of the job in the Hold queue so that you can 
print the job again later. You can also duplicate a job if you want to have multiple 
copies of a job in the same queue.

Duplicating jobs

When you duplicate a job, the Colorwriter creates a reference to the original file, 
so duplicate files do not require the full amount of disk space on the Colorwriter. 
As long as one of the duplicates remains, the Colorwriter saves the file, so you can 
delete all but one reference to a file.

TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Command-click to select multiple, non-
adjacent jobs in the list.

2. Choose Duplicate Job from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Command-click to select multiple, non-
adjacent jobs in the list.
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2. Click the Duplicate and Print icon, or drag the job to the Duplicate and Print icon.

The job appears at the bottom of the Print queue. 

TO COPY A JOB TO ANOTHER QUEUE:

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Command-click to select multiple, non-
adjacent jobs in the list.

2. Click Command-D to duplicate the job.

3. Drag the duplicate job to either the Hold or Print queue icon or to the Hold or 
Print section of the job list.

A copy of the job is moved to the queue you have selected, but the original job 
still appears in the Hold or Printed queue so that you can print the job at another 
time.

TO MOVE A JOB WITHIN A QUEUE:

1. Choose Password from the Administrator menu and enter the password.

If there is no password, go to step 2.

2. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select adjacent jobs in the list; Command-click to select multiple, non-
adjacent jobs in the list.

3. Drag the file to the new location in the queue.
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TO MOVE JOBS BETWEEN QUEUES:

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to make selections of adjacent jobs in the list; Command-click to select 
multiple, non-adjacent jobs in the list.

2. Move the selected job to another queue by dragging it to the queue icon of your 
choice or to the Hold or Print section of the job list.

For example, move a job that is currently in the Hold queue to the Print queue by 
dragging the job to the Print queue icon. 

TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete icon or click the Delete icon.

You can also choose Delete from the Edit menu to delete a selected job.

If a password has been set, you can only delete your own jobs; system 
administrators who enter the Colorwriter LSR Spooler password can delete any 
job. See page 3-28 for more information.

Changing print settings for a job
You can use the Override Print Settings window to set certain printing parameters 
for a job. The settings in this dialog box override the settings made in the Print 
Options window and the control panel Printer Setup.

You can only change printing parameters for jobs in the Hold, Print, and Printed 
queue sections of the Colorwriter LSR Spooler main window.

If a password has been set, you can only change print settings for your jobs; system 
administrators who enter the Colorwriter LSR Spooler password can change print 
settings for any job. See page 3-28 for more information.
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TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the 
Edit menu.

The Override Print Settings dialog box appears. 

2. Select the new settings.

Select any of the options in the pop-up menus. If you select Default Settings, the 
job will use the settings in the Print dialog box.

3. Click OK to make changes.

Using the job log
With the Colorwriter LSR Spooler, you can view and print a log of all the jobs 
printed to the Colorwriter. You can also save the job log as a text file that you can 
then import into a spreadsheet or word processing application for job accounting 
purposes. All printed or downloaded jobs are listed in the job log. 

TO DISPLAY, PRINT, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Window menu. 

You can move between the Job Log and Main windows for a server by choosing 
them in the Window menu. 



33-26 Using the Colorwriter LSR Spooler

2. Specify the period for the job log in the dialog box that appears.

Click All to view all jobs since the job log was cleared; click Date if you want to 
specify a period of time for the job log, and enter the dates you want.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information 
about them: status, document name, user name, date, start time, end time, 
process time, file size, print device, paper size, media, number of originals, 
number of color pages, number of black and white pages, and total number of 
pages.

Use the scroll bar at the bottom of the window to view all fields in the Job Log 
window.

Print icon

Export icon

Update icon
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The text in the Status column provides information about the job:

4. To print the job log, choose Print Job Log from the File menu or click the Print 
icon at the top of the window.

The information displayed in the Job Log window prints to the current 
Colorwriter. When you print the job log, totals are printed for all appropriate 
columns.

5. To save the job log as a file that you can view with a different application, choose 
Export Job Log from the File menu or click the Export icon at the top of the 
window.

6. Enter a name for the log file, and click Save. 

The job log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

7. If an Administrator password was set, and you entered the password, you can 
choose Delete Job Log from the File menu to clear the job log. 

The system administrator can also print and clear the job log from the control 
panel.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You 
can double-click ERROR to display the error message. A 
dialog box displays the PostScript error. Click OK to close the 
dialog box.

CANCEL The job was canceled before printing was completed.
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TO USE ADMINISTRATOR FUNCTIONS:

1. Choose Password from the Administrator menu.

This option is only available if a password was created on the Colorwriter.

2. Enter the password in the window that appears. 

This password is initially set in the Setup on the control panel. Once it is set, only 
persons with the password can move, override, and delete all users’ jobs in the 
Colorwriter LSR Spooler main window, and re-order jobs within a queue.
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Application notes
This section provides special instructions for optimizing color output with the 
following Macintosh applications:

• Adobe Illustrator 5.0 and 5.5

• Aldus PageMaker 5.0

• Adobe Persuasion 3.0

• Adobe Photoshop 2.5 and 3.0

• Macromedia FreeHand 5

• Microsoft PowerPoint 4.0

• QuarkXPress 3.2 and 3.3

• Other QuickDraw applications

NOTE: Make sure the Colorwriter is selected in the Macintosh Chooser before you 
specify information within applications.

Adobe Illustrator 5.0 and 5.5
In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

Choosing fill and line colors

You can create fill and line colors using the process color model (entering a 
percentage for cyan, magenta, yellow, and black) or choose a named color using 
one of the four color matching systems supplied. Note that displayed versions of 
colors you choose may not match Colorwriter output exactly. 

Monitor calibration

To calibrate your monitor to resemble the Colorwriter’s output more closely, 
follow the instructions in the Adobe Illustrator User Guide. You will need to create 
a progressive color bar like the one found in that guide, and print it on the 
Colorwriter.
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Working with imported files

You should use EPS files for all raster artwork that will be placed in Illustrator 
documents. If the image is RGB, it should be saved from Adobe Photoshop, since 
Photoshop includes PostScript information in RGB EPS files that activates the 
Colorwriter CRDs. Using this type of image file, the image will print from 
Illustrator as it does from Photoshop. For details, see “Exporting image files to 
other applications” on page 3-39. Note that using a different file format will 
compromise the printed output of RGB bitmaps, since no CRD will be activated. 

If you use a pixel-editing application other than Photoshop, you should separate 
the image to CMYK before importing it. CMYK raster images from high-end 
scanners are typically separated for offset printing, and may need some color 
correction to print properly on your Colorwriter. 

Selecting options when printing

Illustrator files can be printed directly to the Colorwriter without using Adobe 
Separator . No special settings for Colorwriter printing are typically required in 
the Print and Page Setup dialog box. It is necessary to make selections in the Print 
Options dialog box only if:

• The Illustrator document you are printing includes a placed photographic 
image saved from Photoshop as an RGB EPS file.

• You want to choose a specific feature such as Paper Type.
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Aldus PageMaker 5.0
In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

TO CHANGE THE PAGE SETUP DIALOG BOX:

1. Choose Page setup from the File menu.

2. Choose options in the Page setup dialog box when you begin creating the 
PageMaker document. 

3. Enter 600 dpi for “Target printer resolution,” as shown below: 

Choosing fill and line colors

You can create fill and line colors using the process (CMYK), RGB, or HSB color 
model, or choose a named color using one of the four color matching systems 
supplied. Note that displayed versions of colors you choose may not match the 
printer output exactly. 

Working with imported files

You should use EPS files for all artwork that will be placed in PageMaker 
documents unless you are using the option-print feature. 

If the image is RGB, it should be saved from Adobe Photoshop, since Photoshop 
includes PostScript information in RGB EPS files that activates the Colorwriter 
CRDs. Using this type of image file, the image will print from PageMaker as it 

Choose 600 from 
the pop-up menu
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does from Photoshop. For details, see “Exporting image files to other applications” 
on page 3-39. Note that using a different file format will compromise the printed 
output of RGB bitmaps, since no CRD will be activated. 

If you use a pixel-editing application other than Photoshop, you should separate 
the image to CMYK before importing it. CMYK bitmaps from high-end scanners 
are typically separated for offset printing, and may need some color correction to 
print properly on your Colorwriter. 

Imported files and option-print

EPS files will not print correctly when using the option-print feature, described in 
the following section. Use CMYK TIFF files instead.

Selecting options when printing

You can print two ways in PageMaker 5.0:

• By choosing Print from the File menu, as is standard with other applications. 
You will not be able to use printer features (such as choosing a Paper Type or 
Rendering Style) that are normally available with PostScript Level 2 printer 
drivers.

• By using the option-print feature (hold down the option key while choosing 
Print from the File menu).

NOTE: If you use the option-print feature, EPS files will print at the low resolution 
used for their screen previews. Therefore, this method is recommended only when 
you need to choose a printer-specific feature. Additional instructions on using 
option-print are found on page 3-35.
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TO CHOOSE OPTIONS WHEN PRINTING:

1. From the Type pop-up menu in the Print dialog box, choose the printer file for 
your Colorwriter.

2. To access more print options, click Paper, Options, or Color.

3. In the Paper dialog box, choose a paper size and a paper tray.
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4. In the Options dialog box, click Optimized and click Faster (binary).

5. In the Color dialog box, click Composite and click Color.

Optimized

Faster (binary)

Composite

Color
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Using option-print

To use the option-print feature, hold down the option key while selecting Print 
from the File menu. In the Print document dialog that is displayed, the Paper 
button is replaced by the Setup button, which you use to access printer features.

Click Setup to
access printer

features (a Page
Setup dialog box is
displayed initially)

Click OK (a
Printer dialog

box is displayed)

Choose a paper size

Click to display
the Print Options

dialog box

Click to return to
the Print document

dialog box
Choose a paper tray
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Adobe Persuasion 3.0
Presentations created in Persuasion can be printed to the Colorwriter on plain 
paper or on transparency film for projection. For best results, you should use the 
Colorwriter’s built-in CRDs. Note that you will need to use a PostScript Level 2 
printer driver, such as the Adobe PostScript Printer Driver.

Working with imported files

You can import graphics in EPS, PICT, Windows Metafile, and Photo CD 
formats into Persuasion. EPS files are recommended for printing to the 
Colorwriter. However, if you plan to show the presentation on a monitor as well 
as in hardcopy form, you may want to use a PICT file, which will display with 
better quality. Note that RGB EPS and PICT files may print differently.

All RGB files imported into Persuasion are affected by your choice of rendering 
style in the Print Options dialog box. Because the CRD that is best suited to the 
presentation’s other picture elements may not be appropriate for imported 
photographic images, you may want to have these images bypass the CRD 
altogether. To do this, separate the image and save it as a CMYK EPS file using a 
pixel-editing application such as Adobe Photoshop. 

Choose printer 
features 

Choose Color/
Grayscale
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Selecting options when printing

To use the CRD when printing from Persuasion, choose Calibrated Color/
Grayscale in the Print Options dialog box. In general, you should choose 
Presentation or Solid Color for Rendering Style. For detailed instructions on 
setting print options, see “Printing from applications” on page 3-1.

NOTE: To print your presentation on transparency film, you must use the 
multipurpose tray. For instructions, see “Printing pages from the multipurpose 
tray” on page 3-6.

Adobe Photoshop 2.5 and 3.0
The files in the Separation Tables folder on the user software CD are for use with 
Adobe Photoshop. These files provide EFICOLOR data conversions when you use 
Photoshop to convert images from one mode to another, such as between RGB, 
Lab color, and CMYK color spaces. 

Mode conversions are commonly used when you use Photoshop to print an image 
specified in RGB mode to a printer (such as the Colorwriter) that uses CMYK 
toner colors. They are also used when you use Photoshop to save separations.

EFICOLOR color conversions that involve RGB data should start with a 
standardized RGB color space. This is provided by the Calibrated RGB file, which 
is loaded into Photoshop’s Monitor Setup.

In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

TO PRINT FROM PHOTOSHOP TO THE COLORWRITER: 

1. Make sure you have installed a copy of Calibrated RGB monitor settings file in the 
Photoshop folder. 

2. If you use Photoshop 2.5, make sure the plug-in called “Don't Tag RGB 
PostScript ” is not placed in the Photoshop Plug-ins folder. 

This plug-in disables Colorwriter CRDs when printing RGB files.
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3. From the Chooser, select the PSPrinter icon, and then select the name of your 
Colorwriter. 

4. Load the Calibrated RGB monitor settings file, as described in the next section.

Loading Calibrated RGB monitor settings

The Calibrated RGB monitor settings file ensures consistent results when using 
Colorwriter CRDs. You need to load the settings file only once. The settings 
remain loaded unless you change them.

TO LOAD THE CALIBRATED RGB MONITOR SETTINGS FILE:

1. Start Photoshop, choose Preferences from the File menu, and choose Monitor 
Setup from the submenu.

The Monitor Setup dialog box is displayed.

2. Click Load to load the Calibrated RGB file. 

3. Choose High from the Ambient Light pop-up menu. 

Before you apply the settings, you should see this:

4. Click OK to apply the settings.

NOTE: Changing settings in the Monitor Setup dialog box will affect your printed 
output from RGB images. If you’re not sure whether the Calibrated RGB settings 
are loaded, load them again.

IMPORTANT: Choose High
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Selecting options when printing

You must select the “Print in RGB” option in the Print dialog box to use the 
Colorwriter’s built-in CRDs. 

You need to make selections in the Print Options dialog box only if:

• You previously chose a rendering style other than Photographic for your saved 
set of print options.

• You want to choose a feature such as Paper Type.

Exporting image files to other applications

If you’re preparing an image to import into another application, you should save it 
as an EPS format file. Photoshop puts PostScript information in RGB EPS files 
that activates the Colorwriter CRDs. Performing any needed rotating, cropping, 
and resizing to the image in Photoshop before saving it will speed printing from 
the application the image is placed in.

Click to display the
Print Options

dialog box

IMPORTANT: Click Print in 
RGB to use the printer CRDs

Click Binary

Choose Color/Grayscale

Choose Photographic for 
Rendering Style and any 
other printer-specific 
features 
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Macromedia FreeHand 5
In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

Choosing fill and line colors

You can create fill and line colors using the process (CMYK), RGB, or HSL color 
models, or choose a named color using one of the color matching systems 
supplied. Note that displayed versions of colors you choose may not match 
Colorwriter output exactly.

Working with imported files

You should use EPS files for all raster artwork that will be placed in FreeHand 
documents. 

If the image is RGB, it should be saved from Adobe Photoshop, since Photoshop 
includes PostScript information in RGB EPS files that activates the Colorwriter 
CRDs. Using this type of image file, the image will print from FreeHand as it does 
from Photoshop. For details, see “Exporting image files to other applications” on 
page 3-39. If you use a different file format it will compromise the printed output 
of RGB bitmaps since no CRD will be activated. 

If you use a pixel-editing application other than Photoshop, you should separate 
the image to CMYK before importing it. CMYK raster images from high-end 
scanners are typically separated for offset printing, and may need some color 
correction to print properly on your Colorwriter. 

NOTE: EPS separations should be saved without the DCS option selected. DCS 
files placed in FreeHand documents print at the low resolution used for the screen 
viewing on the Colorwriter.
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Selecting options when printing

Refer to the following illustrations to choose options when printing.

Click to set printer-
specific Print

Options

Click to set FreeHand 
Print Options 

Click to set Output 
Options 

Click Use PPD 
Information

Your printer model
appears here,
provided it is

selected in the
Chooser

Choose Unadjusted

Click Composite proof
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You need to set printer-specific Print Options (by clicking Options in the Print 
dialog box) only if:

• The FreeHand document you are printing includes a placed photographic 
image saved from Photoshop as an RGB EPS file.

• You want to choose a feature such as Paper Type.

Microsoft PowerPoint 4.0
Presentations created in PowerPoint can be printed to the Colorwriter on plain 
paper or on transparency film for projection. 

In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

Working with imported files

Use EPS format files for all raster images you want to import into PowerPoint. 
They print at their full resolution on a Colorwriter (rather than the low resolution 
used for the screen preview). 

NOTE: Importing TIFF and PICT files into PowerPoint may cause printing 
problems. You should avoid using them.

Leave these fields blank

Click Binary data

Don’t check Split 
complex paths
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All RGB files imported into PowerPoint are affected by your choice of CRD in the 
Print Options dialog box. Because the CRD that is best suited to the 
presentation’s other picture elements may not be appropriate for imported 
photographic images, you may want to have photographs bypass the CRD 
altogether. To do this, separate the image and save it as a CMYK EPS file using a 
pixel-editing application such as Adobe Photoshop. 

Selecting options when printing

Refer to this section to select options in the Print and Print Options dialog boxes. 
To use a CRD when printing from PowerPoint, choose Calibrated Color/
Grayscale in Print Options. In general, you should choose Presentation or Solid 
Color for the Rendering Style (CRD). 

NOTE: To print your presentation on transparency media, see “To load 
transparency film:” on page 2-24, and “Printing pages from the multipurpose 
tray” on page 3-6.

Click to display
the Print Options

dialog box

IMPORTANT: Choose 
Calibrated Color/Grayscale

Choose Presentation or Solid 
Color for Rendering Style, and 
any other printer-specific 
features



33-44 Application notes

QuarkXPress 3.2 and 3.3
This section gives condensed instructions for using QuarkXPress 3.2 and 3.3 with 
the EFICOLOR color management system. For further instructions for using 
QuarkXPress with EFICOLOR, see Using the EFICOLOR XTension with 
QuarkXPress, included with QuarkXPress.

In general, you should use the Adobe PostScript Printer Driver, although 
LaserWriter 8.0 and 7.1 are also supported.

NOTE: You do not need the EFICOLOR color management system to print from 
QuarkXPress.

TO USE QUARKXPRESS:

• Make sure you have installed the QuarkXPress PDF file and the EFICOLOR color 
management system.

The PDF file comes with the Colorwriter user software; EFICOLOR comes with 
QuarkXPress.

Use the following table for reference.

The EFICOLOR XTension is included with QuarkXPress 3.2 and 3.3. If you are 
missing this file, run the QuarkXPress Installer. 

Make sure this file: Is installed on your hard disk drive:

QuarkXPress PDF file for 
your printer

• QuarkXPress 3.2:
In the folder where QuarkXPress is located

• QuarkXPress 3.3:
In the PDF folder, inside the folder where QuarkXPress 
is located

EFICOLOR XTension
and the
EFICOLOR EPS 
XTension

• QuarkXPress 3.2:
In the folder where QuarkXPress is located

• QuarkXPress 3.3:
In the XTension folder, inside the folder where 
QuarkXPress is located
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Setting QuarkXPress preferences

Use the Preferences settings shown in this section to activate EFICOLOR color 
management.

Application Preferences on the Edit menu

For accurate display of 
TIFF images, choose 16 bit 
or 32 bit

Click Display Correction 
and choose the profile for 
your monitor
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EFICOLOR Preferences on the Edit menu

NOTE: Default profiles selected for EFICOLOR preferences become source profiles 
for vector-based artwork that is either created in QuarkXPress or imported into 
QuarkXPress. (Source profiles are explained in detail on page 3-47.) If you choose 
SWOP-Coated for a default CMYK profile, EFICOLOR converts process colors 
to simulate on your Colorwriter how they would print on a press that meets 
SWOP standards. If you want process colors in vector-based artwork to print on 
the Colorwriter without conversion, choose your Colorwriter profile for a default 
CMYK profile.

Click the checkboxes 
to activate all of 
these options

Choose SWOP-Coated or the
Colorwriter profile

Choose Calibrated RGB
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Working with imported files

The following file formats are supported by the EFICOLOR color management 
system, and are converted to print correctly on your Colorwriter:

• TIFF

• PICT

• Scitex CT

• EPS and DCS files created by Adobe Illustrator 5.5 and earlier, Adobe 
Photoshop 3.0 and earlier, and Aldus FreeHand 4.5 and earlier

NOTE: QuarkXPress sends only the low-resolution preview of placed DCS files to 
composite printers such as the Colorwriter. These previews may not give an 
accurate representation of the image as it will print on a printing press.

Assigning source profiles and color rendering styles

Each color image file imported into a QuarkXPress document has a source profile 
and a color rendering style associated with it that determine how EFICOLOR 
processes the image when you print. Source profiles describe the color device 
originally used to display, print, or scan an image. If you are importing an image 
that was created or edited on a monitor, you should choose the corresponding 
monitor profile. If you are importing a CMYK file that was prepared for offset 
printing, choose the printer profile corresponding to the offset process or proofing 
system. 

You assign source profiles and color rendering styles in different places, depending 
on the type of file that is imported. Source profiles for vector artwork—files 
created in illustration applications such as Adobe Illustrator—are assigned on a 
global basis in EFICOLOR Preferences (See page 3-46). Source profiles and color 
rendering styles for raster images can be set on an image-by-image basis as shown 
in the following sections.
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Importing TIFF and PICT files

Assign a source profile and color rendering style to TIFF and PICT image files in 
the Get Picture dialog box when you import them.

Get Picture on the File menu

Choose a source profile 
for the image

Choose a color rendering 
style for the image
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Page Setup

Refer to the following illustrations to select options in the Page Setup dialog box. 

Choose the Colorwriter LSR 
2000.PDF file 

Choose an output 
paper size 

Contone printing: Enter 200 
for the highest possible 
quality. Enter 100 for faster 
printing.

Choose Binary
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Setting options when printing

It is necessary to make selections in the Print Options dialog box only if you want 
to choose a printer-specific feature such as Paper Type. 

Other QuickDraw applications
This section contains guidelines for printing from other QuickDraw applications. 
(Almost all word processors, spreadsheets, and presentation packages are 
QuickDraw applications; they rely on QuickDraw rather than the PostScript 
language to send words and pictures to printers. Examples include Microsoft 
Word, Excel, PowerPoint, and Aldus Persuasion.) Since most QuickDraw 
applications function similarly for Colorwriter printing, the instructions here are 
applicable to many printing scenarios. Note that you will need to use a PostScript 
Level 2 printer driver, such as the Adobe PostScript Printer Driver.

Click to display the
Print Options

dialog box

Make sure Separation is off

Choose Color/Grayscale
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Be sure to read the application’s User Guide, as well the ReadMe file if one is 
included, for additional information about printing. 

Working with imported files

Although your application may allow you to import a variety of file formats, we 
recommend using EPS format files for all raster images you want to import; some 
applications have printing problems when using file formats such as TIFF and 
PICT. 

If the image is RGB, it should be saved from Adobe Photoshop, since Photoshop 
includes PostScript information in RGB EPS files that activates the Colorwriter 
CRDs. Using this type of image file, the image will print from your application as 
it does from Photoshop. For details, see “Exporting image files to other 
applications” on page 3-39. 

Note that all RGB files imported into your document are affected by your choice 
of CRD in the Print Options dialog box. Because the CRD that is best suited to 
other picture elements in your document or presentation may not be appropriate 
for imported photographic images, you may want to have photographs bypass the 
CRD altogether. To do this, separate the image and save it as a CMYK EPS file 
using a pixel-editing application such as Adobe Photoshop.

If you use a pixel-editing application other than Photoshop, you should separate 
the image to CMYK before importing it. CMYK bitmaps from high-end scanners 
are typically separated for offset printing, and may need some color correction to 
print properly on your Colorwriter. 
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Selecting options when printing

Refer to this section to select options in the Print and Print Options dialog boxes. 
To use a CRD when printing from your application, choose Calibrated Color/
Grayscale in Print Options. 

Click to display
the Print Options

dialog box

IMPORTANT: Choose 
Calibrated Color/Grayscale

For detailed instructions 
on setting print options, 
see page 3-3
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4-1 Printing from PC-compatible Computers

 

The Colorwriter enables you to print from an IBM PC-compatible computer 
connected to the Colorwriter over a network or directly to the parallel port. This 
chapter gives some tips on printing from PCs using Windows 3.x, Windows 95 or 
Windows NT, and includes the following topics:

• Printing to the Colorwriter from Windows

• Configuring Windows printing options

• Printing pages from the multipurpose tray

• Using the Colorwriter LSR Downloader

• Using the Colorwriter LSR Spooler

• Application notes

Chapter 4:
Printing from 
PC-compatible 
Computers

 

 

This document was created with FrameMaker 4.0.4
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4-2 Printing to the Colorwriter from Windows

 

Printing to the Colorwriter from Windows

 

For information on setting up the Windows environment for printing with the 
Colorwriter, see Chapter 6 of 

 

Getting Started

 

, which describes how to set up your 
network and enable a connection to the parallel port, IPX (Novell) networks, and 
TCP/IP networks. For information on how to install the Colorwriter Windows 
utilities, also see Chapter 6 of 

 

Getting Started

 

. 

You can print files directly to the Colorwriter from within your Windows 
application. If you plan to print files at another location, you should follow the 
procedures described below. You can print from a PC connected to the parallel 
port on the Colorwriter or by using a network protocol supported by the 
Colorwriter. 

 

Printing from applications

 

Once you have installed the PostScript printer driver and the Colorwriter PPD 
(PostScript printer description), and set the proper port as described in Chapter 5 
and Chapter 6 of 

 

Getting Started

 

, you should be able to print directly from most 
Windows applications by choosing the Print command from within the 
application.

For information about achieving the best printing results from specific 
applications, see “Application notes” on page 4-37.

 

Saving files to print at a remote location

 

If you are preparing files to take to a service bureau or other location, you can 
print your final files to disk in PostScript format. You can also print to disk to 
create a file to be downloaded with the Colorwriter LSR Downloader. If you will 
be sending files to a service bureau, you should check with the service bureau 
before printing files to disk.
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4-3 Configuring Windows printing options

 

Configuring Windows printing options

 

Printing options are configured by using the PostScript printer driver that 
corresponds to your particular system. The following table refers to the printer 
driver installation for each type of Windows operating system.

The following sections describe how to configure printing options with each 
operating system.

 

Configuring printing options on Windows 3.x

 

Although we recommended that you use the Adobe PostScript Printer Driver 
(ADOBEPS.DRV) included with the Colorwriter, you can also use the PostScript 
printer driver (PSCRIPT.DRV) included with your Windows software. Once you 
have installed the Colorwriter PPD (PostScript printer description), you can select 
the printer settings you prefer. You can also change these settings from within your 
application when you send a file to the Colorwriter. This setup is different for the 
Adobe PostScript Printer Driver and the Windows PostScript printer driver. 

Make sure you follow the procedure that corresponds to the driver you are using:

• If you are using the Adobe PostScript Printer Driver, see the following 
procedure.

• If you are using the Windows PostScript printer driver, see page 4-7.

 

Using: PostScript Driver:  Installation

 

Windows 3.x PostScript level 1 or 
PostScript level 2

page 6-43 or
page 6-41 of 

 

Getting Started

 

Windows NT Features similar to 
PostScript level 1

page 6-26 of 

 

Getting Started

 

Windows 95 PostScript level 2 page 6-18 of 

 

Getting Started
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T

 

O

 

 

 

CHANGE

 

 

 

THE

 

 

 

PRINTER

 

 

 

SETUP

 

 

 

WITH

 

 

 

THE

 

 A

 

DOBE

 

 P

 

OST

 

S

 

CRIPT

 

 P

 

RINTER

 

 
D

 

RIVER

 

 

 

FOR

 

 W

 

INDOWS

 

 3.

 

X

 

:

 

1. In the Main group of the program manager, double-click the Control Panel icon.

2. In the Control Panel window, double-click the Printers icon.

3. In the Printers dialog box, select the Colorwriter LSR 2000 v2015.108 in the 
Installed Printers box. Then click the Setup button.

4. Select the paper size and paper orientation in the Print Setup dialog box.

 

In the 

 

Paper Source

 

 drop-down list, specify the paper tray to use for the job. For 
example, you can use this dialog box to specify that the job should be printed on 
the media in the 

 

Multipurpose tray

 

.

 

5. Click the PostScript tab in the Print Setup dialog box.



 

4

 

4-5 Configuring Windows printing options

6. Select the appropriate information for your file and click OK.

N

 

OTE

 

:

 

Setting 

 

Match Color Across Printers 

 

activates the color rendering 
dictionaries.

 

7. Click the Features tab to display the Features window, select the appropriate 
settings, and then click OK.



 

4

 

4-6 Configuring Windows printing options

 

The options in this window are specific to the Colorwriter. 

 

N

 

OTE

 

:

 

The settings you select in the PostScript Options, Features, and Print Setup 
windows override the settings specified in Printer Setup on the Colorwriter. You 
can override the Brightness setting in the Colorwriter LSR Spooler Override Print 
Settings window. 

If you select 

 

Printer’s Default

 

 for Color Mode and Rendering Style in the Features 
dialog box, the Colorwriter prints with the configuration instructions that were 
entered in the Setup at the printer control panel.

The options you can specify are:

 

Color Mode—CMYK/Grayscale

 

Specify the color mode for the document. Select 

 

CMYK

 

 if it is a color document. 
Select 

 

Grayscale

 

 if it is a grayscale document or if you want a color document to 
print in grayscale.

 

Paper Type—Plain Paper/Transparency

 

Use this option to specify the type of media to be printed on. Select 

 

Plain Paper 

 

if 
you will be printing on standard paper. Select 

 

Transparency

 

 if you will be printing 
on a transparency. 

 

Rendering Style—Photographic/Presentation/Monitor/Solid Color

 

Use this option to select a color rendering dictionary (CRD) to be used when you 
print an RGB file from the Adobe PostScript Printer Driver or an application such 
as Adobe Photoshop 2.5 (or later) that supports PostScript Level 2. 

Selecting the appropriate color rendering dictionary for the type of image you are 
printing assures optimum color output on the Colorwriter. The 

 

Photographic

 

 
CRD optimizes the range of colors on the Colorwriter to produce the best results 
for photographic or bitmapped images. The 

 

Presentation

 

 CRD optimizes the 
output of pure, saturated colors such as those used in business presentations, and 
is especially suited for printing transparencies. The 

 

Solid Color

 

 

 

CRD is most 
useful for printing spot colors such as those found in company logos. The 

 

Monitor

 

 CRD improves the correspondence between colors as they are displayed 
on your computer monitor and colors in the printed output.
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Color rendering dictionaries are not used when CMYK files are sent to the 
Colorwriter, nor are they used when RGB files are sent using a PostScript Level 1 
driver such as PSCRIPT.DRV for Windows 3.1 or the Windows NT PostScript 
printer driver.

 

Brightness—85% Lightest/90% Lighter/95% Light/100% Normal/
105% Dark/110% Darker/115% Darkest

 

Change the Brightness setting if a file prints too dark or too light. Select 

 

85%

 

 for 
a substantially lighter image, 

 

115%

 

 for a substantially darker image, or one of the 
options in between.

 

8. In the Printer Setup dialog box, click OK.

 

You can also use the Windows PostScript printer driver (PSCRIPT.DRV) 
included with your Windows 3.x software, although we recommend that you use 
the Adobe PostScript Printer Driver (ADOBEPS.DRV) included with the 
Colorwriter.

 

T

 

O

 

 

 

CHANGE

 

 

 

THE

 

 

 

PRINTER

 

 

 

SETUP

 

 

 

WITH

 

 

 

THE

 

 W

 

INDOWS

 

 3.

 

X

 

 P

 

OST

 

S

 

CRIPT

 

 
P

 

RINTER

 

 D

 

RIVER

 

:

 

1. Double-click the Printers icon in the Control Panel window.

2. In the Printers dialog box, select the Colorwriter in the Installed Printers list box 
and click Setup.
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3. Use the Print Setup dialog box to specify information about the printer setup 
such as the paper source, paper size, and paper orientation.

N

 

OTE

 

: Print Setup dialog boxes vary across applications. 

4. Click Options in the Print Setup dialog box.

Do not use the Encapsulated PostScript File option when you are printing to the 
Colorwriter. This option is for files you wish to import into other applications.

Make sure that the Color checkbox is selected.

Make sure that the Send Header with Each Job checkbox is selected. This option 
ensures that all the correct PostScript information is sent to the Colorwriter.

Select the Default option under Margins for best printing results.

You can change the size of the image by changing the Scaling factor in this dialog 
box, or you can control the image size from within your application.
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5. Click Advanced to set additional options.

The Advanced Options dialog box appears. This dialog box allows you to set 
advanced printing options. 

You can use this dialog box to choose how to send TrueType fonts to the 
Colorwriter. In most cases, you should set the Send to Printer option to Adobe 
Type 1, and select the Use Substitution Table option. For a higher accuracy of 
font rendition, download the exact font you want from your application (i.e., do 
not select Use Substitution Table). Click Help for more information about 
TrueType conversion options.

The Virtual Memory box is set automatically. Click Help for information about 
changing this setting.

The Clear Memory per Page should be on. Click Help for information about this 
option.

The Resolution box displays only the option of 600 dpi because the Colorwriter 
is a 600 dpi printer.

Selecting Negative Image changes black to white, blue to yellow, red to green, and 
so forth. This option may not have an effect in all applications.

The effect of selecting All Colors to Black varies from one application to another. 
In some applications this option has no effect.
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Selecting Mirror prints a mirror image of the original. 

The Conform to Adobe Document Structuring Convention option should be 
off. Special effects created with some applications will not print if this option is 
selected.

6. Click OK.

7. When you have set the printing options, close all the dialog boxes.

Configuring printing options on Windows 95

TO CONFIGURE PRINTING OPTIONS ON WINDOWS 95:

1. Double-click the My Computer icon.

2. Double-click the Printers icon.

3. Click the icon for the Colorwriter to select it.

4. Choose Properties from the File menu.

The Colorwriter Properties window appears with the General tab displayed.
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The Colorwriter Properties window contains eight tabs that allow you to 
configure printing options. 

5. Specify the Paper source and the number of copies that you want printed.

You may also use this tab to set orientation and layout options.



44-12 Configuring Windows printing options

6. Choose the Device Options tab.

The Device Options tab allows you to change the Color Mode, Rendering Style, 
Brightness, and settings for the Optional Cassette (if installed) of the Colorwriter.

7. To change a setting, select the feature in the Printer features area, and then 
select one of the options in the “Change settings for” list. Click OK when you 
have entered the settings you want.

If you select Printer’s Default for any of the Printer features, the Colorwriter prints 
with its default value, or with a setting entered during Printer Setup on the 
Control Panel.

NOTE: The settings you select in the Paper, Features, Device Options, and 
PostScript tabs of the Properties window override the settings specified in the 
Printer Setup on the Colorwriter. This window can be used for entering both job-
specific and printer-specific settings.
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Configuring printing options on Windows NT
The Windows NT PostScript printer driver that you install with the Colorwriter 
PPD does not give your applications access to all the paper and tray selection 
options and printer features that you get with the PostScript level 2 drivers you 
can install on Windows 3.1 or Windows 95. For example, it does not provide a 
means of altering the settings for Brightness, Color Mode, or Rendering Style for 
all your print jobs.

Adobe Photoshop gives you access to two rendering styles when you print RGB 
files to the Colorwriter, if you have installed the Monitor Setup file and loaded the 
Separation tables for Photographic or Solid Color rendering (see Getting Started, 
page 6-70).

Once you have printed a job to the Colorwriter, you can override the print 
settings for Rendering Style and Brightness from the Colorwriter LSR Spooler 
(see page 4-31).

Applications differ in offering access to the Colorwriter paper trays. In general, to 
print to the Colorwriter Multipurpose tray, select Manual Feed from printing 
options dialog boxes, Print Setup, or Page Setup dialog boxes.

Printing pages from the multipurpose tray
You can use the Colorwriter’s multipurpose tray if you want to print on special 
paper, such as letterhead or colored paper, or on a transparency. 

TO PRINT PAGES USING THE MULTIPURPOSE TRAY: 

1. Open the multipurpose tray and insert the paper, or insert a transparency.

Be sure to use the page size specified in the Page Setup dialog box of your 
application. 

2. From your application’s Print Setup, Page Setup, or Print dialog box, select 
Multipurpose Tray as the Paper Source.

If you want to print on a transparency, choose Transparency for the Media Type, 
and choose Presentation for the Rendering Style. 



44-14 Printing pages from the multipurpose tray

These options are available if you are using Windows 95 with the Microsoft 
PostScript driver (see “Configuring Windows printing options” on page 4-3 or 
“Configuring printing options on Windows 95” on page 4-10. Some applications 
provide these options in a different dialog box.

3. Click Print in your application.

The job prints on the page that was inserted in the multipurpose tray. If you did 
not specify the correct size for the page you are printing, the page may not be 
centered when it prints.
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Using Colorwriter utilities
The Windows utilities enable you to perform additional functions with your 
Colorwriter. The following utilities are included on the Colorwriter User 
Software CD:

• Colorwriter LSR Downloader

• Colorwriter LSR Spooler 

• Colorwriter LSR Manager

The Windows Colorwriter utilities are supported by the Windows 95 and the 
Windows NT operating systems, communicating with the printer with TCP/IP 
or IPX/SPX (Novell) network protocols. The Colorwriter utilities are not 
supported by the Windows 3.x operating system.

NOTE: Colorwriter utilities require a Colorwriter with the Professional Color Kit 
option (PCK) installed.

Using the Colorwriter LSR Downloader
You can use the Colorwriter LSR Downloader to: 

• Print PostScript and Encapsulated PostScript (EPS) files.

• Check the status of the Colorwriter.

• Manage the PostScript printer fonts stored on the Colorwriter hard disk.

NOTE: You can also use standard LaserWriter downloaders, such as the Adobe Font 
Downloader, with the Colorwriter. The Colorwriter LSR Downloader was 
designed specifically for the Colorwriter. You cannot use it with any other printer. 

PCK

PCK

PCK
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TO VIEW STATUS INFORMATION WITH THE COLORWRITER LSR DOWNLOADER:

1. Choose Colorwriter LSR Downloader from the Windows 95 Start button or 
appropriate Windows NT program group.

The Colorwriter LSR utilities function the same way on Windows 95, 
Windows NT, and Macintosh computers.

2. Select the Colorwriter in the Chooser window that appears and click OK.

You see the Colorwriter LSR Downloader window, with icons, a Status window, 
File and Window menus, and a status bar at the bottom of the screen. 
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Icons for some menu functions display in the Toolbar at the top of the window. 
Click the button to perform the function. You can toggle the display of the 
Toolbar by choosing Toolbar in the View menu. The icons are:

The Print Status area displays the status and the user name and document name of 
the job currently printing.

The RIP Status area displays the status and the user name and document name of 
the job currently processing.

The Download Progress bar dynamically displays the progress of the job being 
downloaded.

The Hard Disk area displays the amount of available disk space on the 
Colorwriter.

You can click the Display Font List button or choose Font List from the File menu 
to view font information in the window.

3. To select a different Colorwriter or Colorwriter connection, choose Open from the 
File menu, select the Colorwriter LSR 2000+ in the chooser dialog that appears, 
and click OK.

You can only select a different Colorwriter if it has been previously configured on 
your system; it must be listed in the NET_WSCK.INI file. It is recommended that 
you use the Colorwriter LSR Manager for this purpose (see Getting Started ).

4. To close the window, choose Close from the File menu; to close the application 
select Exit from the File menu.

Open Click this button to connect to a different 
Colorwriter.

Download Click this button to download a file or font to the 
Colorwriter

Display font list Click this button to display a list of printer fonts 
on the Colorwriter’s hard disk.

Display status 
window

Click this button to display the status window for 
the current Colorwriter. 

About the 
Downloader

Click this button to view version information 
about the Colorwriter LSR Downloader.
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Printing with the Colorwriter LSR Downloader
Printing PostScript files with Colorwriter LSR Downloader is fast—generally 
faster than printing from within applications. If you regularly print large files, be 
sure to try printing with the Colorwriter LSR Downloader.

TO DOWNLOAD A FILE OR FONT WITH THE COLORWRITER LSR DOWNLOADER:

1. Use your application to generate a PostScript or EPS file.

You can save a PostScript file by selecting the File option in the application’s Print 
dialog box. With some applications, you can save Encapsulated PostScript (EPS) 
files.

If you experience problems printing EPS files with the Colorwriter LSR 
Downloader, you can print the file directly from the application in which you 
created it.

2. Double-click the Colorwriter LSR Downloader icon.

3. Choose Download from the File menu or click the Download button.

A dialog box containing a list of files appears.

Go up one level

Create a new folder

View list (L) or
view file details (R)

You can drag files into a
new folder, or rename a

folder
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4. Select the file type to display in the Show pop-up menu.

You can leave this at the default All known formats, or select All Files. All known 
formats will list all files in formats supported by the Colorwriter LSR 
Downloader; All Files will list all files.

The File name field displays the name(s) of the selected file(s) before you click 
Add.

NOTE: You can download files and fonts in the same batch. See page 4-20 for more 
information about downloading fonts.

5. Select where to download the file in the Queue pop-up menu.

You can select the Print queue, Hold queue, or Direct connection. If the 
connection is not enabled, an error message will be displayed. Fonts are 
automatically downloaded to the Direct connection.

6. Select the filename and click Add File(s).

You can use the dialog box to move to different drives and directories to select files 
to download.

If you change your mind about a file, select the filename in the Files to be 
Downloaded list and click Remove File(s).

7. To change attributes of a job, select the filename and click Options. 

8. Specify the following information in the dialog box and click OK.

Copies—Specify the number of copies you want by entering the number in the 
Copies text box.

Brightness—Change the Brightness setting if a file prints too dark or too light. 
Select 85% for a substantially lighter image, 115% for a substantially darker 
image, or one of the options in between. 
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NOTE: Some applications, including Adobe Photoshop, provide transfer functions 
that let you specify density settings for an image. If you saved a Photoshop file as 
EPS and included transfer functions, the Colorwriter LSR Downloader 
Brightness options will have no effect on your printout. For more information on 
using transfer functions, see the documentation for your application.

‘showpage’ after EPS files—In most cases, you do not need to use this option. 
Select the ‘showpage’ option only if an EPS file fails to print without it. This 
option adds a “showpage” PostScript language command at the end of the print 
job. If you select this option unnecessarily, extra blank pages may be printed.

9. Repeat steps 7 and 8 for any other jobs as needed.

10. When you have selected all files and fonts, click Download.

11. To cancel downloading, press the Escape key.

Downloading and managing printer fonts 
Before printing a PostScript or EPS file that requires PostScript fonts that are not 
resident on the Colorwriter hard disk, you must download the fonts manually. 

The Colorwriter comes with PostScript fonts installed. These include regular, 
bold, italic, and bold italic versions of Courier, Times, Helvetica, Helvetica 
Narrow, Helvetica Condensed, ITC Avant Garde, Palatino, ITC Bookman, and 
New Century Schoolbook. Also included are ITC Zapf Dingbats, ITC Zapf 
Chancery, and ITC Symbol. 

Windows screen fonts that correspond to the printer fonts installed on the 
Colorwriter are not supplied with the Colorwriter. However, the Windows 
operating system substitutes a similar font for screen display.

NOTE: If you are using TrueType fonts, you can print them by converting them to 
Adobe Type 1 fonts. To do this with the Adobe PostScript Printer Driver, click the 
Fonts tab and select Send TrueType Fonts to This Printer as Type 1. To do this 
with the Windows 95 PostScript printer driver, click the Fonts tab and select 
Always use built-in printer fonts instead of True Type fonts.
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Occasionally, you may want to use Adobe Type 1 fonts that are not included with 
the Colorwriter. If so, you’ll need to install both the screen fonts and the printer 
fonts on your computer. To do this, follow the instructions from the font 
manufacturer. 

Downloading printer fonts to the Colorwriter LSR 2000+ 

If your applications regularly use one or more fonts that are not already installed 
in the Colorwriter, you can save time by downloading them to the Colorwriter 
hard disk with the Colorwriter LSR Downloader. Fonts you download to the 
Colorwriter hard disk remain installed until you remove them using the 
Colorwriter LSR Downloader, no matter how many times the Colorwriter is 
turned off and on. You’ll probably want to download fonts you use on a regular 
basis to the Colorwriter. 

NOTE: The fonts you can download must be Windows PostScript printer outline 
fonts, with a file extension of .pfb. You cannot use the Colorwriter LSR 
Downloader to download TrueType fonts.

Before you print PostScript or Encapsulated PostScript (EPS) files using the 
Colorwriter LSR Downloader, make sure that all fonts included in your file are 
installed in the Colorwriter. If your file calls for fonts that are not installed on the 
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Colorwriter, the text in these fonts will not print correctly and may not print at 
all. With some applications, you can include fonts when you create PostScript 
files. See your application software for information.

TO VIEW FONT INFORMATION:

1. Choose Font List from the File menu or click the Font List button.

The Font List window is displayed with the Update, Print, and Delete buttons in 
the titlebar.
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The icons in the Font list window are:

2. Click the Update button to update the information in the list.

3. Click the Print Font List button to print the font list. 

4. Highlight a font and click the Delete button if you want to delete the font.

Shift-click to select multiple fonts.

NOTE: The 39 printer fonts included with the Colorwriter (resident fonts) are 
locked. Locked fonts appear with a lock icon next to the name and cannot be 
deleted.

Update Click this icon to update the information in the 
font list window.

Print 
Font List

Click this icon to print the font list.

Delete Select a font and click this icon to delete it.
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Using the Colorwriter LSR Spooler
The Colorwriter LSR Spooler utility lets you monitor and manipulate the print 
jobs that you send to the Colorwriter. It also lets system administrators track and 
manage all users’ print jobs. 

Colorwriter LSR Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the Colorwriter hard disk. Make sure that you 
leave enough space on the hard disk for fonts and other Colorwriter LSR Spooler 
jobs.

Files printed to the direct connection are not available from the Colorwriter LSR 
Spooler. 

You can use the Colorwriter LSR Spooler job log for job accounting purposes, or 
just to view information about jobs printed to the Colorwriter. The job log can be 
printed to the Colorwriter or saved as a file and viewed in other applications.

Print Normal print jobs sent to the Colorwriter print queue appear 
in the Print queue or are added to the end of the print queue. 
You can move and manipulate these jobs as described below.

Hold Jobs sent to the Hold queue remain in the Hold queue until 
they are moved to the Print queue or deleted. If you need to 
print the same document frequently, you can send it to the 
Hold queue and move a copy of the job to the Print queue 
every time you need to print it. You can also print large jobs to 
the Hold queue and then move them to the Print queue when 
other users are not printing.

Printed The jobs most recently sent to the Colorwriter are saved in the 
Printed queue. You can drag these jobs back to the Print queue 
to print additional copies. The number of jobs saved in the 
Printed queue is set by your system administrator in the Setup. 

PCK
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TO USE THE COLORWRITER LSR SPOOLER:

1. Choose Colorwriter LSR Spooler from the Windows 95 Start button or appropriate 
Windows NT program group.

The Colorwriter LSR utilities function the same way on Windows 95, 
Windows NT, and Macintosh computers.

2. Select the Colorwriter LSR 2000+ in the window that appears, and click OK.

The Colorwriter LSR Spooler main window and File, Edit, Window, Help, and 
Administrator menus appear. 
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In the main window, the job list includes information about the document name, 
user name, time and date sent, print device, and file size. 

The job list is split into regions that correspond to the different queues and steps 
in the printing process. You can click and drag a job to the Print or Hold region of 
the window to move it to the corresponding queue. 

The icons provide information about the job:

Printing Print icon The job that is currently printing appears in 
this list. It can be selected and deleted to 
cancel printing.

Waiting Print icon Jobs that have been processed and are waiting 
to be printed appear in this list. They are 
dimmed because they cannot be canceled, 
their settings cannot be changed, and they 
cannot be moved.

Ripping RIP icon Jobs that are processing appear in the scroll 
list, but they are dimmed because their 
settings cannot be changed and they can’t be 
moved or canceled.

Print Print icon Jobs that are waiting in the Print queue and 
have not been processed appear with the Print 
icon. This list shows jobs in the order they will 
be printed. 

Hold Hold icon Jobs in the Hold queue appear with the Hold 
icon. You can move the job from the Hold 
queue to the Print queue to print it.

Printed Printed 
icon

Jobs that have been printed are saved in the 
Printed queue and appear with the Printed 
icon. Jobs are stored in the Printed queue until 
the limit set in the Printer Setup on the 
control panel is reached. 

Printed Alert icon If a PostScript error occurred while a job was 
printing, it appears in the Printed queue with 
an Alert icon next to it. You can double-click 
the Alert icon to display the error message.
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Icons also appear above the scroll list. The icons are:

3. Choose Preferences from the Edit menu to specify how the Colorwriter LSR 
Spooler behaves.

The Preferences dialog box appears. 

You can use this window to specify that the Colorwriter:

Update Automatically every n seconds or Update Manually—This option lets 
you specify whether the Colorwriter LSR Spooler main window is automatically 
updated every 20 seconds (or at an interval that you set), or whether it is updated 
only when you choose the Update command from the Window menu. By default, 
the Colorwriter LSR Spooler main window is updated automatically every 20 
seconds.

Update Click this icon to update the information in the 
Colorwriter LSR Spooler main window.

Duplicate 
and Print

Drag a job onto this icon or select the document and 
click this icon to move a duplicate of the job to the Print 
queue.

Print Drag a job onto this icon or select the document and 
click this icon to move it to the Print queue.

Hold Drag a job onto this icon or select the document and 
click this icon to move it to the Hold queue.

Delete/
Cancel

Drag a job onto this icon or select the document and 
click this icon to delete it or cancel processing or printing 
it. You will be asked to verify that you want to delete the 
job. You can eliminate the verification notice by turning 
off the Confirm file deletion option in the Preferences 
window.
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NOTE: When automatic updating is on, data from the Colorwriter is transmitted 
over the network very frequently. This data adds to the network traffic, and may 
slow down other network jobs. For optimum network performance, turn off 
automatic updating in the Colorwriter LSR Spooler Preferences dialog box; when 
you want to view updated information in the Colorwriter LSR Spooler windows, 
choose Update from the Window menu or click the Update icon.

Confirm file deletion—Select this if you want a confirmation dialog box to 
appear before you delete a file.

4. If you selected Manual updating in the Preferences window, choose Update from 
the Window menu to update the information in the Colorwriter LSR Spooler 
window.

To manage print jobs, see page 4-29.

To use the job log, see page 4-32.

5. Choose Close from the File menu to close the connection to the current 
Colorwriter; choose Quit from the File menu to quit the Colorwriter LSR Spooler 
application.

6. To display information about a different Colorwriter, choose Open from the File 
menu.

A selection window appears. 

7. Select the Colorwriter LSR 2000+ in the selection window.

The Colorwriter LSR Spooler main window appears and displays information 
about the Colorwriter you selected.

You can move between Colorwriter LSR Spooler windows by choosing the 
Colorwriter name in the Window menu. You can move between the Job Log and 
Main windows for a Colorwriter by choosing them in the Window menu. You can 
also use the Cascade option in the Window menu to organize windows on your 
Desktop. 

8. Choose Close from the File menu to close the connection to the current 
Colorwriter; choose Exit from the File menu to quit the Colorwriter LSR Spooler 
application.
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Duplicating, copying, moving, and deleting jobs
Users can always move, delete, and configure their own print jobs. If a password 
has been set, users can manipulate only their own print jobs; the Colorwriter 
system administrator (or anyone with Colorwriter LSR Spooler Password access) 
can move, delete, prioritize and configure jobs for all users. You can move your 
jobs from the Hold queue and the Printed queue to the Print queue. If, for 
example, you frequently print the same file, you can send it to the Hold queue and 
later drag a copy of the file to the Print queue. By copying rather than moving a 
job, you leave a copy of the job in the Hold queue so that you can print the job 
again later. You can also duplicate a job if you want to have multiple copies of a 
job in the same queue.

Duplicating jobs

When you duplicate a job, the Colorwriter creates a reference to the original file, 
so duplicate files do not require the full amount of disk space on the Colorwriter. 
As long as one of the duplicates remains, the Colorwriter saves the file, so you can 
delete all but one reference to a file.

TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent 
jobs in the list.

2. Choose Duplicate Job from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent 
jobs in the list.
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2. Click the Duplicate and Print icon, or drag the job to the Duplicate and Print icon.

The job appears at the bottom of the Print queue. 

TO COPY A JOB TO ANOTHER QUEUE:

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent 
jobs in the list.

2. Choose Duplicate Job from the Edit menu. 

3. Drag the duplicate job to either the Hold or Print queue icon or to the Hold or 
Print section of the job list.

The original job still appears in the Hold or Printed queue so that you can print 
the job at another time.

TO MOVE A JOB WITHIN A QUEUE:

1. Choose Password from the Administrator menu and enter the password.

If there is no password, go to step 2.

2. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to select adjacent jobs in the list; Ctrl-click to select multiple, non-adjacent 
jobs in the list.

3. Drag the file to the new location in the queue.

TO MOVE JOBS BETWEEN QUEUES:

1. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-
click to make selections of adjacent jobs in the list; Ctrl-click to select multiple, 
non-adjacent jobs in the list.

2. Move the selected job to another queue by dragging it to the queue icon of your 
choice or to the Hold or Print section of the job list.
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For example, move a job that is currently in the Hold queue to the Print queue by 
dragging the job to the Print queue icon. 

TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete icon or click the Delete icon.

You can also choose Delete from the Edit menu to delete a selected job.

If a password has been set, you can only delete your own jobs; system 
administrators who enter the Colorwriter LSR Spooler password can delete any 
job. See page 4-35 for more information.

Changing print settings for a job
You can use the Override Print Settings window to set certain printing parameters 
for a job. The settings in this dialog box override the settings entered in your 
application, in your printer driver options, or the control panel Printer Setup.

You can only change printing parameters for jobs in the Hold, Print, and Printed 
queue sections of the Colorwriter LSR Spooler main window.

If a password has been set, you can only change print settings for your jobs; system 
administrators who enter the Colorwriter LSR Spooler password can change print 
settings for any job. See page 4-35 for more information.
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TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the 
Edit menu.

The Override Print Settings window appears. 

2. Select the new settings.

Select any of the options in the pop-up menus. If you select Default Settings, the 
job will use the settings in the Print dialog box.

3. Click OK to make changes.

Using the job log
With the Colorwriter LSR Spooler, you can view and print a log of all the jobs 
printed to the Colorwriter. You can also save the job log as a text file that you can 
then import into a spreadsheet or word processing application for job accounting 
purposes. All printed or downloaded jobs are listed in the job log. 

TO DISPLAY, PRINT, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Window menu. 

You can move between the Job Log and Main windows for a server by choosing 
them in the Window menu. 
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2. Specify the period for the job log in the dialog box that appears.

Click All to view all jobs since the job log was cleared; click Date if you want to 
specify a period of time for the job log, and enter the dates you want.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information 
about them: status, document name, user name, date, start time, end time, 
process time, file size, print device, paper size, media, number of originals, 
number of color pages, number of black and white pages, and total number of 
pages.

Use the scroll bar at the bottom of the window to view all fields in the Job Log 
window.

Print icon

Export icon

Update icon
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The text in the Status column provides information about the job:

4. To print the job log, choose Print Job Log from the File menu or click the Print 
icon at the top of the window.

The information displayed in the Job Log window prints to the current 
Colorwriter. When you print the job log, totals are printed for all appropriate 
columns.

5. To save the job log as a file that you can view with a different application, choose 
Export Job Log from the File menu or click the Export icon at the top of the 
window.

6. Enter a name for the log file, and click Save. 

The job log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

7. If a password was set, and you entered the Administrator password, you can 
choose Delete Job Log from the File menu to clear the job log. 

The system administrator can also print and clear the job log from the control 
panel.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You 
can double-click ERROR to display the error message. A 
dialog box displays the PostScript error. Click OK to close the 
dialog box.

CANCEL The job was canceled before printing was completed.



44-35 Using the Colorwriter LSR Spooler

TO USE ADMINISTRATOR FUNCTIONS:

1. Choose Password from the Administrator menu.

This menu is active only if a password was created on the Colorwriter.

2. Enter the password in the window that appears. 

This password is set in the Setup on the control panel. Once it is set, only persons 
with the password can move, override, prioritize and delete all users’ jobs in the 
Colorwriter LSR Spooler main window.
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Using the Colorwriter LSR Manager
The Colorwriter LSR Manager configures a special network layer that allows the 
Colorwriter LSR Spooler and the Colorwriter LSR Downloader to communicate 
with the printer over IPX or TCP/IP networks. The Colorwriter LSR Manager 
application runs on Windows 95 and Windows NT systems.

After installing the utilities, and before using them, run the Colorwriter LSR 
Manager to make sure that the network configuration is correct. 

The main screen of the Colorwriter LSR Manager includes buttons that enable 
you to launch the Colorwriter LSR Downloader and Colorwriter LSR Spooler 
without exiting the Colorwriter LSR Manager.

For a detailed description of the Colorwriter LSR Manager and how to use it to 
run the Colorwriter LSR Spooler and the Colorwriter LSR Downloader, see 
page 6-60 of Getting Started. 

PCK
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Application notes
This section provides special instructions for optimizing color output with the 
following applications:

• Aldus PageMaker 5.0 for Windows 3.1

• Adobe Photoshop 2.5 and 3.0 for Windows 3.1

• CorelDRAW 5.0 for Windows 3.1

• Microsoft PowerPoint 4.0 for Windows 3.1

In general, you should use the Adobe PostScript Printer Driver for Windows 3.x 
and Windows 95, although the Windows PostScript printer driver is also 
supported.

Before you start:

• Make sure you or your system administrator has installed your Colorwriter as a 
PostScript printer. Make sure that any additional printer files for your 
applications are installed.

For installation, see Chapter 6 of Getting Started.

Aldus PageMaker 5.0 for Windows 3.1
Your PageMaker package may include a small document with the heading 
“PRINTING ALERT!” stating that only the Microsoft PostScript Printer Driver 
can be used with PageMaker 5.0. You may disregard this warning. In general, you 
should use the Adobe PostScript Printer Driver for Windows to print from 
PageMaker, but you can also use the Microsoft Windows PostScript printer driver 
version 3.56 supplied with PageMaker.
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Page setup

Choose options in the Page setup dialog when you begin creating the PageMaker 
document. Refer to the illustration below for settings applicable to the 
Colorwriter.

Choosing fill and line colors

You can create fill and line colors using the process (CMYK), RGB, or HSB color 
model, or choose a named color using one of the four color matching systems 
supplied. Note that displayed versions of colors you choose may not match 
Colorwriter output exactly. 

Working with imported files

RGB raster images should be saved from Adobe Photoshop as EPS files before 
they are placed in PageMaker documents. Photoshop includes PostScript 
information in RGB EPS files that activate the Colorwriter CRDs. Using this type 
of image file, the image prints from PageMaker as it does from Photoshop; using a 
different format compromises the printed output of RGB bitmaps, since no CRD 
is activated. For details, see “Exporting image files to other applications” on 
page 4-43.

If you use a pixel-editing application other than Photoshop, you should separate 
the image to CMYK. Note that CMYK bitmaps are often separated for offset 
printing and may need adjustment to print properly on your Colorwriter.

Choose the Colorwriter here

Choose 600 from the 
pop-up menu
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Selecting options when printing

Refer to this section to select options in the Print dialog box.

NOTE: You cannot access Adobe PostScript Printer Driver options from 
PageMaker 5.0. Settings made for Adobe PostScript Printer Driver options from 
the Windows Control Panel have no effect. 

Choose the Colorwriter 
from both menus

Click these buttons
to access more

print options

Choose a paper size

Choose a paper tray
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Adobe Photoshop 2.5 and 3.0 for Windows 3.1
This section explains how to print from Photoshop using the Colorwriter’s built-
in CRDs. This way of printing is convenient and fast, and is ideal when the 
Colorwriter is the final printing device. Note that you can use this technique to 
print only RGB images, such as scans made with a desktop scanner.

The Separation Tables that come with the Colorwriter user software provide 
EFICOLOR data conversions when you use Photoshop to convert images from 
one mode to another, such as between RGB, Lab color, and CMYK color spaces. 

Mode conversions are commonly used when you use Photoshop to print an image 
specified in RGB mode to a printer (such as the Colorwriter) that uses CMYK 
toner colors. They are also used when you use Photoshop to save separations.

Click Optimized

Click Composite

Click Color
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EFICOLOR color conversions that involve RGB data should start with a 
standardized RGB color space. This is provided by the Calibrated RGB file, which 
is loaded into Photoshop’s Monitor Setup.

Loading Calibrated RGB monitor settings

Calibrated RGB monitor settings ensure consistent results. You need to load the 
settings file only once. The settings remain loaded unless you change them.

TO LOAD THE CALIBRATED RGB MONITOR SETTINGS FILE:

1. Copy the file of Calibrated RGB monitor settings (called calrgb.ams) from the 
Colorwriter user software CD into the directory where you keep Photoshop.

2. Start Photoshop, choose Preferences from the File menu, and choose Monitor 
Setup from the submenu.

The Monitor Setup dialog box is displayed.

3. Click Load and load the file called calrgb.ams. Choose High from the Ambient 
Light menu. 

Before you apply the settings, you should see this if you are using Photoshop 3.0:

Note that this dialog box looks slightly different in Photoshop 2.5.

4. Click OK to apply the settings.

NOTE: Changing settings in the Monitor Setup dialog box affects your printed 
output from RGB images. If you’re not sure whether the Calibrated RGB settings 
are loaded, load them again.

Make sure that High is 
selected here
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Selecting options when printing

Consult the following illustrations when selecting options in the Page Setup and 
Print dialog boxes. Note that you must select Print as RGB in the Print dialog box 
to use the Colorwriter’s built-in CRDs. 

Setting Adobe PostScript Printer Driver options

No special settings are required for printing from Photoshop; it is necessary to 
change Adobe PostScript Printer Driver options only if:

• You previously chose a rendering style other than Photographic.

If necessary, click
Options to access
Adobe PostScript

Printer Driver
options

Choose the Colorwriter

Click Print as RGB to use the 
Colorwriter’s CRDs

Click Binary encoding
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• You want to choose a feature such as Paper Type.

You can access Adobe PostScript Printer Driver options in Photoshop by clicking 
the Options button in the Page Setup dialog box. 

Exporting image files to other applications

Photoshop is a PostScript Level 2 application. As such, it puts information that 
activates the Colorwriter CRDs in PostScript files that it writes. For this reason, 
you should save RGB Encapsulated PostScript (EPS) images from Photoshop 
when the image will be imported into another application and printed to a 
Colorwriter. The image will be printed using a CRD when imported into almost 
any application.

Perform any needed rotating, cropping, and resizing on the image in Photoshop 
before saving it, to speed printing from the application the image is placed in. 
When saving the file, select binary encoding in the EPS Format dialog box, and 
do not include transfer functions or halftone screens, as shown in the following 
illustration.

NOTE: If you later experience problems printing the exported image, substitute an 
ASCII encoded version of the same image, and print the document again. Binary 
encoding occasionally causes printing problems with some system configurations.
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CorelDRAW 5.0 for Windows 3.1

The Color Manager

The Color Manager is a color management system that is integrated into 
CorelDRAW and other Corel applications. Because the Color Manager does not 
include profiles for the Colorwriter, this section suggests other ways to get 
predictable results when printing to the Colorwriter from CorelDRAW. These 
methods include importing raster images saved from Adobe Photoshop in the 
RGB EPS file format to activate Colorwriter CRDs.

If you have considerable experience working with color, and want to use the Color 
Manager, consider creating a custom printer profile for your Colorwriter. You will 
need a spectrophotometer or colorimeter for accurate results. For details, see 
section 3 of the CorelDRAW 5 User Guide, Volume 1.

Choosing fill and line colors

You can create fill and line colors using the process (CMYK), RGB, or HSB color 
model, or choose a named color using one of the three color matching systems 
supplied. Note that displayed versions of colors you choose may not match 
Colorwriter output exactly. 

Working with imported files

We recommend using EPS files for all artwork that will be placed in CorelDRAW 
documents. 

If the image is RGB, it should be saved from Adobe Photoshop, since Photoshop 
includes PostScript information in RGB EPS files that activates the Colorwriter 
CRDs. Using this type of image file, the image prints from CorelDRAW as it does 
from Photoshop. For details, see “Exporting image files to other applications” on 
page 4-43. Note that using a different file format compromises the printed output 
of RGB bitmaps, since no CRD is activated. 

If you use a pixel-editing application other than Photoshop, we recommend 
separating the image to CMYK before importing it. CMYK bitmaps from high-
end scanners are typically separated for offset printing, and may need some color 
correction to print properly on your Colorwriter. 
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Selecting options when printing

Refer to this section to select options in the Print dialog box.

Setting Adobe PostScript Printer Driver options

No special settings are required for printing from CorelDRAW; it is necessary to 
change Adobe PostScript Printer Driver options only if:

• Your CorelDRAW document contains a placed RGB EPS file, and you 
previously chose a rendering style other than Photographic.

• You want to choose a feature such as Paper Type.

You can access Adobe PostScript Printer Driver options in CorelDRAW by 
clicking the Setup button in the Print dialog box. 

Microsoft PowerPoint 4.0 for Windows 3.1
Presentations created in PowerPoint can be printed to the Colorwriter on plain 
paper or on transparency film for projection. 

Choosing a template

PowerPoint comes with templates that determine the background for each slide, as 
well as a color scheme and placement for text. To select a template, choose 
Presentation Template from the Format menu, and double-click a template name 
to apply it to all slides in the presentation. If none of the templates for color 
overheads suit your needs, try one of the templates for color slides. 

Choose the Colorwriter

To set Adobe PostScript
Printer Driver options,

choose the Setup button

To set CorelDRAW print
options, choose the

Options button

NOTE: Do not select this 
option unless you are using 
the Corel Color Manager
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If you use one of the templates for color slides, you must change the Slide Setup 
for printing with the Colorwriter. Choose Slide Setup from the File menu, enter 
the appropriate page size, and click OK to apply the changes.

Working with imported files

In addition to the clip art included with PowerPoint, images from other 
applications in many formats can be imported. You should use EPS files for all 
raster artwork that will be placed in PowerPoint documents.

If the image is RGB, save it from Adobe Photoshop since Photoshop includes 
PostScript information in RGB EPS files that activates the Colorwriter CRDs. 
Using this type of image file, the image prints from PowerPoint as it does from 
Photoshop. For details, see “Exporting image files to other applications” on 
page 4-43. Note that using a different file format compromises the printed output 
of RGB raster images, since no CRD is activated. 

If you use a pixel-editing application other than Photoshop, separate the image to 
CMYK before importing it. CMYK bitmaps from high-end scanners are typically 
separated for offset printing, and may need some color correction to print 
properly on your Colorwriter. 

Selecting options when printing

Refer to this section to select options in the Print and Print Setup dialog boxes.

Click to display the Print Setup
dialog box, where you can

select the Colorwriter

To print a single slide on a 
page, choose Slides

To print several slides on a 
page, choose Handouts (2, 
3, or 6 slides per page)
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It is possible to have multiple instances of the Colorwriter driver installed on your 
PC. Each driver may have different connections or setup preferences. However, 
installing the Adobe driver and the Microsoft driver on the same system for the 
same printer may produce unpredictable results. If you find that you have both 
drivers installed, it is recommended that you remove one of them. Enter the Setup 
of the driver after selecting the driver from the Control Panel Printers Icon. Click 
the About button to determine which driver you have selected. Click the Remove 
button to remove the driver of your choice.

Select the Colorwriter
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5-1 Printing to the Colorwriter from UNIX Workstations

 

This chapter provides information about printing to the Colorwriter directly from 
UNIX. Although Colorwriter utilities are not available on UNIX workstations, 
jobs printed to the Colorwriter are sent to the Print queue and can be 
manipulated from Macintosh and PC computers on the network.

The queue name and Colorwriter printer name are established by your system 
administrator. In general, the queue name should be appended to the name of the 
Colorwriter, for example, 

 

DefaultPrinterName

 

_print

 

.

For information on setting up printing from TCP/IP, see Chapter 5 of 

 

Getting 
Started

 

.

 

Printing to the Colorwriter from UNIX Workstations

 

You can use UNIX commands to print PostScript files and text files to the 
Colorwriter. In general, the basic printing commands (lpr, lpq, lprm) can be used 
to send print jobs to a Colorwriter. See your UNIX manual pages or other 
documentation for information about UNIX commands.

 

N

 

OTE

 

:

 

Make sure that the files are either PostScript or text files. These are the only 
formats you can use to print from UNIX. Files may arrive at the printer without a 
file type designation that would distinguish between PostScript and text files. The 
printer makes the distinction based on the first characters in the file. A file is 
treated as a text file unless it begins with “%!” which indicates a PostScript file.

 

T

 

O

 

 

 

PRINT

 

 

 

A

 

 

 

FILE

 

 

 

TO

 

 

 

THE

 

 C

 

OLORWRITER

 

:

 

•

 

On a UNIX system running SunOS 4 or other BSD-based variant, use the lpr 
command to send a job to the Colorwriter.

 

The lpr command creates a printer job in a spooling area. Use this format:

 

lpr -P<queuename> -#<copies> <filename>

Chapter 5:
Printing 
from UNIX 
Workstations
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5-2 Printing to the Colorwriter from UNIX Workstations

 

For example, if your Colorwriter queue is named 

 

colorwriterq

 

, your file is named 

 

Sample

 

, and you want to print two copies, you would type:

 

lpr -Pcolorwriterq -#2 Sample

 

•

 

On a UNIX system running Solaris 2, use the lp command to send a job to the 
Colorwriter.

 

Use this format:

 

lp -d <queuename> <filename>

 

For example, if your Colorwriter queue is named 

 

colorwriterq

 

 and your file is 
named 

 

Sample

 

, you would type:

 

lp -d colorwriterq Sample

 

To print multiple copies:

 

lp -d colorwriterq -n # Sample

 

T

 

O

 

 

 

MANAGE

 

 

 

THE

 

 C

 

OLORWRITER

 

 

 

QUEUE

 

 

 

FROM

 

 

 

A

 

 UNIX 

 

WORKSTATION

 

:

 

•

 

On a UNIX system running SunOS 4 or other BSD-based variant, use the lpq 
command to see printer jobs in the queue.

 

lpq -P<queuename>

 

For example, if the queue name for your Colorwriter is 

 

colorwriterq

 

, you would 
type:

 

lpq -Pcolorwriterq

 

Your workstation displays the contents of the queue.

•

 

On a UNIX system running Solaris 2, use the lpstat command to see printer jobs in 
the queue.

 

lpstat -o <queuename>

 

For example, if your Colorwriter queue is named 

 

colorwriterq

 

, type:

 

lpstat -o colorwriterq

 

The job ID includes the printer name.
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6-1 Printing from DCPS to the Colorwriter

 

This chapter provides information about printing to the Colorwriter from 
DECprint Supervisor for OpenVMS (DCPS) on VMS systems. DCPS (version 
1.3) is the print client used on OpenVMS systems.

 

Printing from DCPS to the Colorwriter

 

To print to the Colorwriter from OpenVMS, DCPS must be installed on the 
system. DCPS v1.3 provides full support for the Colorwriter. The Colorwriter 
can be used with DCPS v1.2 or earlier, but an optional DCPS OPEN licensce is 
required; not all print command qualifiers are supported, even with the optional 
license installed.

The OpenVMS operating system with DCPS v1.3 has commands that allow you 
to submit and manage print jobs to the Colorwriter. OpenVMS also provides 
commands for defining and managing print queues for print job entries. For a full 
description of the commands listed below, see the 

 

DCL Command Dictionary

 

, 
which is part of the OpenVMS document set.

Commands to define and manage print queues:

 

Define/Form

Delete/Form

Delete/Queue

Initialize/Queue

Set Queue

Show Queue

Show Queue/Form

Start/Queue

Start/Queue/Manager

Stop/Queue

Stop/Queue/Abort

Stop/Queue/Manager/Cluster

Chapter 6:
Printing 
from OpenVMS 
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6-2 Printing from DCPS to the Colorwriter

 

Commands to enter and manage print jobs:

 

Stop/Queue/Next

Stop/Queue/Requeue

Stop/Queue/Reset

Stop/Queues/On_Node

Delete/Entry

Print

Set Entry

Show Entry

Stop/Queue/Entry
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7-1 Monitoring queued print jobs

 

The Colorwriter LSR 2000

 

+

 

 with the Professional Color Kit (PCK) option 
installed supports simultaneous connections to three different Novell NetWare 
print servers. This chapter contains information on:

• Monitoring queued print jobs

• Printing a PostScript file over the NetWare print server

 

N

 

OTE

 

:

 

Make sure you have set up your Novell server or servers with a print server 
and print queue for the Colorwriter, and then configure your printer to connect 
to the print queue you set up on the Novell server. See page 5-22 of 

 

Getting 
Started

 

 for information on how to create a print server, and page 5-27 of 

 

Getting 
Started

 

 for instructions on how to connect the Colorwriter to the Novell network.

 

Monitoring queued print jobs

 

Network administrators can monitor, move, and delete jobs from the Colorwriter 
queue from any one of the the NetWare print servers, using the NetWare Print 
Console utility. 

 

T

 

O

 

 

 

MONITOR

 

 

 

QUEUED

 

 

 

PRINT

 

 

 

JOBS

 

:

 

1. Log in to the NetWare server as the Supervisor.

2. At the NetWare MS-DOS prompt, type PCONSOLE.

 

The Available Options menu is displayed.

 

3. Select Print Queue Information.

 

PCONSOLE displays a list of queues on the current server.

 

4. Highlight the Colorwriter queue and press Enter.

 

The Print Queue Information menu is displayed.

 

5. Select Current Print Job Entries.

 

NetWare displays a list of current jobs in the Colorwriter queue on the NetWare 
server, in order of priority.

Chapter 7:
Administering 
Print Jobs over 
the NetWare 
Print Server
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7-2 Printing a PostScript file

 

From the list you can:

• Delete jobs

Use the arrow keys to highlight one or more jobs and Press 

 

Del

 

 to delete the job 
from the queue. Queue operators can delete any job; queue users can delete 
only their own jobs.

• Change the number of copies, the print priority, and the print time

Highlight a job and press 

 

Enter

 

 to display the Print Queue Entry Information 
window. From this window you can place the job on user or operator hold. If 
you have operator privileges, you can also change the priority, change the 
number of copies, and defer printing.

 

6. Press Esc to exit PCONSOLE windows.

 

Since NetWare jobs that are transmitted to the Direct connection are usually 
processed immediately, a series of Colorwriter jobs queued on the NetWare server 
can monopolize the Colorwriter on a mixed network. If this becomes a problem, 
you can change two settings in Network Setup on the Control Panel: connect the 
NetWare server to the Colorwriter Print queue, or increase the IPX Poll Interval, 
to let other network jobs print.

Entering an administrator password on the control panel keeps casual users from 
changing NetWare and other options in Setup screens.

 

Printing a PostScript file

 

In addition to downloading PostScript files, PostScript files can be printed directly 
from applications that create them. 

Such files may arrive at the printer without a file type designation that would 
distinguish between PostScript and text files. The printer makes the distinction 
based on the first characters in the file. 

 

N

 

OTE

 

:

 

The printer treats the file as a text file unless it begins with “%!” which is 
the convention for the beginning of a PostScript file.
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7-3 Printing a PostScript file

 

T

 

O

 

 

 

PRINT

 

 

 

A

 

 P

 

OST

 

S

 

CRIPT

 

 

 

FILE

 

 

 

OVER

 

 IPX (N

 

OVELL

 

) 

 

NETWORKS

 

:

 

1. Set up the server and the Colorwriter as described in Chapter 5 of Getting Started.

2. On your workstation, at the NetWare MS-DOS prompt, type PCONSOLE.

 

You do not need Supervisor privileges to print a PostScript file. However, you 
must be logged into a NetWare file server that has a Colorwriter queue.

The Available Options menu is displayed.

 

3. Choose Print Queue Information and press Enter.

4. From the list of Print Queues, select the Colorwriter queue. and press Enter.

 

The Print Queue Information menu is displayed.

 

5. From the Print Queue Information menu, choose Current Print Job Entries.

6. Press the Ins key to select the directory containing the file you want to print, and 
press Return.

 

For example, to print a 

 

SAMPLE.PS

 

 file, in the New Print Job to be Submitted 
window, select or type the following:

 

C:\SAMPLE.PS

 

When you press Return, the configuration choices are displayed.

 

7. Press Return to select the default print job configuration.

8. In the Print Job Configurations window, press Esc to leave the default settings.

 

The Colorwriter needs no additional information for printing a raw PostScript 
file.

 

9. Press Return to save changes.

 

The Colorwriter prints the selected PostScript file.
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7-4 Using AppleTalk with Macintosh computers on an IPX (Novell) network

 

Using AppleTalk with Macintosh computers 
on an IPX (Novell) network

 

Macintosh users on an IPX network can print to the Colorwriter:

• Directly, using AppleTalk and bypassing the NetWare server

• Through a NetWare server running NetWare for Macintosh

Since the Colorwriter supports both AppleTalk and IPX protocols at the same 
time, it’s not necessary to use the second option. However, a network 
administrator may choose to route all print jobs through a server.

 

N

 

OTE

 

:

 

Colorwriters configured with 16MB of memory can be attached to a single 
NetWare server. Colorwriters configured with 32MB or 48MB of memory may be 
attached to as many as three NetWare servers.

 

Printing directly to the Colorwriter

 

Due to the layered design of networks, Ethernet cable can transmit data using 
more than one network protocol. When Macintosh computers are connected to 
an IPX network, they can continue to transmit data over Ethernet cable using 
AppleTalk protocols. If the Colorwriter is on the same network, Macintosh 
computers can see and print to the Colorwriter, provided that AppleTalk is 
enabled on the Macintosh and in Colorwriter Setup.

PCK
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A-1 Printer control panel error messages

 

When an error interferes with printing, you will see a message on the printer 
control panel. Only two messages are displayed at a time on the printer control 
panel (one warning message and one error message) even when more than one of 
each error condition is present. The messages are displayed until the problem 
conditions are resolved. For example, when yellow toner is low, even though the 
black toner may also be low, only the “Low Toner Yellow” message is displayed. 
For tips and procedures on how to correct certain printing problems, see 

 

Appendix D: Troubleshooting

 

.

Following are the messages (listed in alphabetical order), with the appropriate 
corrective action for each one. Some error messages refer you to specific parts of 
the printer. For an illustration of the printer parts, see page C-1.

 

Printer control panel error messages

 

The following operation errors cause the fault LED to flash and printing to stop. 
Contact an authorized service representative.

 

Message Corrective action/additional information

 

DOOR OPEN

 

The door on the printer is open. The printer will resume 
printing when it is closed.

 

LOAD ___ 

 

The printer is not loaded with the paper size specified. The 
printer will resume printing when the required paper is loaded.

 

LOAD ___ PAPER 
IN MAIN CASSETTE

 

The printer’s main cassette is not loaded with the paper size 
specified. The printer will resume printing when the main 
cassette is loaded with the required paper.

 

LOAD ___ PAPER 
IN MP TRAY

 

The printer’s multipurpose tray is not loaded with the paper 
size specified. The printer will resume printing when the 
multipurpose tray is loaded with the required paper.

 

LOAD ___ PAPER 
IN OPT TRAY

 

The printer’s optional cassette is not loaded with the paper size 
specified. The printer will resume printing when the optional 
cassette is loaded with the required paper.

Appendix A: 
Error and 
Warning 
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A-2 Printer control panel error messages

 

LOAD ___ TRANS. 
IN MP TRAY

 

The printer’s multipurpose tray is not loaded with the 
transparency size specified. The printer will resume printing 
when the multipurpose tray is loaded with the required 
transparency.

 

NO FIXING 
UNIT

 

The printer will resume printing when you have replaced the 
fixing unit.

 

NO OPTIONAL CASS

 

There is no optional cassette in the paper feeder. The printer 
will resume printing when the paper cassette is inserted.

 

NO PHOTO 
DRUM

 

The printer will resume printing when you have replaced the 
photo drum.

 

NO TONER CART. 
___ 

 

There is no toner cartridge for the specified color. The printer 
will resume printing when the toner cartridge is replaced.

 

PAPER JAM 
___

 

There is a paper jam at the specified location. The printer will 
resume printing when the paper jam is cleared.

 

PRINTER BUSY

 

The printer is being serviced or printing a test page from the 
console on the rear of the printer.

 

PRINTER OFFLINE

 

The printer is off line. The printer will resume printing when 
it is back online (when you press the online button on the 
printer control panel).

 

REPLACE 
FIXING OIL

 

The fixing oil bottle in the fixing assembly is empty. The 
printer will resume printing when the fixing oil is replaced.

 

REPLACE 
FIXING UNIT PUMP

 

This message indicates one or more of the following 
conditions: the printer is at more than a 1% angle from level, 
the sensor is stuck, the sensor is dirty, or the fixing unit pump 
needs replacement. Check to make sure the printer is level and 
check the sensor before replacing the fixing unit pump.

 

REPLACE
FIXING WEB

 

The printer will resume printing when the fixing assembly unit 
is replaced. This should be done by an authorized service 
representative.

 

REPLACE TONER 
CART. ___ 

 

Toner is low for the specified color and the control panel; 
option was set on 

 

LOW TONER ERROR

 

.

 

REPLACE 
WASTE TONER

 

The printer’s waste toner container is full.

 

Message Corrective action/additional information
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A-3 Printer control panel warnings

 

Printer control panel warnings

 

The following warnings cause the fault LED to light and the message to be 
displayed on the printer control panel until the problem is fixed. 

 

N

 

OTE

 

:

 

The printer continues to print while the warnings are displayed.

 

Message Explanation

 

DISK FULL

 

The Colorwriter LSR 2000

 

+

 

 hard disk is full. Allow pending 
jobs to finish printing before sending any new jobs. If this 
problem occurs often, consider deleting jobs in the Hold 
queue and Printed queue, and deleting fonts that were 
downloaded to the printer.

 

CLEAN SENSOR & 
TRANSFER DRUM

 

The sensor and transfer drum need to be cleaned for optimal 
print quality. 

 

LOW
DRUM LIFE

 

The drum life is low. Prepare a new drum. The printer will 
continue to print until the drum is worn out, and then it will 
display the message, “Replace drum.”

 

LOW
FIXING OIL

 

The fixing oil is low. The printer will continue to print until it 
runs out of oil, and then it will display the message: “Replace 
fixing oil.”

 

LOW
FIXING WEB

 

The fixing assembly unit life is low. The printer will continue 
to print until the fixing web is worn out, and then it will 
display the message, “Replace fixing web.”

 

LOW TONER
___

 

The toner for the specified color is low. If you set 

 

LOW TONER 
ERROR 

 

to 

 

YES 

 

(in System Setup on the printer control panel), 
this message is displayed and printing stops until the toner is 
replaced. If you set 

 

LOW TONER ERROR 

 

to 

 

NO

 

, then it will 
display the message: 

 

REPLACE TONER CART

 

, and the printer 
will continue to print until it runs out of toner. We 
recommend that you keep replacement toner for all colors on 
hand, and when you order, always order all four colors at the 
same time.

 

 

 

LOW DRUM LIFE

 

Drum life is low and the drum should be replaced. The printer 
will continue to print until it displays the message 

 

NO PHOTO 
DRUM

 

.
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A-4 Startup diagnostic error service calls

 

Startup diagnostic error service calls

 

Startup diagnostic tests are performed on the printer controller board every time 
the Colorwriter LSR 2000

 

+

 

 is powered up. Diagnostic test names are displayed 
briefly, followed by the message 

 

DIAGS PASSED

 

. 

If a startup test fails, an error number is displayed on the control panel. When you 
see a startup test failure, note the error number and turn off the printer. Contact 
an authorized service representative to restore your printer to working order, and 
report the error number. There are no user-serviceable parts on the controller 
board.

If no characters appear on the LCD display, there is a problem with one or more 
SIMMs (single in-line memory modules) in Bank 0. An example of a diagnostic 
test failure follows. 

 

Printer control panel service calls

 

Operation errors cause the fault LED to flash and printing to stop. Contact an 
authorized service representative to restore your printer to working order.

 

Message Action required

 

DRAM TEST FAILED
NOTE #320

 

Notify an authorized service technician.

 

Message Explanation

 

CALL FOR SERVICE
NOTE #A1

 

A1 Fixing unit failure (low temperature)

 

CALL FOR SERVICE
NOTE #A2

 

A2 Fixing unit failure (warm-up abnormal)

 

CALL FOR SERVICE
NOTE #A3

 

A3 Fixing unit failure (high temperature)

 

CALL FOR SERVICE
NOTE #A4

 

A4 Fixing unit failure 
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A-5 Printer control panel service calls

 

CALL FOR SERVICE
NOTE #A5

 

A5 Fixing unit failure (unknown)

 

CALL FOR SERVICE
NOTE #A6

 

A6 Fixing unit failure (heater cut off )

 

CALL FOR SERVICE
NOTE #B1

 

B1 BD failure

 

CALL FOR SERVICE
NOTE #B2

 

B2 Laser failure

 

CALL FOR SERVICE
NOTE #C5

 

C5 Polygon motor failure (abnormal startup)

 

CALL FOR SERVICE
NOTE #D0

 

D0 Motor failure

 

CALL FOR SERVICE
NOTE #D2

 

D2 Motor failure (drum motor)

 

CALL FOR SERVICE
NOTE #D3

 

D3 Motor failure (main motor)

 

CALL FOR SERVICE
NOTE #D4

 

D4 Motor failure (controller fan)

 

CALL FOR SERVICE
NOTE #D5

 

D5 Motor failure (fixing unit fan)

 

CALL FOR SERVICE
NOTE #D6

 

D6 Motor failure (electric fan)

 

CALL FOR SERVICE
NOTE #E5

 

E5 Be sure toner cartridge is installed correctly

 

CALL FOR SERVICE
NOTE #E6

 

E6 Developer unit failure (pressing error)

 

CALL FOR SERVICE
NOTE #F1

 

F1 DC controller failure (abnormal memory)

 

CALL FOR SERVICE
NOTE #F2

 

F2 DC controller failure (abnormal voltage)

 

Message Explanation
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A-6 Printer control panel service calls

 

CALL FOR SERVICE
NOTE #F3

 

F3 DC controller failure (thermal/humidity unit)

 

CALL FOR SERVICE
NOTE #F4

 

F4 DC controller failure (abnormal density sensor)

 

CALL FOR SERVICE
NOTE #F5

 

F5 DC controller failure (print engine)

 

CALL FOR SERVICE
NOTE #F6

 

F6 DC controller failure (abnormal IC)

 

Message Explanation



 

B

 

B-1 Setup Menus

 

This appendix reproduces the Help Map, which provides information about 
Setup menus and options, and also summarizes the status screens and pages you 
can print from the printer control panel. To print out a full-size version of the 
Help Map from the printer control panel:

• Press the Menu button to display 

 

PRINT PAGES.

 

• Press the 

 

↓

 

 or 

 

↑

 

 buttons until 

 

HELP MAP 

 

is displayed.

• Press the Enter button.

Appendix B: 
Setup Menus

 

 

This document was created with FrameMaker 4.0.4



 

B

 

B-2 Setup Menus

H IGH  P E R FORM A N C E  NE TWOR K  COLO R  P R I N TE R


LOADING

SYSTEM…

TESTING:

  TESTNAME




PRESS MENU

FOR SETUP

READY      292MB

Colorwriter LSR

SELECT FUNCTION

RUN SETUP

READY      292MB

Colorwriter LSR
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B-3 Setup Menus

H IGH  P E R FORM A N C E  NE TWOR K  COLO R  P R I N TE R


LOADING

SYSTEM…

TESTING:

  TESTNAME




PRESS MENU

FOR SETUP

READY      292MB

Colorwriter LSR

SELECT FUNCTION

RUN SETUP

READY      292MB

Colorwriter LSR
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B-4 Setup Menus





 
 


*

SYSTEM SETUP




PRINTER SETUP

ENABLE DIRECT Q *

ENABLE PRINT Q *

ENABLE HOLD Q *

ENABLE PRINTED *

JOBS TO SAVE *

COLOR MODE

PAPER SIZE

PAPER SOURCE

DEFAULT CRD

ENABLE APPLETALK

   APPLETALK ZONE

ENABLE IPX

ENABLE TCP/IP

   IP ADDRESS

   SUBNET MASK

   GATEWAY ADDRESS

ENABLE PARALLEL

   TIMEOUT (S)

   IGNORE EOF

  




NETWORK SETUP




JOB LOG SETUP




NEW PASSWORD

VERIFY PASSWORD

CHANGE PASSWORD




PRINTER NAME

DATE (MM/DD/YY)

SYSTEM TIME

PRINT START PAGE

PRINT TO PSERROR

PRINT COVER PAGE

LOW TONER ERROR

POWER SVNGS (M)

LOCAL MESSAGES

IPX FRAME TYPE

IPX SETTINGS

   VIEW

     CONNECTED SERVRS

   CHANGE

     AVAILABLE SERVRS

     PRINT SERVER

     IPX POLL INT

     SELECT QUEUE

     

     SELECT FS *

READY     292MB

Colorwriter LSR
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C-1 Identifying the parts of the printer

 

This appendix provides a diagram identifying the parts of the printer and contains 
maintenance information about:

• Cleaning and handling the printer

• Storing and handling toner cartridges 

• Replacing a toner cartridge

• Replacing the silicone oil bottle

• Using the drum cartridge kit

• Moving the printer

 

N

 

OTE

 

:

 

Maintenance on the printer should be done before 60,000 letter-size 
printouts. At the same time, the following items should also be replaced: ozone 
filter, air filter, separation corona wire assembly, transfer drum cleaner unit, and 
fuser (110 v or 220 v).

Several of the maintenance procedures in this appendix are also detailed on the 
Quick Reference Card that came with your Colorwriter documentation. Adhere 
the clear plastic pocket to your printer and use it to keep the Quick Reference 
Card handy, so you always have ready access to these procedures: replacing toner, 
replacing the drum cartridge, installing or reinstalling the waste toner bottle, 
cleaning the corona wire, and replacing the silicone oil bottle.

 

Identifying the parts of the printer

 

The following illustration (showing the front and right side of the printer) will 
help you identify the parts of the printer for maintenance and troubleshooting 
purposes.

Appendix C: 
Maintenance
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C-2 Identifying the parts of the printer

1 Top cover (open)

 

For access to the transfer drum to remove jammed paper or for replacing the 
separation corona unit.

 

2 Silicone oil bottle (cover opened)

 

The silicone oil is used at the fixing rollers to fix the toner. 

 

3 Fixing assembly cover (closed)

 

For removing jammed paper at the output area or for replacement of the 
fixing assembly.

Optional paper feeder unit’s right door
(open to remove jammed paper)

22 Separation corona unit (exposed
when top cover is lifted up)

1

2

3

4
5

6
7

8

9
10

11

12

13

14
15
16

17

18

19

20

21
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C-3 Identifying the parts of the printer

4 Release knobs

 

Open the fixing assembly cover and the feeder unit cover for troubleshooting 
or maintenance.

 

5 Face-up tray (open)

 

When opened, the face-up tray holds printouts when they come out facing 
up. When the tray is closed, the face-down tray is used instead. The tray can 
hold about 50 sheets of plain paper at 20 lb (80 g/m

 

2

 

).

 

6 Multipurpose tray (open)

 

Holds about 100 sheets of plain paper at 20 lb (80 g/m

 

2

 

) or 20 sheets of 
transparency film.

 

7 Route cable (attached)

 

Required if the optional paper feeder unit is installed. It connects the power 
outlet on the feeder unit with the power receptacle (now serving as power 
inlet) on the printer body.

 

8 Power receptacle (on paper feeder unit)

 

Plug in the supplied power cord here, then connect the other end to an AC 
power (100-120V or 220-240V depending on the voltage model of the 
printer package).

 

9 Right door

 

For access to the feeder area on the optional paper feeder unit to remove 
jammed paper.

 

10 Feeder unit cover (closed)

 

For removing jammed paper at the feeder area or replacement of the drum 
cleaning unit.

 

11 Power switch

 

When the switch sticks out, the printer is turned off. When the switch 
remains pressed, the printer is turned on.

 

12 Paper feeder unit (optional)

 

Comes with a universal cassette.

 

13 Paper volume indicator

 

Indicates the paper level. When the blue bar is almost invisible, it is time to 
refill the cassette.
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C-4 Identifying the parts of the printer

14 Paper width selector

 

Sets the width of the paper loaded.

 

15 Paper cassette (universal type) for the paper feeder unit (optional)

 

Holds about 250 sheets of Letter-, A4-, Legal-, or B5-size paper at 
20 lb (80 g/m

 

2

 

).

 

16 Paper size indicator

 

As your reminder, slide the knob to the position corresponding to the paper 
size actually set in the paper cassette.

 

17 Paper length guide

 

Sets the size of the paper loaded.

 

18 Paper cassette (universal type) standard 

 

Holds about 250 sheets of Letter-, A4-, Legal, or B5-size paper at
20 lb (80 g/m

 

2

 

).

 

19 Front door (opened) at on-line status, the “DOOR OPEN” error message 
appears when opened.

 

For access to the printer’s internal parts for troubleshooting or maintenance.

 

20 Face-down tray

 

Holds about 100 sheets of plain paper at 20 lb (80 g/m

 

2

 

).

 

21 Wire cleaner (stored inside the printer)

 

Used to clean the separation corona wire inside the separation corona unit, as 
well as the window of the density detection sensor. For more information on 
using the wire cleaner, see page C-6.

 

22 Separation corona wire

 

Located inside the separation corona unit, which should be cleaned with the 
cleaning brush stored inside the printer. 

LTR
B5

LGL
A4
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C-5 Cleaning and handling the printer

 

Cleaning and handling the printer

 

Regular cleaning and careful handling of the printer keep the printer in the best 
condition and maintain optimal print quality.

 

Cleaning the cabinet

 

Use a soft cloth slightly moistened with water or a mild detergent solution. Avoid 
using any solvents, such as alcohol, benzine, or any spray, which might damage 
the finish. When cleaning is finished, wipe the cabinet with a dry cloth. 

The process of cleaning the printer may disperse some toner inside the printer. For 
a more complete cleaning, therefore, wait a few minutes to let the toner settle, 
then clean again.

• Before cleaning the printer, always unplug it from the AC outlet after turning 
off the power switch of the printer. We also recommend removing any interface 
cable connected to the printer. 

• Do not spill water or detergent into the printer. Otherwise the printer could be 
damaged and electric shock could occur. 

Do not lubricate the printer. The printer does not require lubrication.

 

Cleaning the paper pickup area

 

Paper dust may collect inside the paper pickup area and affect the print quality. 
Periodically wipe the area with a soft, clean cloth moistened with water. Then dry 
the paper pickup area with a soft, clean cloth. To open the paper pickup feeder, see 
page D-5.

!
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C-6 Cleaning and handling the printer

 

Using the wire cleaner

 

The wire cleaner is oblong, each end is used to clean a different part. Use the 
padded end to clean the separation corona wire, and use the brush end to clean 
the window of the density detection sensor. The wire cleaner is stored in the 
printer as shown in the illustration. The following steps explain how to clean each 
part.

 

N

 

OTE

 

:

 

When cleaning a part is necessary, be sure to use the end of the cleaner that 
is intended for cleaning that part.

 

Cleaning the separation corona wire

 

Every time you replace the drum cartridge, or if the print output has toner spots, 
use the padded end of the wire cleaner to clean the separation corona wire inside 
the separation corona unit.

 

T

 

O

 

 

 

CLEAN

 

 

 

THE

 

 

 

SEPARATION

 

 

 

CORONA

 

 

 

WIRE

 

:

 

1. Turn off the printer and open the front door and top cover to reveal the separation 
corona unit and wire cleaner.

Padded end for 
cleaning the wire

Brush end for cleaning 
the window
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2. Remove the wire cleaner from inside the printer.

3. Place the padded end of the wire cleaner on the separation corona unit.

4. Clean the separation corona wire by moving the wire cleaner from side to side 
several times.

N

 

OTE

 

:

 

The separation corona wire is very thin and delicate, so take care when 
cleaning.
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5. After cleaning, replace the cleaner in its storage place and close the top cover and 
the front door. Then, turn on the printer to resume printing. 

 

Cleaning the window of the density detection sensor

 

When there is a density detection error or if the window is soiled with toner 
residue or dust, clean the window with the brush end of the wire cleaner. 

 

1. Turn off the printer and open the front door and top cover to reveal the window of 
the density detection sensor.

2. Remove the wire cleaner from inside the printer.
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3. Place the brush end of the wire cleaner on the window surface as shown.

4. Clean the surface with the brush and remove any dirt.

5. After cleaning, replace the cleaner in its storage place and close the top cover and 
the front door. Then, turn on the printer to resume printing. 
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Handling the Colorwriter

 

Avoid spraying cleaning solution directly onto the printer’s exterior, as the spray 
could penetrate into the ventilation slots and damage the internal circuits.

This printer is a precision machine. Handle it with care. 

• Do not make the printer vibrate while printing. 

• Do not open the printer while printing. 

• Do not arrange paper stacks by tapping them on the top of the printer while 
printing.

!
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• Do not put anything on the printer.

The printer weighs 110 lb (about 50 kg). It should always be moved by two or 
more persons. Do not attempt to move it by yourself. For more information, see 
page C-34. 

The inside of the printer gets hot while printing.

• Be careful when cleaning the inside, or removing paper jams, as the fixing 
assembly gets very hot. 

!


!
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• Do not cover the printer right after you have finished using it. Turn off the 
printer and wait until it cools down.

Do not close the front door abruptly, or expose the printer to any vibration.

Do not touch the electrical contacts, gears, or the laser beam devices. Doing so 
may damage the printer or cause the print quality to deteriorate.

HOT SURFACE. AVOID CONTACT ACHTUNG HEISSCAUTION!
ATTENTION! TEMPERATURE ELEVEE PRECAUTION! / ATTENZIONE! ALTA TEMPERATURA
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Do not attempt to disassemble the printer.

To avoid light and dust, do not leave the front door open unnecessarily. Avoid 
bright sunlight to protect the photosensitive drum from damage.

Avoid magnetic fields.

!




CC-14 Cleaning and handling the printer

Do not lubricate the printer.

Do not tilt the printer.

!
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Storing and handling toner cartridges
Poor print quality can result if toner becomes caked or unequally distributed 
inside the cartridges. Follow the instructions below when handling the cartridges. 

• Store the cartridges in their protective bag. Do not open the bag until you are 
ready to install the cartridge in the printer. 

• Do not store the cartridges where they will be exposed to direct sunlight. 

• Do not stand a cartridge on end, and do not turn it upside down. If the toner 
becomes caked in the cartridge, it may prove impossible to free it even by 
shaking the cartridge, which results in print quality deterioration. 

• Do not store the cartridges at high temperature or high humidity, or where the 
temperature or humidity can change abruptly. 

• Store the toner cartridges horizontally in a cool, dry location away from 
sunlight. Maximum storage temperature: 30°C (86°F). Maximum storage 
humidity: 80% without condensation.

• Do not store the cartridges in salty air or where there are corrosive gases such as 
aerosol spray. 

• Remove the cartridges from the printer when transporting the printer. (Put the 
cartridges in their original protective bag to avoid exposure to light.) 

• Do not attempt to disassemble the cartridges. 

• Use of only Digital toner cartridges is recommended. (See information on 
ordering supplies on page F-1.)

• The printer uses the rectangular, transparent windows at the top and bottom of 
a toner cartridge to detect the toner level. When handling a toner cartridge, 
avoid touching or scratching the windows or the toner level detection 
mechanism may not work properly.

• Be sure to replace a used toner cartridge with the same color one. Never insert a 
toner cartridge where its color does not match the color markers on the rotary; 
otherwise printing problems may result.

Do not place the cartridges in fire. Toner powder is flammable. 

!
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Replacing a toner cartridge
Each toner cartridge prints about 4,000 sheets of Letter- or A4-size paper, when 
toner coverage of the toner cartridge on the paper is at 4.5% dot ratio. This, 
however, does not mean all four of the toner cartridges will run out at the same 
time. Depending on the particular color toner used in a full color print job, some 
may last longer than others. 

While it is difficult to make a general rule, if the printouts contain a lot of space 
not covered by toner, then the warning signal may not appear even after 4,000 
prints. On the other hand, if each printout continuously uses a lot of multiple-
color printing or contains less unprinted area, then the color toner indicator 
appears before 4,000 sheets are printed.

According to the instructions (or messages) displayed on the LCD window, 
perform the following operation to replace the appropriate color toner cartridge.

TO REPLACE A USED TONER CARTRIDGE:

1. Make sure the power switch is turned off. Then open the front door.

Online Cancel Menu Enter

Processing Multipurpose Tray
Main Cassette
Optional CassetteFault LCD

READY     212 MB
Colorwriter LSR

Down Up Left Right
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2. While pressing the rotary knob ➀, turn it in the direction of the arrow ➁ until the 
markers for the color indicated by the message on the status panel appear on the 
rotary. When this is done, the rotary knob pops out and is locked ➂.

3. Make sure the rotary knob is locked and the two color markers are fully visible. 
Then pull the eject handle to pop out the end of the toner cartridge.

4. Remove the new cartridge from its bag.

1

2
3

Color markers
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5. While holding the cartridge with one hand, slide it out as shown.

6. Hold the cartridge with one hand from the end with the opening seal, insert it 
into the protective bag of the new cartridge and dispose of it.

NOTE: We recommend holding the used toner cartridge from the end with the 
opening seal to avoid getting your hands dirty. 

Do not try to rock the used cartridge; otherwise toner leakage may occur.

7. Prepare a new toner cartridge of the desired color by rocking it up and down five 
or six times to distribute the toner evenly, as shown.
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8. Remove the two protective tapes.

9. Place the toner cartridge on a flat surface, then pull the sealing tape completely 
out in the indicated direction. The tape may break if not pulled out in this 
direction.

NOTE: Do not pull the sealing tape diagonally, as it may snap.

Avoid touching the windows on the top and bottom of the cartridge.
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10. Hold the cartridge with the arrow label facing up, then slide it completely into 
the rotary until it snaps into place. Avoid touching the windows on the top and 
bottom of the cartridge. 

11. Insert the toner cartridge all the way into the printer. Make sure the end of the 
cartridge is aligned with the marks. 

12. Close the front door. 

Color markers
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Tips for replacing the toner cartridge
Be sure to observe the following when changing the toner cartridge:

• This printer uses four color toner cartridges: cyan, magenta, yellow, and black. 
Each color cartridge has its own holder in the printer’s rotary. When loading a 
toner cartridge, make sure its color matches the color markers on the printer. 

• If the printer is operated with the toner cartridge inserted in the wrong holder, 
the print quality will decrease and may result in printer malfunction. Therefore, 
be sure to insert the cartridges correctly. 

• If you pull the eject handle when the color markers are not fully visible, the 
toner cartridge cannot pop out and this may damage the handle. 

Color markers on the printer Color markers on the toner cartridge
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Replacing the silicone oil bottle
Silicone oil is used in the final fixing process before the paper comes out of the 
printer. To prevent toner offset caused by toner on the fixing rollers, the upper 
roller remains in contact with the cleaning belt saturated with silicone oil supplied 
from the silicone oil bottle. When the oil level is low, replace the silicone oil bottle 
with a new one, as follows.

1. Make sure the power switch is turned off. Then open the front door.

2. Open the stopper completely ➀. Then, lift up the used silicone oil bottle 
completely ➁. Be careful as some silicone oil may drip out of the bottle. 

NOTE: To prevent possible oil leakage, do not place the removed oil bottle upside 
down or drop it to the floor. 

Do not dispose of the used silicone oil bottle in a flame of any kind.

S-H1 310ml
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3. Peel off the seal from the new silicone oil bottle and put it on the old bottle.
Do not shake the bottle or the oil may spill out.

4. Insert the new bottle into the compartment with the label facing towards you and 
the spout on the right and facing down.

5. Press the bottle down until it goes completely into the compartment.

S-H1 310ml
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6. Close the cover completely.

7. Then, close the front door.

The oil is very slippery, and may present a skidding or slipping hazard. Following 
a spill or leak, use absorbent material to contain and collect excess oil for salvage 
or disposal. Thoroughly clean the floor or other contaminated surface (such as a 
ladder) and do not leave any traces of the oil. Use an all-purpose alkaline cleaner, 
or have the surface (including carpeting) cleaned commercially. Petroleum 
distillates may be used, except on plastic or vinyl surfaces. Dispose of absorbed 
material in accordance with applicable federal, state, and local requirements.

Do not operate the printer when no silicone oil bottle is installed; otherwise the 
printer may be damaged. 

NOTE: This printer uses a special type of oil called silicone oil to prevent toner 
offset when the toner is fixed. For this reason, when a new printer is first used, the 
first one or two printouts may be stained with this oil. This may also occur after 
the fixing assembly has been replaced by the service personnel.

!
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Using the drum cartridge kit
A message displayed on the printer control panel indicates that the drum cartridge 
needs replacing. When black vertical streaks or toner spots appear on the printouts 
after the message appears, replace the drum cartridge immediately, following the 
procedure below. Also replace the waste toner bottle next to the drum cartridge.

If you continue printing with a depleted drum cartridge, the print quality will 
diminish and the printer may malfunction.

NOTE: Each time you replace the drum cartridge, clean the wire inside the 
separation corona unit using the wire cleaner stored inside the printer.

When replacement is necessary, be sure to use a new drum cartridge. The printer 
may not function properly if replaced with a partly used drum cartridge.

TO REPLACE THE DRUM CARTRIDGE:

1. Make sure the power switch is turned off. Then open the front door.

2. Before you push down the release handle, make sure the toner cartridge rotary is 
properly positioned for installing/removing the toner cartridge.
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3. Push down the release handle to unlock the waste toner bottle and the drum 
cartridge. 

4. Push the handle on the drum cartridge door in the direction of the arrow to open 
the door fully. 

5. Pull out the waste toner bottle.

6. If necessary, tap the top of the waste toner box to settle the used toner contained 
inside it.
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7. Remove the sealing cap provided and plug it into the opening on the used waste 
toner bottle to cap it immediately.

8. While pressing the green tab on the right side of the drum, pull out the drum 
cartridge.

9. Attach the drum cartridge cover (removed earlier) to the used drum cartridge.

NOTE: Dispose of the used drum cartridge according to local regulations.
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10. Remove the new drum cartridge from its protective bag.

NOTE: Do not open the protective bag or drum cartridge cover until you are ready 
to install it into the printer.

Do not expose the drum cartridge to direct sunlight.

11. Direct the end with the  mark towards the printer and insert the drum 
cartridge cover into the V-shaped opening, as shown. 

NOTE: Do not apply excessive force to the protective cover while handling the 
drum cartridge. Otherwise, the photosensitive drum may be scratched.
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12. While holding the cover with one hand and the cartridge horizontally, place the 
drum on the rails of the compartment and gently slide the drum in.

13. When the drum cartridge is completely inside the printer, remove the cover.

NOTE: Save the drum cartridge cover for future use to cover a used photosensitive 
drum. 

Avoid touching the surface of the photosensitive drum with your fingers

14. Push the drum cartridge all the way in until the green tab on its end is locked.



CC-30 Using the drum cartridge kit

15. With the opening facing the printer, attach the new waste toner bottle to the 
printer. 

16. Close the drum cartridge door. 

NOTE: Make sure the drum cartridge is fully inserted into the printer before 
closing the door.

17. Push up the release handle to lock the drum cartridge.
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TO CLEAN THE SEPARATION CORONA WIRE:

1. Open the top cover to reveal the separation corona unit and the wire cleaner.

2. Remove the wire cleaner from inside the printer.

3. Place the wire cleaner on the separation corona unit.
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4. Clean the separation corona wire by moving the wire cleaner from side to side 
several times.

NOTE: The separation corona wire is very thin and delicate, so take care not to 
break it. 

5. After cleaning, replace the brush in its original place and close the top cover.
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6. Close the front door.

This completes the replacement of the drum cartridge and the waste toner bottle, 
as well as the cleaning of the separation corona wire. 

7. Turn on the power again.

NOTE: If you cannot push up the release handle completely, do not continue by 
force or the printer may be damaged. Instead, remove the drum cartridge and re-
install it again, making sure that the drum cartridge is completely inside the 
printer. 

Do not attempt to remove the used toner from the toner bottle nor reuse it. 
Doing so may cause printer malfunction. 

Do not dispose of waste toner in a flame of any kind.
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Moving the printer
Before moving the printer, follow these guidelines:

• Open the photosensitive drum door and remove the waste toner bottle.

• Drop the transfer drum lever and remove the drum cartridge. Store the drum 
cartridge in the drum cover.

• Remove the toner cartridges.

• Fix the transfer drum unit with the transfer drum fixing screw.

• Open the front door and remove the oil bottle. Remove oil from the fixing unit.

• Tape shut the transfer drum lever and the photosensitive drum door.

• Tape shut the front door, the fixing unit cover, and the pick-up cover.

Before moving the printer to a new location, be sure to remove any silicone oil in 
the printer with the oil pump included in the printer package (see “To remove the 
silicone oil:” on page C-35). Also remove the drum cartridge (see “To replace the 
drum cartridge:” on page C-25), the four toner cartridges (see “To replace a used 
toner cartridge:” on page C-16), and the waste toner bottle. 

Remove any oil from the oil catch tray with the oil removing tool and transfer the 
oil to the oil storage bottle. Move the lever up and down about 50 times. Then 
remove any oil in the bottle case and oil catch tray again. Repeat this three times. 
Wash off any silicone oil from your hands with a mild detergent.

Neglecting this operation will cause oil leakage inside the printer and may damage 
the unit. !
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TO REMOVE THE SILICONE OIL:

1. Make sure the power switch is off, then open the front door.

2. Open the stopper completely ➀ and lift out the silicone oil bottle from the holder 
➁.

Be careful as oil may drip from the bottle. Store it on a flat level surface, away 
from direct sunlight. 

3. Prepare the oil pump and oil recycle bottle. 

S-H1 310ml
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4. Uncap the oil recycle bottle and remove the inner cap. 

Place the bottle on a flat, level surface, away from direct sunlight.

5. Pump the oil from the holder with the oil pump and transfer it to the recycle 
bottle. Repeat until most of the oil has been pumped out.

6. Push up the release knob to open the fixing assembly door. 
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7. Then push down the jam release lever about 50 times to guide the silicone oil 
from the fixing assembly into the holder. 

About 40 cc of oil may be contained in the fixing assembly.

The fixing assembly and the delivery areas may be hot. Be careful when using the 
lever.

8. Pump the oil from the holder with the oil pump and transfer it to the recycle 
bottle.

9. Repeat the procedure described in steps 7 and 8 three or four times until most of 
the oil has been removed from the fixing assembly.

10. Replace the inner cap on the oil recycle bottle and recap it securely. Close the 
stopper completely, then close the front door. 

The printer can now be moved. The oil recycle bottle can contain about 100 cc of 
silicone oil. Store the silicone oil bottle and the recycle bottle on a flat, level 
surface, away from direct sunlight.

!
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11. After moving the printer, replace the silicone oil into the printer. To do this, open 
the front door, then open the stopper completely ➀. Uncap the recycle bottle and 
slowly pour the oil back into the holder ➁. Finally, replace the silicone oil bottle 
into the holder ➂, then close the stopper ➃ and front door securely.

NOTE: Do not add any oil to the printer other than what was removed.

The oil is very slippery and may cause skidding or slipping if spilled. Use an 
absorbent material to contain and collect spilled oil for disposal. Thoroughly clean 
any oily surface with an all-purpose alkaline cleaner, or have the surface 
(carpeting, for example) commercially cleaned. Except for cleaning plastic and 
vinyl surfaces, petroleum distillates can be used. Dispose of absorbed material 
according to federal, state and local regulations.

NOTE: Do not incinerate the used oil recycle bottle or the oil pump.

Never use any oil other than the suggested one.

Do not operate the printer without the silicone oil bottle installed; otherwise the 
printer may be damaged.

Keep the oil recycle bottle and oil pump clean and free of any foreign objects 
when handling or storing.

1 2
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D-1 Power problems

 

This appendix contains information about:

• Power problems

• Printing large files

• Initialization problems

• Print quality and paper problems

• Paper jams

• Correcting abnormal printouts

If a printer problem occurs, use the checklist below to solve the problem. If a 
problem persists or is not covered here, call an authorized dealer or the place of 
purchase.

See Appendix A for lists of messages that may appear on the printer control panel 
with the appropriate corrective action for each one.

AVOID ELECTRIC SHOCK. If the printer does not work properly even after 
taking the suggested measures, do not attempt further adjustment and do not try 
to disassemble the printer. The printer contains high-voltage parts which may 
cause electric shock when touched. Turn off the printer and unplug it from the AC 
outlet. Then call your authorized warranty service provider or a qualified Digital 
Multivendor Customer Services engineer. See Appendix H for more details.

 

Power problems

 

Is power supplied to the AC outlet?

• Check the AC outlet.

Is the power cord securely plugged into the AC outlet?

• Check the power cord connection.

Is the printer turned on?

• Make sure the power switch remains pressed (that is, on).

Appendix D: 
Troubleshooting

!
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D-2 Initialization problems

 

Does the printer’s voltage rating match that of the AC outlet?

• Check the voltage of the printer as well as the AC outlet.

 

Initialization problems

 

Is the printer level (at less than a 1% angle)?

• If the printer is not level the error message 

 

REPLACE FIXING UNIT PUMP

 

 is 
displayed.

Is the printer attached to the network?

• When a transceiver is attached to the printer but not to the network, the 
Colorwriter fails to power up to the ready state and hangs at the 

 

LOADING 
SYSTEM

 

 screen. Connecting the network at any time will allow the printer to 
complete the powerup and initialization. Ensure that the connector latch is 
secure.

 

Printing large files

 

You cannot print a job whose file size exceeds the amount of available space on the 
Colorwriter’s hard disk. If you try to print such a job, you will get a PostScript 
limitcheck error.

If you consistently print large (over 100MB) files, and have insufficient disk space, 
the following tips may help you maintain the largest possible amount of available 
disk space:

• Using the Colorwriter LSR Downloader, delete fonts you have downloaded to 
the Colorwriter and no longer use. When possible, let the application download 
the fonts it needs.

• Using the Colorwriter LSR Spooler, delete the jobs in the Hold queue and the 
Printed queue that you no longer use. To free up more space, you can disable 
the Hold queue and the Printed queue from Printer Setup on the printer 
control panel.

• Run a few tests to match the resolution of your files to the resolution needed for 
good printed results. If your files are so large because you are sending high 
resolution raster image data to the printer, try printing the file at 300 or 150 
dpi.
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Print quality and paper problems

 

Is the correct paper type used?

• See “Paper requirements” on page E-3 and check the paper type.

Are toner cartridges inserted in the correct order?

• See “Replacing a toner cartridge” on page C-16 and make sure the toner 
cartridges are installed in the correct order.

Is there slight graying on the pages?

• Be sure to clean the printer periodically; see “Cleaning and handling the 
printer” on page C-5 for information on how to do this. After using the printer 
for prolonged periods of time, there may be slight gray shading on the pages. 
You may be able to eliminate the shading by using the wire cleaner (as explained 
in Appendix C) or replacing the toner cartridge.

Is the silicone oil bottle stopper, drum cover, or transfer drum release handle 
properly set back?

• See “Replacing the silicone oil bottle” on page C-22, “Using the drum cartridge 
kit” on page C-25, and “To replace a used toner cartridge:” on page C-16 and 
make sure they are properly set back in the original place.

Is the printer displaying a message about the fuser?

• When the message appears, the fuser is good for about 500 more printouts. The 
fuser must be replaced or it will stop functioning.

Does the paper loaded exceed the paper limit mark?

• Make sure the stack does not exceed the paper limit mark.

Is the paper stack correctly aligned?

• Make sure the paper stack is correctly aligned in the main and optional cassettes 
or in the multipurpose tray.

Is the correct paper type used?

• See “Paper requirements” on page E-3 and check the paper type.

Is there any jammed paper inside the printer?

• Make sure no paper remains inside the printer after a paper jam.
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Paper jams

 

There are three possible paper jam locations: the feeder area, the print and transfer 
area, and the output area.

If a paper jam occurs, follow the instructions described in the following pages to 
remove the jammed paper in a way appropriate to the actual jam site on the 
printer.

The instruction label on the oil bottle holder also gives instructions for clearing 
paper jams.

Several of the procedures in this appendix are also detailed on the Quick 
Reference Card that came with your Colorwriter documentation. Adhere the clear 
plastic pocket to your printer and use it to keep the Quick Reference Card handy, 
so you have ready access to procedures for clearing paper jams.

Optional paper feeder unit

Print and transfer area

Output area

Feeder area

1

2

3

12

3

4

4

3

2

1

1

2

3

4
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C

 

HECKING

 

 

 

THE

 

 

 

FEEDER

 

 

 

AREA

 

:

 

1. Make sure the multipurpose tray is closed.

2. Push up the release knob to open the feeder door.

3. Remove the jammed paper if you can find it.
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4. If the jammed paper is not visible or if it is difficult to remove, pull the two green 
levers and slide out the entire feeder unit.

5. Carefully remove the jammed paper in the likely spots as indicated.

6. Push the levers to slide the feeder unit back into the printer.
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7. Close the feeder door.

 

When using the optional paper feeder unit

 

1. Pull the tab to open the optional cassette feeder door.

2. Carefully remove the jammed paper.
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3. Close the door and resume printing.

 

Checking the transfer drum area

 

N

 

OTE

 

:

 

Even if the trailing edge of the jammed paper is visible over the transfer 
drum, avoid pulling it out from the top cover side. The toner is not fixed onto the 
paper and falls off to scatter inside the printer. It will lead to the permanent print 
deterioration in extreme cases. In such cases, use the procedure on page D-13 to 
remove the jammed paper.

 

1. Open the front door.

NG

Tab
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2. Use the tab identified in step 1 to raise the top cover.

 

Avoid touching the window of the density detection sensor, which is used to 
adjust the grayscale. 

 

3. Push down the handle to unlock the transfer drum.

4. Turn the transfer drum knob in the direction of the arrow 

 

➀

 

 until the top edge of 
the paper is visible

 

 

 

➁

 

.

1

2
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5. Release the top edge of the paper by gently pulling a corner of the paper.

 

Be careful not to stain the density detection sensor with the non-fixed toner. 
Remove the jammed paper by pulling at a slight angle.

 

N

 

OTE

 

:

 

Do not touch the print on the paper.

 

6. While turning the knob, gently pull out the jammed paper.

N

 

OTE

 

:

 

Be careful not to touch the transfer drum.

 

7. Pull up the handle to lock the transfer drum.

8. Lower the tab to close the top cover.

!
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9. Close the front door and resume printing.
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Checking the fixing assembly area

 

The fixing assembly and delivery areas may be hot. Wait until the printer has 
completely cooled off. Be careful when accessing the knobs and lever.

 

1. Close the face-up tray if it is open.

2. Push up the release knob to open the fixing assembly door.

!


CAUTION! HOT SURFACE. AVOID CONTACT ACHTUNG HEISS
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Release knobs

Jam release lever
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If the leading edge of the paper is visible, follow the procedure below to remove 
the jammed paper.

 

3. Pull the release knobs and open the guide cover.

4. While repeatedly pushing down and releasing the lever, remove the jammed paper 
completely from the printer.

 

Be sure to open the guide cover first before operating the release lever. Not doing 
so will result in loosening the cleaning belt inside so that it will come out from the 
printer.

 

N

 

OTE

 

:

 

Avoid pulling out the jammed paper, as it may rip and remain inside the 
printer.

If the jammed paper is wound up onto either the upper or lower fixing roller, 
follow the procedure below to remove the paper.
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5. First, open the guide cover ➀, then move the lever up and down until the trailing 
edge of the jammed paper is visible ➁.

To pull out the paper, hold and slide the release lever as shown to unlock both 
fixing rollers ➀. It is properly set when the lever is seated in the slit on the metal 
plate ➁.

While sliding the lever, be careful not to put your fingers too far into the printer 
because the wheels and the metal plate are exposed nearby.

Be sure to open the guide cover first before operating the release lever. Not doing 
so will result in loosening the cleaning belt inside so that it will come out from the 
printer.

1

2

1 2
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6. Slowly pull out the jammed paper from the printer while holding the printer with 
your hand.

Before pulling out the trailing edge of the paper, make sure the guide cover has 
been opened.

7. Finally, set the lever back to its original position, and close the guide cover (➀, 
➁).

NOTE: If you get silicone oil on your hands while removing the jammed paper, 
wash them with a mild detergent.

8. Close the fixing assembly door and resume printing.

1

2
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Correcting abnormal printouts
If abnormal images similar to the following examples are printed, follow the 
procedures below to correct them.

Example 1

TO CORRECT EXAMPLE 1:

1. While pressing the COLOR SELECT button on the density control panel (on the 
back of the printer), press ENTER three times. 

The Y and Bk indicators flash and the separation high voltage control mode is set.

M C Y Bk

COLOR

SELECT DEFAULT ENTER
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2. Use the +/- buttons to move the level indicator to the position shown, then press 
the ENTER button to set the separation high voltage ON.

3. Print out the page again and check the results.

NOTE: If the abnormal printout no longer occurs, reset to the default setting.

TO CORRECT EXAMPLE 2:

1. While keeping the COLOR SELECT button on the density control panel pressed, 
press ENTER three times. 

The Y and Bk indicators flash and the separation high voltage control mode is set.

M C Y Bk

COLOR

SELECT DEFAULT ENTER

M C Y Bk

COLOR

SELECT DEFAULT ENTER
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2. Use the +/- buttons to move the level indicator to the position shown, then press 
the ENTER button to set the separation high voltage OFF.

3. Print out the page again and check the results.

NOTE: If the abnormal printout no longer occurs, reset to the default setting.

M C Y Bk

COLOR

SELECT DEFAULT ENTER
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E-1 Colorwriter specificationss

 

This appendix contains specifications for the Colorwriter LSR 2000

 

+

 

 and the 
kinds of paper you can use in it.

 

Colorwriter specifications

 

Category Specification

 

Printer type: Desktop color page printer

Printing method: Electrophotographic process via laser beam scanning

Color process: Full color development with C, M, Y, K or monochrome printing 
selectable

Print quality: Continuous tone at 600 X 600 dots per inch
Automatic temperature and humidity monitoring and 
recalibration

Processor speed: 100 MHz RISC

Print speed: Maximum 3 pages per minute in full-color or 12 pages per 
minute in monocolor print using A4-size plain paper via cassette 
feed

Connectivity: Autosensing ports: Centronics parallel, Ethernet (RJ45 and AUI 
built-in, BNC optional)
Simultaneous auto-switching protocols: Ethertalk, TCP/IP, 
Novell Netware IPX

Language: Adobe PostScript Level 2

Memory: 16MB (standard), 32MB, 48MB (maximum)

Hard disk: Minimum of 341MB SCSI

First print: Approximately 40 seconds in full color or 25 seconds in 
monocolor print using A4-size plain paper via cassette feed at 
20

 

°

 

C (68

 

°

 

F).

Warm-up: 4.5 minutes at 20

 

°

 

C (68

 

°

 

F) for 100V and 220V input
3.5 minutes at 20

 

°

 

C (68

 

°

 

F) for 120V and 240V input
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E-2 Colorwriter specifications

 

Paper feed:
Via cassette: Maximum stacking height: 25 mm (approximately 250 sheets of 

plain paper at 20 lb (80g/m

 

2

 

) or 150 sheets at 24 lb (90 g/m

 

2

 

)

Via MP tray: Maximum stacking height: 10 mm (approximately 100 sheets of 
plain paper at 20 lb (80 g/m

 

2

 

) or 50 sheets at 24 lb (90 g/m

 

2

 

) 
(transparency film must use MP tray feed; you can load up to 20 
sheets of transparency film at a time.)

Feeding Direction: Short edge feed only

Paper stock:
Via cassette:
Via MP tray:

Acceptable 16 to 24 lb (61 to 90 g/m

 

2

 

)
Acceptable 16 to 28 lb (61 to 105 g/m

 

2

 

)

Paper output:
With face-down tray:
Via face-up tray:

Approximately 100 sheets of plain paper at 20 lb (80 g/m

 

2

 

)
Approximately 20 sheets of plain paper at 20 lb (80 g/m

 

2

 

)

Paper size:
Via cassette:
Via MP tray:

Universal paper cassette (A4, Letter, B5 or Legal size)
Acceptable in 216 x 356 mm to 182 x 257 mm

Printable media:
Via cassette:
Via MP tray:

Cassette-sized plain paper only, including letter head
Dedicated transparency film (A4- or letter-size only) and plain 
paper listed above.

Duty cycle: Up to 20,000 pages per month

Warranty: 1 year on-site

Weight: 110 lbs (without paper)

Dimensions: 21.3" W x 22.8" D x 18.1" H

Safety standards Energy Star, FDA, UL 1950, CSA 22.2 #950, EN 60950

Emissions standards 
(class B)

FCC, VDE, EN55022, VCCI

 

Category Specification
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E-3 Paper requirements

 

Paper requirements

 

Using the correct paper ensures good print quality, prevents paper jams, and 
extends the printer life.

 

N

 

OTE

 

:

 

This printer does not accept envelopes and labels.

For printing on transparency film, use the multipurpose tray only, and make sure 
the proper paper delivery is selected prior to printing.

When feeding transparency film, position each sheet so that the white positioning 
marker (triangle) is on the upper right.

When tapping the transparency film (to avoid multiple feeds), be careful not to 
scratch or leave fingerprints on the print sides. If you look at a transparency with 
its white marker positioned on the right, the side facing away from you is the print 
side.

This printer accepts short edge feed only.

 

Loading Paper Size Weight/Delivery Capacity

 

Cassette Plain Any size from 216 x 
356 mm to 184 x 
267 mm, including: 
Letter (8-1/2" x 11")
A4 (210 x 297 mm)
Legal (8-1/2" x 14")
B5 (182 x 257 mm)

16 to 24 lb (61 to 
90 g/m

 

2

 

)
Up to a 25-mm stack 
height (about 250 
sheets of 20 lb 
(80 g/m

 

2

 

) paper)

Multipurpose Tray Plain Any size from 216 x 
356 mm to 184 x 
267 mm, including: 
Letter (8-1/2" x 11")
A4 (210 x 297 mm)
Legal (8-1/2" x 14")
B5 (182 x 257 mm)

16 to 28 lb 
(61 to 105 g/m

 

2

 

)
Up to a 10-mm stack 
height (about 100 
sheets of 20 lb 
(80 g/m

 

2

 

) paper)

transparency film Letter (8-1/2" x 11")
A4 (210 x 297 mm)

— About 20 sheets
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E-4 Paper requirements

 

Unacceptable paper

 

Avoid using the following types of paper:

• Too thick or too thin

• Wet paper

• Highly textured or rough paper

• Curled, creased, or damaged paper

• Non-rectangular paper (such as aerograms)

• Paper with cutouts or perforations

• Paper with irregular shape

• Paper with wrinkles or rips

• Damaged paper

• Paper with special coating

During the fusing process, paper is exposed to high temperature. Therefore, the 
following types of paper should not be used: 

• Thermal paper 

• Paper that deforms or discolors at high temperature 

• Paper that offsets (leaves toner on the backs of printed pages) at high 
temperature 

• Pre-printed paper which contains ink that will deteriorate at high temperature 
(such as invoices and company letterheads) 

• Adhesive paper

 

N

 

OTE

 

:

 

Using paper that deforms or deteriorates in quality at high temperature 
may damage this printer. In particular, pre-printed paper and coated paper should 
be checked first to ensure that it meets the heat compatibility specifications.

Paper that could damage this printer:

• Carbon paper 

• Paper with staples, ribbons, tape, and so forth
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E-5 Effective printing area

 

Effective printing area

 

The shaded area in the figure below indicates the printable area on a sheet of 
paper.

 

Paper Size Border Width (mm)

A B C D

 

Letter, A4, Legal, and B5 10.0 5.0 5.0 5.0

A

B

C D
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F-1 Optional paper feeder unit

 

For high quality and reliability, use genuine Digital accessories and supplies.This 
appendix lists the accessories and supplies available for the Colorwriter. Contact 
your local authorized Digital reseller or Digital sales office for more information. 
In North America, call 1-800-DIGITAL (1-800-344-4825). 

 

Optional paper feeder unit

 

This option (LNC1X-TA) comes with the paper feeder unit, an optional 
(universal) cassette, and two locking pins to secure the paper feeder unit to the 
printer body.

Appendix F: 
Ordering 
Accessories 
and Supplies

Cautio
n

Precaucion

PrecaucionVorsicht

Atte
ntio

n

SAFETY INFORMATION
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Figure 1

Figure 2

Locking pins (2)

Caution sheet Safety information sheet

Optional (universal) cassette

Paper feeder unit
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F-2 Upgrade kits

 

Optional paper cassette

 

You can purchase a universal paper cassette (LNC1X-TB) which can hold any size 
from 216 x 356 mm to 184 x 267 mm, including Letter, A4, Legal, and B5 paper. 
You can load only plain paper from 16- to 24-lb (61 to 90 g/m

 

2

 

) into a paper 
cassette, and the maximum capacity is about 250 sheets at 20 lb (80 g/m

 

2

 

).

 

Upgrade kits

 

The following upgrade kits are available:

Instructions for installing the SIMMs are included in the kit itself.

 

Memory upgrade kit Contents Part Number

 

16MB to 32MB 16MB (4x4) + CD LNCIX-CD

16MB to 48MB 32MB (4x8) + CD LNCIX-CE

32MB to 48MB 16MB (4x4) + CD LNCIX-CD

v1 32MB to v2 32MB CD LNCIX-CF

Optional cassette

Caution

Precaucion

Precaucion

Vorsicht

Attention

Caution sheet
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F-3 Ordering consumables

 

Ordering consumables

 

You will want to keep a supply of the following consumables on hand—especially 
if your site has more than one printer in service. For high quality and reliability, 
use genuine Digital supplies and accessories.

 

Toner cartridges

 

Use of the genuine toner cartridges designed for this printer is recommended. 
Four types of color toner cartridges are available: cyan, magenta, yellow, and 
black.

 

N

 

OTE

 

:

 

Each color toner cartridge typically lasts for about 4,000 prints of A4- or 
Letter-size paper (when printing at 5% print density). The actual cartridge life, 
however, depends on how much toner of each toner cartridge is used for each 
print; the more toner from a particular toner cartridge is used for each print, the 
shorter the cartridge life for the particular color toner cartridge will become. For 
details, see “Storing and handling toner cartridges” on page C-15.

A Material Safety Data Sheet is available for toner cartridges.

Before installing a toner cartridge, be sure to remove the two pieces of protective 
tape.

 

Description Part Number

 

Cyan toner cartridge LNC1X-AB

Magenta toner cartridge LNC1X-AC

Yellow toner cartridge LNC1X-AD

Black toner cartridge LNC1X-AA
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F-4 Ordering consumables

 

Silicone oil

 

Silicone oil is used in the final fixing process before the paper comes out of the 
printer. To prevent toner offset caused by toner on the fixing rollers, the upper 
roller remains in contact with the cleaning belt impregnated with silicone oil 
supplied from the silicone oil bottle (LNC1X-AF). 

You will probably need to replace the silicone oil after about 10,000 pages of full 
color.

A Material Safety Data Sheet is available for silicone oil.

The oil is very slippery, and may present a skidding or slipping hazard. Following 
a spill or leak, use absorbent material to contain and collect excess oil for salvage 
or disposal. Thoroughly clean the floor or other contaminated surface (such as a 
ladder) and do not leave any traces of the oil.

Use an all-purpose alkaline cleaner, or have the surface (including carpeting) 
cleaned commercially. Petroleum distillates may be used, except on plastic or vinyl 
surfaces. Dispose of absorbed material in accordance with applicable federal, state 
and local requirements.

• Do NOT use any other than the specified silicone oil.

• Do not dispose of the used silicone oil bottle in a flame of any kind.

• Do not operate the printer when no silicone oil bottle is installed; otherwise the 
printer may be damaged. 

S-H1
310ml

LOT NO.

!
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F-5 Ordering consumables

 

Drum cartridge kit 

 

Each drum cartridge kit (LNC1X-AE) contains a drum cartridge and two waste 
toner bottles. When you replace the drum cartridge, be sure to always replace the 
waste toner bottle as well.

You will probably need to replace the drum cartridge after about 5,000 to 30,000 
pages, based upon the use of color per page. OPC drum life is an estimate only, 
and is dependent on the mix of color images and black only images being printed. 
The frequency of the auto calibration and the amount of continuous versus 
intermittent printing that occurs will also contribute to the overall drum life.

After you remove the cap from the new waste toner bottle, be sure to use this 
sealing cap to recap the used waste toner bottle before storing it away.

Sealing cap
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F-6 Ordering consumables

 

Transparency film

 

For optimum printing results, use only the transparency film specifically for the 
Colorwriter LSR 2000

 

+

 

. Under no circumstances should this type of transparency 
be used with other laser printers In addition, remember to feed transparency film 
via the multipurpose tray only.

 

Paper

 

While most 17–28 lb paper is usable, high brightness print media, such as 
Hammermill’s LaserPrint 24 lb paper, is recommended for this color laser printer. 
Also, Teslin

 



 

 for laser printers and colored paper are acceptable. It is a good idea 
to experiment using different types or brands of paper (as long as it complies with 
these specifications). Make sure you are satisfied with the results before purchasing 
large quantities of paper.

For more details about print media, see “Paper requirements” on page E-3.

 

N

 

OTE

 

:

 

Do not attempt to print labels on the printer.

 

Description Quantity Part Number

 

Letter-size transparency 
film

50 sheets LNC1X-AG

A4-size transparency film 50 sheets LNC1X-AH
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G-1 Technical support

 

The following documentation is included in the Document Package for the 
Colorwriter LSR 2000

 

+

 

 printer: 

•

 

Getting Started

 

•

 

User Guide

 

•

 

Quick Reference Card

 

•

 

Release Notes

 

•

 

Registration Card

 

•

 

Warranty Card

 

The order number for the Colorwriter LSR 2000

 

+

 

 Document Package is 

 

EK-LCPLE-DK

 

. 

In addition to the specific Colorwriter LSR 2000

 

+

 

 documentation listed above, 
the following documents provide general PostScript language information:

•

 

PostScript Language Reference Manual Supplement for Version 2013

 

 
by Adobe Systems Incorporated, March 31, 1993.
Available through the Adobe Systems Developer Support organization

•

 

PostScript Language Reference Manual, Second Edition

 

by Adobe Systems Incorporated, ISBN 0-201-18127-4. 
Available in bookstores

 

Technical support

 

If you need help deciding which documentation best meets your needs call 
800-DIGITAL (800-344-4825).
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G-2 Electronic orders

 

Electronic orders

 

If you wish to place an order through your account at the Electronic Store, dial 
800-234-1998, using a modem set to 2400- or 9600-baud. You must be using a 
VT terminal or terminal emulator set at 8 bits, no parity. If you need assistance 
using the Electronic Store, call 800-DIGITAL (800-344-4825) and ask for an 
Electronic Store specialist.

 

Telephone and direct mail orders

 

In North America:

For international orders, contact your local Digital subsidiary or approved 
distributor.

 

From Call Write

 

U.S.A. DECdirect
Phone: 800-DIGITAL
(800-344-4825)
Fax: 800-513-4778

Digital Equipment Corporation
Merrimack Communications Center
P.O. Box 9501
Merrimack, NH 03054

Puerto Rico Phone: 809-781-0505
Fax: 809-749-8300

Digital Equipment Corporation, Inc.
3 Digital Plaza, 1st Street
Suite 200
Metro Office Park
San Juan, Puerto Rico 00920

Canada Phone: 800-344-4825
Fax: 613-591-4021

Digital Equipment of Canada Ltd.
100 Herzberg Road
Kanata, Ontario, Canada K2K 2A6
Attn: DECdirect Sales
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G-3 Telephone and direct mail orders

 

For internal orders:

 

a. Call to request an Internal Software Order Form (EN-01740-07).

 

For Call Write

 

Internal Orders

 

a

 

(for software 
documentation)

DTN: 264-4446
(603) 884-4446

U.S. Software Supply Business
Digital Equipment Corporation
10 Cotton Road
Nashua, NH 03063-1260

Internal Orders 
(for hardware 
documentation)

DTN: 264-4446
(603) 884-4446

U.S. Software Supply Business
Digital Equipment Corporation
10 Cotton Road
Nashua, NH 03063-1260
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H-1 Questions to ask before calling the service center

 

Use MCS On-line to learn about new services and special offers, or to browse 
through Digital’s service menu. Our world wide web page is at:
http://www.digital.com/-i/mcs/mcsovw.html

Before calling the service center, check Appendix D, “Troubleshooting.” Often 
you can solve the problem yourself.

If not, try to determine if the problem is a:

• Software application problem.

• Generic PostScript problem.

• Software driver problem.

• Hardware problem, such as print quality.

If you cannot correct a problem with the Colorwriter LSR 2000

 

+

 

 printer, request 
servicing from your authorized warranty service provider or a qualified Digital 
Multivendor Customer Services engineer.

 

Questions to ask before calling the service center

 

To ensure the best possible service, read the following series of questions and 
answers before you call the Digital service center.

 

Who should call for service?

 

Typically, the system manager should place the call for service.

 

Where should you call?

 

In the continental United States: If you purchased on-site warranty support at the 
time of sale, call Digital at 1-800-354-9000

If you do not have on-site warranty support and are returning the printer to 
Digital for service, call 1-800-225-5385.

For per call service information, call your local sales office.

In Alaska, Hawaii, Canada, and Europe: Call your local sales office for service.

Appendix H: 
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H-2 Questions to ask before calling the service center

 

What does the service center need to know?

 

Write down the serial and model numbers located on the label at the rear of the 
printer.

 

How should you describe the problem?

 

Summarize the problem. Make a note of: 

• The file, application, host computer, and connectivity you were using when the 
printer failed.

• Any indicators on the printer control panel, such as an error message.

• Any strange noises.

Stay by the printer and host system, if possible, because the service engineer may 
ask you to try some tasks.



 

Glossary

 

additive color model

 

A system in which color is produced by 
combining primary lights additively. The 
additive primaries are red, green, and 
blue. When added together in proper 
amounts, these colors produce white. An 
RGB video monitor is based on an addi-
tive color model.

 

additive primaries

 

Red, green, and blue light that is used in 
additive color systems. The additive pri-
maries combine to produce white.

 

banding

 

Visible steps between shades in a 
gradient.

 

bit depth

 

Amount of information required for 
each pixel in a raster image. Black and 
white images require only one bit per 
pixel. Photographic quality color images 
can require 24 or 32 bits per pixel.

 

Calibrated RGB

 

An RGB color space used by EFI-
COLOR color management software as 
an interchange standard. The Calibrated 
RGB color space is defined according to 
the following specifications for a color 
monitor: SMPTE phosphors, a white 
point D50, and gamma of 2.2.

 

calibration

 

The process of ensuring that a device 
behaves consistently with respect to a set 
of specifications. 

 

color gamut

 

See

 

 gamut.

 

color rendering dictionary (CRD)

 

A feature found in PostScript Level 2 
color printers that gives improved 
matching between the monitor and 
printed output. Color rendering dictio-
naries are used by the printer’s PostScript 
interpreter when converting RGB data 
sent to the printer to CMYK data used 
by the print engine.

 

color rendering style

 

A feature of EFICOLOR color manage-
ment software that allows you to main-
tain the best possible translation of color 
from one color device to another. The 
EFICOLOR color rendering styles are: 
Solid Color, Photographic, Presenta-
tion, and Monitor color.

 

color space

 

A model for representing color in terms 
of measurable values, such as the amount 
of red, green, and blue in an image. RGB 
and CMYK color spaces are based on 
color devices—monitors and printers 
respectively. Other color spaces, such as 
CIELAB are based on mathematical 

 

Glossary
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G-2 Glossary

 

models, and are device-independent—
they are not based on the color response 
of a particular device.

 

colorant

 

An ink, die, toner, paint or other pig-
ment that modifies the color of what it is 
applied to.

 

composite printer

 

Any printer that can print directly in 
color without first creating color separa-
tions. A composite is an early proof of a 
printing job.

 

continuous tone

 

An image containing gradient tones. 

 

custom color system

 

A system of named color swatches that 
can be matched on press using process or 
spot colors. PANTONE and TruMatch 
are examples of custom color systems.

 

densitometer

 

An instrument that measures density 
according to a specified standard. 
Status T densitometers are commonly 
used in the graphic arts industry. 

 

density

 

A precise measurement of the light 
energy transmitted or reflected by a sur-
face in the presence of a standard light 
source.

 

four-color printer

 

A printing device that uses cyan, 
magenta, yellow, and black ink or toner.

 

gamut

 

A range of colors. A device gamut is the 
range of colors that a device, such as a 
printer, can produce. An image gamut is 
the range of colors in a particular image.

 

gamut mapping

 

The process whereby EFICOLOR color 
management software compresses—
“maps”—the colors in a digital image to 
fit the color gamut of a particular device. 

 

gradient fill

 

A color or grayscale fill made of smooth 
transitions between two different colors 
or shades.

 

Graphics device interface (GDI)

 

Graphics and display technology used by 
computers running Windows. GDI 
applications rely on GDI rather than the 
PostScript language to send words and 
pictures to printers.

 

halftoning

 

A method for representing an original 
continuous tone image using a pattern of 
dots of various sizes. The pattern is 
determined by the line frequency, screen 
angle, and dot shape. 

 

metamerism

 

Phenomenon where two colors com-
posed of different combinations of light 
wavelengths appear identical. The colors 
are called “metamers.”



 

G-3 Glossary

 

moiré

 

An undesirable pattern in images made 
using halftone screens. Moiré can be 
caused by improper screen angles, 
improper alignment of halftone screens, 
or by certain types of patterns in the 
image itself.

 

Monitor color rendering

 

A color rendering style that optimizes 
the match between monitor display and 
printer output.

 

named color

 

A color that is defined according to a 
custom color system. For example, PAN-
TONE 107 C is a named color.

 

offset lithography

 

Printing in which ink is transferred from 
printing plates to a rubber blanket and 
then from the blanket to paper.

 

Photographic rendering

 

A color rendering style that preserves 
tonal relationships in images. Unprint-
able colors are mapped to printable col-
ors in a way that retains differences in 
lightness, slightly sacrificing color accu-
racy as necessary.

 

pixel

 

The smallest distinct element of a raster 
image or an image displayed on a 
monitor.

 

PostScript Level 2

 

Current version of Adobe Systems’ Post-
Script language, which is used to print 
and display pictures and text. PostScript 

Level 2 includes many enhancements to 
older versions of PostScript, including 
improved color matching and the ability 
to control printer-specific features from 
applications.

 

prepress proof

 

A print made from a set of film separa-
tions, or from an electronic file, to simu-
late the results of printing. A film proof 
is the last opportunity to catch problems 
before the final printing.

 

Presentation Graphics rendering

 

A color rendering style that does not try 
to precisely match printed colors to dis-
played colors. It is appropriate for bright 
saturated colors used in illustrations and 
graphs.

 

process colors

 

The four ink colors used to simulate full-
spectrum color images: process yellow, 
magenta, cyan, and black.

 

QuickDraw

 

Graphics and display technology built 
into Macintosh computers. QuickDraw 
applications rely on QuickDraw rather 
than the PostScript language to send 
words and pictures to printers.

 

raster image

 

Electronic representation of a page or 
image using a grid of points (called pix-
els) that are numerically defined. Raster 
images can be black and white, grayscale, 
indexed color, or photographic quality 
color.



 

G-4 Glossary

 

separation

 

The process of separating a color image 
into the primary color components for 
printing—cyan, magenta, yellow, and 
black. Also used to refer to the four sheets 
of film that result from the process of sep-
arating a color image. 

 

Solid Color rendering

 

A color rendering style used when color 
accuracy is crucial. Unprintable colors 
are mapped to the closest printable col-
ors. It does the best job of preserving the 
saturation of displayed colors.

 

source profile

 

A profile used by EFICOLOR to deter-
mine the context for the color values 
specified in a digital image.

 

spot color

 

A color that is printed on its own separa-
tion plate when separations are specified. 
A spot color is printed using a special ink 
for that color, in contrast to process col-
ors that are printed using combinations 
of cyan, magenta, yellow, and black. 

 

Status T 

 

A spectral response for graphic arts 
reflection densitometers defined by 
ANSI (the American National Stan-
dards Institute.)

 

subtractive color model

 

A system in which color is produced by 
combining colorants such as paint, inks, 
or dyes on media such as paper or trans-
parent film or acetate. The subtractive pri-
maries are cyan, magenta, and yellow. All 
printing devices use the subtractive color 
model, as do photographs and transpar-
ency film. Many printers use cyan, 
magenta, yellow, 

 

and

 

 black colorants.

 

subtractive primaries

 

Cyan, magenta, and yellow colorants 
used in subtractive color systems. Com-
bining the subtractive primaries pro-
duces darker colors.

 

SWOP

 

The abbreviation for Specifications for 
Web Offset Publications. A standard of 
specifications for separations, proofs, and 
color printing usually designed for maga-
zine production.

 

vector image

 

Graphic illustration created on comput-
ers where picture elements are defined 
mathematically as lines or curves between 
points. Includes artwork created in illus-
tration and page layout applications. 



 

Index

 

A

 

activity lights 2-2
additive color model 1-3
additive primaries 1-3
adjusting

color density 2-7 to 2-8
paper guides 2-21 to 2-22

administrator. 

 

See

 

 system administrator
Adobe Font Downloader 3-7, 4-15
Adobe Illustrator

choosing fill and line colors 3-29
imported files, working with 3-30
monitor calibration 3-29
notes for optimizing 

(Macintosh) 3-29 to 3-30
Adobe Illustrator files

selecting print options for 3-30
Adobe Persuasion

notes (Macintosh) 3-36 to 3-37
selecting print options 3-37
working with imported files 3-36

Adobe Photoshop
Ambient Light pop-up menu 3-38, 

4-41
application note (Macintosh) 3-37 to 

3-39
application note (Windows) 4-40 to 

4-43
ASCII versus binary encoding 4-43
Calibrated RGB monitor settings

loading 3-38, 4-41
Color Picker 1-3
exporting from 3-39, 4-43
Monitor Setup dialog box 3-38, 4-41
Print in RGB option 3-39, 4-42
selecting print options 3-39, 4-42

transfer functions 3-12, 4-20
using CRDs with 1-10

Adobe PostScript Printer Driver 1-9, 
3-36, 3-50, 4-37, 4-39, 4-42, 4-45

Windows 4-3
Adobe PostScript Printer Driver 8.x

Macintosh 3-1
ADOBEPS.DRV 4-3, 4-4
Adobe Systems, ordering 

documentation G-1
Adobe Type 1 fonts 4-9
Advanced Options dialog box, 

Windows 4-9
advancing cursor in printer control 

panel 2-3
Aldus PageMaker

application note (Macintosh) 3-31 to 
3-36

application note (Windows) 4-37 to 
4-40

choosing fill and line colors 4-38
page setup 3-31, 4-38
selecting print options 3-32, 4-39
working with imported files 3-31, 

4-38
All Colors to Black option 4-9
Apple LaserWriter 8.0 printer driver 1-9
applications

optimizing output with 3-29 to 3-52
printing color from 1-10
QuickDraw 3-50 to 3-52

applications (Macintosh)
printing from 3-1 to 3-5

audience for this guide xiv
available printers

viewing in Chooser 3-1

 

 

This document was created with FrameMaker 4.0.4
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B

 

backspacing cursor in printer control 
panel 2-3

banding, and Solid Color rendering 1-10
bitmapped images

optimizing 3-4
Black LED, on density control panel 2-6
blends, printing 1-10
blue bar, indicator on universal paper 

cassette 2-17
Brightness option

in Colorwriter LSR 
Downloader 3-11, 4-19

in Colorwriter LSR Spooler, 
Windows 4-7

print option (Macintosh) 3-5
bypassing

Colorwriter LSR Spooler 3-2
bytes processed, displayed on printer 

control panel 2-4

 

C

 

cabinet, cleaning C-5
Calibrated RGB monitor settings

loading in Photoshop 3-38, 4-41
calibration

of monitors in Adobe Illustrator 3-29
reasons for 1-7
utility for 1-8

Cancel button 2-3
Canceling Job, status message on printer 

control panel 2-4
canceling printing jobs 2-3
cartridges. 

 

See

 

 toner cartridges
changes, documentation and software xv
changing

brightness setting 3-5
characters, deleting in text fields on printer 

control panel 2-3
charts. 

 

See

 

 color reference charts
Chooser, Macintosh 3-1

choosing
Multipurpose tray option 3-3

CIE chromaticity diagram 1-2, 1-3
CIE color model 1-2
cleaning

corona wire C-6 to C-8, C-31 to 
C-33

density detection sensor window C-8 
to C-9

paper pickup area C-5
printer xviii, C-5 to C-14
printer cabinet C-5
wire cleaner C-6

clearing
paper jams xv

CMYK color model
conversion of image data from 

RGB 1-9 to 1-12
conversion of RGB image data to 1-5

CMYK files
and color rendering dictionaries 3-5

color
additive model 1-3
hue, saturation, and brightness 1-1
physics of 1-1
subtractive model 1-3, 1-4
subtractive primaries 1-4
three-dimensional model 1-3

color (printed)
accuracy of 1-10
controlling 1-7 to 1-12
photographic rendering 1-10

colorants 1-4
color blends

printing 1-10
color calibration

reasons for 1-7
color copies. 

 

See

 

 printouts
color density, adjusting 2-7 to 2-8
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color documents
specifying color mode in Print dialog 

box 3-4
Color/Grayscale option 3-3
color image data

translating to CMYK 1-9 to 1-12
color management 1-8 to 1-12
Color Mode option 3-4, 4-6
color monitors

designing on 1-5
gamut of 1-5
matching color to printed output 1-9 

to 1-12
color monitors, 

 

see 

 

monitors
color pages

printing 2-5
Color Pages option 2-5
Color Picker, in Adobe Photoshop 1-3
color printers

laser-based print engines 1-6
maintaining consistency of 1-7 to 

1-12
paper used in 1-7

color printing
advantages of Colorwriter 1-6
traditional vs. Colorwriter 1-1 to 1-6

color printouts. 

 

See

 

 printouts
color quality

printing test patterns for 2-8 to 2-9
color range 1-5
color reference charts, printing 2-5
color rendering dictionaries xiii, 1-8 to 

1-11
and PostScript Level 1 

applications 3-5

 

See also

 

 Rendering Style option
color rendering dictionaries. 

 

See

 

 CRDs
color rendering styles

banding and 1-10
guidelines 1-10
in QuarkXPress 3-47

Monitor 1-10
Photographic 1-10
Presentation Graphics 1-10
Solid Color 1-10

colors (saturated)
optimizing 3-4

Color Select button, on density control 
panel 2-6

color select indicators, on density control 
panel 2-6

COLOR SELECT key 2-6
Colorwriter LSR_Direct 3-2
Colorwriter LSR Downloader

choosing a printer 3-9, 4-17
printing with 3-10, 4-18

Colorwriter LSR_Hold 3-2
Colorwriter LSR Macintosh utilities

using 3-7 to 3-28
Colorwriter LSR Manager 4-36
Colorwriter LSR_Print 3-2
Colorwriter LSR Spooler

changing print settings 3-24, 4-31
copying jobs 3-23, 4-30
deleting jobs 3-24, 4-31
duplicating jobs 3-22, 4-29
moving jobs 3-24, 4-30
preferences 3-20, 4-27

Commission Internationale de 
l’Eclairage 1-2

computer monitors, 

 

see 

 

monitors
Configuration option 2-5
configuration page, printing 2-5
Confirm file deletion option 3-21, 4-28
connecting

to printer 1-8, 3-2, 4-15, 4-24, 7-1
consistency (printed color), 

maintaining 1-7 to 1-12
controller xiii
Control Panel, Windows 4-4
control panel. 

 

See

 

 printer control panel; 
density control panel
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conversion
RGB image data to CMYK 1-5

copying jobs in Colorwriter LSR 
Spooler 3-23, 4-30

CorelDRAW
application note (Windows) 4-44 to 

4-45
choosing fill and line colors 4-44
Color Manager 4-44
selecting print options 4-45
working with imported files 4-44

corona wire
cleaning C-6 to C-8, C-31 to C-33

covers, opening and removing xviii
CRDs xiii, 1-8 to 1-11, 4-42, 4-43

choosing 1-9
defined 1-9 to 1-12

 

see 

 

Rendering Style option
using with Adobe Photoshop 4-40

CRD. 

 

See 

 

Rendering Style option
curled paper, preventing 2-21
cursor, moving in setup menus 2-3
customizing

color density 2-7 to 2-8
Cyan LED, on density control panel 2-6

 

D

 

damage
avoiding C-12

decrementing text characters on printer 
control panel 2-3

defaults
printer, resetting 2-4
print options, setting 3-4

deleting jobs in Colorwriter LSR 
Spooler 3-24, 4-31

Demo Page
printing 2-5

Demo page option 2-5
densities

correcting 1-8

densitometer 1-8
density

customizing 2-7 to 2-8
density control panel

using 2-6 to 2-9
density detection sensor window

cleaning C-8 to C-9
Density gauge 2-6
density gauge, on density control 

panel 2-6
disk space, message on printer control 

panel 2-4
displaying setup menus 2-3
display window 2-4 to 2-5
documentation xv

related G-1 to G-3
documents

specifying color mode in Print dialog 
box 3-4

downloading
files (from Macintosh) 3-10
fonts (from Macintosh) 3-13

downloading files and fonts 4-15, 4-24, 
4-36

drum cartridge
handling while moving printer C-34

drum cartridge kit F-5
replacing C-25 to C-33

duplicating jobs in Colorwriter LSR 
Spooler 3-22, 4-29

dust, avoiding C-13

 

E

 

EFICOLOR EPS XTension 3-44
EFICOLOR XTension 3-44
electrical contacts, touching C-12
electric shock xviii
electromagnetic radiation 1-1
Electronic Store, ordering 

documentation G-2
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Enable Direct setup option 1-8, 3-2, 
4-15, 4-24, 7-1

enabling/disabling
connecting to printer 1-8, 3-2, 4-15, 

4-24, 7-1
Encapsulated PostScript File option 4-8
Energy Star compliance xix, 2-4
engines (laser based)

calibration of 1-7
Enter button, on density control 

panel 2-6
envelopes, printing on 2-13
environment for printer xvi
EPS files 3-7, 4-15
error, printer control panel activity 

light 2-2
error messages A-1 to A-2
error messages, displayed on printer 

control panel 2-5
Ethernet 7-4
extension cords, use of xvii
exterior of printer xvi

 

F

 

Features window 4-5
Fiery controller xiii
Fiery Print Calibrator utility 1-8
Fiery XJ Downloader (Macintosh)

downloading fonts 3-13
files

Adobe Illustrator, working with 3-30
printing to disk 4-2

fill colors
in Adobe Illustrator 3-29

film, in offset printing 1-6
film. 

 

See

 

 transparency film
filter, ozone xix
flexography 1-6
font list

displaying 3-9, 3-16, 4-17, 4-23
printing 3-9, 3-16, 4-17, 4-23

fonts
downloading from Macintosh 3-13
enabling access by users 1-8, 3-2, 

4-15, 4-24, 7-1

 

See also

 

 screen fonts
FreeHand. 

 

See

 

 Macromedia FreeHand

 

G

 

gamut 1-5
out-of-gamut RGB colors, 

printing 1-10
gamut mapping 1-5
gauging amount of paper in universal 

cassette 2-17
gears, touching C-12
glues 2-11
gravure 1-6
grayscale documents

specifying color mode in Print dialog 
box 3-4

grounding type plug xviii

 

H

 

halftoning 1-4
handling

general instructions C-10 to C-14
paper 2-11 to 2-12
printer xvi
transparency film 2-12

help map
printing 2-5

Help Map option 2-5
Hold queue 3-17, 4-24

printing to 3-2
hue, saturation, and brightness 1-1
humidity

protecting paper from 2-11

 

I

 

Illustrator. 

 

See

 

 Adobe Illustrator
imported files

from Adobe Illustrator 3-30



 

I-6 Index

 

improving
print quality C-5 to C-14

incrementing characters on printer 
control panel 2-3

inhalation slot xvii
Initializing, status message on printer 

control panel 2-4
interpreter xv
IPX (Novell)

managing printer queue on the 
server 7-2

managing print jobs 7-1
with Macintosh computers 7-4

 

J

 

job log
in Colorwriter LSR Spooler 3-25, 

4-32
printing 2-5

Job Log option 2-5
job name, of current print job 2-4
jobs

canceling oldest 2-3

 

L

 

label, voltage rating xvii
labels, printing on 2-13
laser-based print engines 1-6
laser beam devices, touching C-12
LaserWriter Printer Driver 8.x 3-1
LCD

precautions for handling liquid xix
light

from sun 1-1
sources of 1-1
spectral components 1-1, 1-2
Tungsten 1-1
visible spectrum 1-1

light, avoiding C-13
lights (printer). 

 

See

 

 activity lights
lights, on printer control panel 2-2

line colors
in Adobe Illustrator 3-29

liquid crystal display. 

 

See

 

 LCD
loading

paper 2-15 to 2-17
transparency film 2-12, 2-13

location
choosing for printer xvi

locking pins 2-10
logos

optimizing 3-4
lower/upper paper cassette selected 

light 2-2
lpr command 5-1
lubrication, avoiding C-14

 

M

 

Macintosh applications
printing from 3-1 to 3-5

Macintosh computers
on IPX (Novell) network 7-4

Macromedia FreeHand
selecting print options 3-41
working with imported files 3-40

Magenta LED, on density control 
panel 2-6

magnetic fields, avoiding C-13
maintenance C-1 to C-38

general C-10 to C-14
when to do C-1

manual feed printing
setting up xv

manual feed tray. 

 

See

 

 multipurpose tray
manuals xv
mapping (gamut) 1-5
measuring

toner densities 1-8
media F-6

 

See also

 

 paper; transparency film
Media Type option

Macintosh Print dialog box 4-6
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Menu button 2-3
menu entry, displaying next/previous 2-3
messages

error, displayed on printer control 
panel 2-5

status, on printer control panel 2-4
metamerism 1-2
Microsoft PowerPoint

application note (Macintosh) 3-42 to 
3-43

choosing a template 4-45
selecting print options 3-43, 4-46
working with imported files 4-46

Microsoft Windows PostScript Printer 
Driver 4-37

Mirror option 4-10
model number location H-2
moisture, printer exposure to xvi
Monitor rendering style 1-10, 4-6
monitors 1-3

calibration in Adobe Illustrator 3-29
phosphors 1-3

Monitor Setup dialog box, in Adobe 
Photoshop 3-38, 4-41

monitors. 

 

See

 

 color monitors
moving

printer xvi
moving jobs in Colorwriter LSR 

Spooler 3-24, 4-30
moving printer C-34 to C-38
multipurpose tray

adjusting paper guides in 2-21 to 
2-22

amount of paper to load 2-18
amount of transparency film to 

load 2-23
loading paper into 2-18 to 2-25
loading transparency film into 2-23 

to 2-25
opening/closing 2-18 to 2-19
paper limit mark 2-20

using 3-6, 3-6, 4-13 to 4-14
using for transparency film 2-12, 

2-13
multipurpose tray activity light 2-2
Multipurpose tray option

choosing 3-3

 

N

 

Negative Image option 4-9
Next button 2-3
non-solvent glues 2-11

 

O

 

obtaining
service H-1 to H-2

offset lithography 1-6
offset printing 1-6

film 1-6
plates 1-6

OK button 2-3
Online activity light 2-2
Online button 2-3
on-site warrenty support H-1
opening

printer covers xviii
opening/closing

multipurpose tray 2-18 to 2-19
operator intervention, printer control 

panel activity light 2-2
optimizing

Adobe Illustrator files 3-29 to 3-30
images 3-4
output 3-29 to 3-52
saturated colors 3-4
spot colors 3-4

optional cassette 2-10
optional paper cassette F-2
optional paper feeder unit 2-10, 2-14, F-1 

to F-2
options (printer)

setting 2-2
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ordering
documentation G-2
related documentation G-1 to G-3
supplies F-1 to F-6

out-of-gamut RGB colors, printing 1-10
output

matching to color monitors 1-9 to 
1-12

optimizing through 
applications 3-29 to 3-52

output. 

 

See

 

 printouts
overheating xvii
overlays. 

 

See

 

 transparency film
Override Print Settings window, 

Colorwriter LSR Spooler 3-24, 4-31
overriding

Printer Setup options 3-3
overview of manual xiv
ozone emission xix

 

P

 

PageMaker. 

 

See

 

 Adobe PageMaker
pages, printing from printer control 

panel 2-5
Page Setup dialog box

selecting print options in 3-2
PANTONE colors

printing samples of 2-5
paper

avoiding jams 2-16
back side printing incorrectly 2-13
curled, preventing 2-11, 2-21
estimating amount in cassette 2-17
gamut of 1-5
handling and storing 2-11 to 2-12
increasing supply of 2-14
increasing supply of in printer 2-10
loading into multipurpose tray 2-18 

to 2-25
loading into universal paper 

cassette 2-15 to 2-17

multipurpose tray activity light 2-2
optional cassette 2-10
optional paper feeder unit 2-10, F-1 

to F-2
printer control panel activity 

lights 2-2
print side 2-15
recommended brands F-6
setting size of 2-14 to 2-15
storage recommendations 2-11
use in color printers 1-7

paper (special)
printing options for 4-13 to 4-14

paper amount indicator, reading 2-17
paper cassette

optional F-2
paper cassette (lower/upper) selected, 

printer control panel activity light 2-2
paper cassette (optional) 2-10
paper feeder unit (optional) 2-10
paper guides

adjusting 2-21 to 2-22
paper jams

clearing xv
paper jams, avoiding 2-16
paper length guide, in universal paper 

cassette 2-15
paper limit mark 2-16
paper limit mark, in multipurpose 

tray 2-20
paper pickup area

cleaning C-5
paper sizes

supported 2-10
using various 2-10

Paper Source option 3-3
paper tray

multipurpose 4-13 to 4-14
specifying 3-3

paper width guide, in universal paper 
cassette 2-14
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password, entering in Colorwriter LSR 
Spooler 3-28, 4-35

PCONSOLE 7-1
PDF file, for QuarkXPress 3-44
Persuasion. 

 

See

 

 Adobe Persuasion
phosphors, in monitors 1-3
photographed images

optimizing 3-4
photographic prints 1-4
Photographic rendering style 1-10, 3-4, 

4-6
photographic transparencies 1-4
photographs

printing 1-10
Photoshop. 

 

See

 

 Adobe Photoshop
physics of color 1-1
pins, locking 2-10
plates, in offset printing 1-6
plug xviii
PostScript files

printing to 4-2
PostScript interpreter, parameters and 

resources xv

 

PostScript Language Printer Addendum

 

xv

 

PostScript Language Reference Manual, 
Second Edition

 

G-1

 

PostScript Language Reference Manual 
Supplement for Version 2013

 

G-1
PostScript Level 1 applications

printing from 3-5
PostScript Level 2 1-9 to 1-12

printer drivers 3-36, 3-50
PostScript options 4-4
PowerPoint. 

 

See

 

 Microsoft PowerPoint
Power Saver Mode, status message on 

printer control panel 2-4
precautions xvi to xviii
preferences, Colorwriter LSR 

Spooler 3-20, 4-27
prepress proof 1-6

Presentation Graphics rendering 
style 1-10

Presentation rendering style 3-4, 4-6
presentations

color rendering style appropriate 
for 1-10

optimizing 3-4
presentation software, printing color 

from 1-10
Previous button 2-3
Printed queue 3-17, 4-24
print engines (laser based)

calibration of 1-7
printer

general handling instructions C-10 
to C-14

selecting 3-1 to 3-2
printer control panel

activity lights 2-2
activity lights on 2-2
buttons on 2-3
Canceling Job 2-4
display window on 2-4 to 2-5
error messages A-1 to A-2
overview 2-2
Power Saver Mode 2-4

printer control panel service calls A-4 to 
A-6

printer control panel warnings A-3
printer description files 3-2
printer drivers

PostScript Level 2 1-9
Windows 4-3

printer drivers (Macintosh)
Adobe PostScript Printer Driver 

8.x 3-1
PostScript Level 1 3-5

printer files, Read Me files for xv
printer fonts 3-12, 4-20

downloading from Macintosh 3-13
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printer queues. 

 

See also

 

 Hold queue; Print 
queue; Printed queue

printers
available, viewing 3-1

Printer’s Default setting 3-4, 4-6
Printers dialog box, Windows 4-7
printer setup

with Adobe PostScript Printer Driver 
for Windows 4-4

with Windows PostScript Printer 
Driver 4-7

Printer Setup menu
Enable Direct option 1-8, 3-2, 4-15, 

4-24, 7-1
Printer Setup options

overriding 3-3
printing

back side of paper printing 
incorrectly 2-13

blends 1-10
bytes processed message during 2-4
Canceling Job status message 2-4
from Colorwriter LSR 

Downloader 3-10, 4-18
from multipurpose tray 4-13 to 4-14
from Windows applications 4-2
to Hold queue 3-2
indicated by printer control panel 

activity light 2-2
LaserWriter 7.x printer drivers 3-5
list of fonts 3-9, 3-16, 4-17, 4-23
from Macintosh applications 3-1 to 

3-5
offset 1-6
from PostScript Level 1 

applications 3-5
Power Saver Mode status message 2-4
from presentation software 1-10
to Print queue 3-2
from QuickDraw applications (using 

LaserWriter 7.x drivers) 3-5

suspend/resume 2-3
test patterns 2-8 to 2-9
to disk 4-2
transparency film 2-12
using PostScript Level 1 printer 

drivers 3-5
printing (color)

traditional vs. Colorwriter 1-1 to 1-6
Printing, status message on printer control 

panel 2-4
printing methods

flexography 1-6
gravure 1-6
offset lithography 1-6

printing options
for special paper 4-13 to 4-14
for transparency films 4-13 to 4-14

printing technologies 1-6
Print in RGB option, in Adobe 

Photoshop 3-39, 4-42
print jobs

viewing information about 2-2
Print message 2-3
print options

selecting for Adobe Illustrator 
files 3-30

selecting in Page Setup dialog box 3-2
setting defaults 3-4

Print Options dialog box 3-3 to 3-5
printouts

storing 2-11 to 2-12
temperature effect on 2-12

Print Pages menu 2-3
print quality

improving C-5 to C-14
printing test patterns for 2-8 to 2-9

Print queue 3-17, 4-24
printing to 3-2

print queues
viewing contents of 5-2, 7-1
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prints
toner cartridge lifespan C-16

Print Setup dialog box, Windows 4-8
print side of paper 2-15
print speed xiii
prism 1-1
problems

obtaining service H-1 to H-2
problems, printing 2-5
processing, printer control panel activity 

light 2-2
Processing, status message on printer 

control panel 2-4
process inks set 1-4
Process message 2-3
productivity xiii
proofs, prepress 1-6
PSCRIPT.DRV 4-3, 4-7
pumping

silicone oil from printer C-35 to C-38
PVC material 2-11

 

Q

 

QuarkXPress
application note (Macintosh) 3-44 to 

3-50
color rendering styles 3-47
EFICOLOR EPS XTension 3-44
EFICOLOR XTension 3-44
importing TIFF and PICT files 3-48
page setup 3-49
PDF file for 3-44
setting preferences 3-45
setting print options 3-50
source profiles 3-46, 3-47
working with imported files 3-47 to 

3-50

queues

 

See also

 

 Hold queue; Print queue; 
Printed queue

viewing lpd jobs 5-2
viewing NetWare jobs 7-1

QuickDraw applications 3-50, 3-52
quick reference card xv

 

R

 

raster images 3-47
reading

paper amount indicator 2-17
Read Me files xv
Ready, status message on printer control 

panel 2-4
receiving data, printer control panel 

activity light 2-2
reference charts. 

 

See

 

 color reference charts
release button, in universal paper 

cassette 2-14

 

Release Notes

 

xv
removing

printer covers xviii
silicone oil from printer C-35 to C-38
universal paper cassette 2-14

Rendering Style option
in Macintosh Print Options 

dialog 4-6
Rendering Style options (Macintosh) 3-4
Rendering Style pop-up menu 1-9
replacing

drum cartridge kit C-25 to C-33
silicone oil bottle C-22 to C-24
toner xv
toner cartridges C-16 to C-21

resetting
Colorwriter defaults 2-4
test patterns 2-8



 

I-12 Index

 

resume/suspend printing button 2-3
RGB color blends, printing 1-10
RGB color model

conversion of image data to 
CMYK 1-5, 1-9 to 1-12

RGB files
and color rendering dictionaries 3-5

rocking toner cartridges C-18

 

S

 

safety information xvi to xviii
saturated colors

optimizing 3-4
scanners 1-3
scans

printing 1-10
screen fonts

Read Me files for xv
Scroll up/down buttons 2-3
selecting

choices in printer control panel 2-3
print options, for Adobe Illustrator 

files 3-30
selecting printer 3-1 to 3-2
Send Header with Each Job option 4-8
separation corona wire. 

 

See

 

 corona wire
separation voltage control D-17
serial number location H-2
service

obtaining H-1 to H-2
service bureaus

preparing files for 4-2
service call messages A-4 to A-6
servicing printer xviii
setting

paper size 2-14 to 2-15
setting up printer xvii to xviii
setup menus

displaying 2-3
moving cursor 2-3

‘showpage’ after EPS files option 3-12, 
4-20

silicone oil F-4
leakage C-34
precautions for moving printer xvi
removing from printer C-35 to C-38

silicone oil bottle xviii
replacing C-22 to C-24

SIMM kits F-2
size guide, in universal paper cassette 2-15
software

changes to xvi
presentation, printing color 

from 1-10
Read Me files for xv

software version, message on printer 
control panel 2-4

Solid Color rendering style 1-10, 3-4, 4-6
solvents, effect on toner 2-11
source profiles, in QuarkXPress 3-46, 

3-47
special pages, printing from printer control 

panel 2-5
special paper

printing options for 4-13 to 4-14
spectral colors 1-2
spectral components of light 1-1, 1-2
speed, printer xiii
Spooler

 

see

 

 Colorwriter LSR Spooler
spooling

bypassing 3-2
spot colors

optimizing 3-4
spray cleaners, using C-10
spreadsheet software, printing color 

from 1-10
status (printer), checking 2-2
status information 2-2
status messages, on printer control 

panel 2-4
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Status T densitometer 1-8
storing

paper 2-11 to 2-12
printouts 2-11 to 2-12
toner cartridges C-15
transparency film 2-12

subtractive color model 1-3, 1-4
subtractive primaries 1-4
sunlight 1-1
sunlight, avoiding C-13
supplies

drum cartridge kit F-5
optional paper cassette F-2
optional paper feeder unit F-1 to F-2
ordering F-1 to F-6
silicone oil F-4
SIMM kits F-2
toner cartridges F-3

support. 

 

See

 

 warranty support
suspend/resume printing button 2-3
system administrator

printer features 7-1

 

T

 

TCP/IP (UNIX)
printing 5-1

technical support phone number G-1
temperature

effect on printouts 2-12
test page

printing 2-5
Test Page option 2-5
test patterns 2-7

printing 2-8 to 2-9
resetting 2-8

Test Print button, on density control 
panel 2-6

TEST PRINT key 2-7
test prints

use of 1-7

text, deleting in text fields on printer 
control panel 2-3

three-dimensional color model 1-3
tilting, avoiding C-14
tilting printer xvi
toner

distributing in replacement 
cartridge C-18

replacing xv, 1-7
solvents’ effect on 2-11

toner cartridges F-3
color markers on printer C-21
disposing C-18
handling while moving printer C-34
replacing C-16 to C-21
storing C-15

toner densities
correcting 1-8
measuring 1-8

Toolbar in Colorwriter LSR 
Downloader 3-9, 4-17

transfer curves 1-8
translation

of color image data to CMYK 1-9 to 
1-12

transparencies (photographic) 1-4
transparency film 3-42, F-6

direction for feeding into 
printer 2-12, 2-23

handling 2-12
loading into multipurpose tray 2-23 

to 2-25
recommended brand 2-23
storing 2-12
uses for 3-36

transparency film, loading 2-12, 2-13
transparency films

gamut of 1-5
printing options for 4-13 to 4-14

transporting printer C-34 to C-38
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troubleshooting
back side of paper printing 

incorrectly 2-13
TrueType fonts 4-9
Tungsten light 1-1
turret knob C-17

 

U

 

universal cassette 2-10
universal paper cassette

blue bar indicator 2-17
loading paper into 2-15 to 2-17
paper length guide 2-15
paper sizes and amounts 2-13
removing 2-14
setting paper size 2-14 to 2-15

UNIX (TCP/IP)
printing 5-1

UNIX systems
managing queues 5-2

unpacking printer xvii to xviii
upper/lower paper cassette selected, printer 

control panel activity light 2-2
user guide xv
using

Colorwriter LSR Macintosh 
utilities 3-7 to 3-28

density control panel 2-6 to 2-9
multipurpose tray 4-13 to 4-14

utilities
calibrator 1-8
Macintosh, using 3-7 to 3-28

 

V

 

vector images 3-46, 3-47
ventilation xix
ventilation slots xvii
vibration C-10
visible spectrum of light 1-1
voltage rating label xix
voltage symbol xviii

 

W

 

Warning light 2-5
warnings xviii to xxi, A-3
warranty support H-1
waste toner bottle xx

handling while moving printer C-34
replacing C-26 to C-30

weight
of printer xvi

Windows
PostScript printer driver 4-3

window. 

 

See also

 

 display window
wire cleaner C-6
word processor software, printing color 

from 1-10
world wide web page address H-1

 

Y

 

Yellow LED, on density control panel 2-6
You 3-6

 

Z

 

zone
selecting printers in 3-1 to 3-2
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